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How can we help you?

Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage ERP
Accpac working smoothly for your business! Your Sage Business
Partner is also an excellent resource to consult when you have
guestions about Sage ERP Accpac.

[}l I'm setting up Sage ERP Accpac and need information or assistance

[}l I'm looking for instructions to complete a task within Sage ERP Accpac

[ | think something is broken, or I'm getting error messages

[}l I'm looking for downloads, updates, or technical specifications

[ 1 want to become a more skilled user of Sage ERP Accpac

[ 1 want to share knowledge with other Sage ERP Accpac users

[ 1 want to contact a Sage ERP Accpac representative
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What's New in Project and Job Costing 6.0

Project and Job Costing 6.0A includes the following new features and
improvements:



In Product Update 1:

You can now create a new invoice batch in Accounts Receivable when
you post a billing worksheet, even if there is an unposted job-related
batch in Accounts Receivable. We've added a new setting to the PJC
Options form to give you the option to always create a new Accounts
Receivable batch whenever you post a billing worksheet.



In the 6.0A Release:

Project and Job Costing 6.0A (PJC) supports changes to Common
Services' Fiscal Calendar.

Fiscal periods are now locked separately for each Sage ERP Accpac
program, including Project and Job Costing. Although this change does
not affect the way you enter transactions, you should note the following
points:

eThe program checks the status of a fiscal period when you enter
certain dates in Project and Job Costing transactions.

el ocking a fiscal period for PJC does not normally prevent other Sage
ERP Accpac programs from updating information in the Contract
Maintenance form. For example, posting a job-related invoice in
Accounts Receivable or Accounts Payable updates the associated
values for the contracts, projects, categories, and resources in PJC.

An exception to this rule can occur if you post material usage or
material return transactions to a period that is later locked for PJC. If
the period is locked before running Day End Processing, Day End
Processing will not process these transactions, and will generate an
error. To clear the error, you must unlock the period for PJC, and then
run Day End Processing. (Material allocation transactions do not
produce this error.)

e|_ocking a fiscal period for Inventory Control does not prevent Day
End Processing from creating transactions for, or from updating
contracts in, PJC. However, if the period is locked for PJC, you might
not be able to post the transactions in PJC.

eYou can create G/L batches for a fiscal period that is not locked for
Project and Job Costing. However, if the period is locked for General
Ledger when you try to post the G/L batch, the transactions will be
placed in an error batch in General Ledger. If the option to create and
automatically post G/L batches is selected on the G/L Integration
form, the transactions will be placed in an error batch in General
Ledger when you create the batch in Project and Job Costing.

eYou can create revenue recognition worksheets for a period that is



unlocked for Project and Job Costing. However, if the period is locked
for General Ledger, you cannot post the resulting batch in General
Ledger. If the option to create and automatically post G/L batches is
selected on the G/L Integration form, the transactions will be placed in
an error batch in General Ledger when you post the worksheet.

eYou can create billing worksheets for a period that is unlocked for
Project and Job Costing. However, if the period is locked for Accounts
Receivable, you cannot post the resulting invoice batch in Accounts
Receivable. Also, if the option to post A/R batches automatically is
selected on the PJC Options form, the transactions will be placed in
an A/R error batch when you post billing worksheets for periods that
are locked for Accounts Receivable.

See also

Changes Introduced in Project and Job Costing 5.6
Changes Introduced in Project and Job Costing 5.5
Changes Introduced in Project and Job Costing 5.4




Steps for Setting Up Project and Job Costing

This topic lists the steps for setting up a new Project and Job Costing
SyStem, assuming that you have [ prepared your Sage ERP Accpac system for use with the

program.

[}l step 1: Select program options and add setup records

[}l step 2: Add existing estimates and contracts to Project and Job Costing

[}l step 3: Design formats for your preprinted forms

%‘ Related Topics
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Project and Job Costing Options —

Overview

Use the PJC Options form to select options when you first set up your
Project and Job Costing system, and whenever you need to change your
selections.

The PJC Options form lets you:

eChange the contact name, telephone number and fax number for your
Project and Job Costing system.

.SpeCify default Settings for contracts and projects .
eSpecify five aging periods.

e[For projects that use a percentage complete accounting method,
specify when to clear the billings and work in progress accounts.

eSpecify formats for contract numbers.

eDetermine how Project and Job Costing interacts with Accounts
Receivable.

Note: You cannot save most changes to the Options form if any other
Project and Job Costing forms are open.

For detailed information about a tab on the Options form, click the
corresponding link, below:

I:E' Company
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LTE‘ Settings

LTE‘ Segments

LTE‘ Transactions

LTE‘ Integration
Before You Start

Before changing any of the settings or other information in the Options
form:

eMake sure you understand the impact your changes will have on
processing.

eMake sure that no one else is using Project and Job Costing and that
no other Project and Job Costing forms are open on your computer.
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I:E' Related Topics
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Project and Job Costing Options —

Company Tab
The Company tab of the PJC Options form lets you change the contact
name and telephone and fax numbers for Project and Job Costing.

Your selection for the Format Phone Numbers option in the Company
Profile in Common Services determines whether parentheses and
hyphens are inserted.

To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use the
Company form in Common Services.

For detailed information about another tab on the Options form, click the
corresponding link, below:

EE} Settings

EE} Segments

EE} Transactions
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LTE‘ Integration
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Project and Job Costing Options — Settings ===

Tab

Use the Settings tab to specify general settings for your Project and Job
Costing system. This tab lets you specify:

eAlternative names to use in place of the default level names
(Contract, Project, and Category) and their plural forms.

Note that the initial letters of the new names are used as shortcut
keys in the Contract Maintenance form.

eThe default accounting method, contract style, overhead type and rate
(or percentage), labor type and rate (or percentage), to use in new
contracts.

eThe default Accounts Receivable item number and unit of measure to
use on item invoices that you generate in Project and Job Costing.

e\Whether to force listing of transactions before you can post
transactions.

e\Whether to update budgets (in Budget Maintenance) whenever you
process transactions.

*\Whether to use the payroll and employee expense accounts from PJC
timecards or the accounts specified in the Payroll employee record
when you update Canadian or US Payroll.

e\Whether to recognize only costs that have been billed using a billing
worksheet when you recognize revenue for projects that use an item
invoice type.

*Whether to clear the billings account and work in progress account
during revenue recognition or at project close for projects that use a
percentage complete accounting method.

eFive aging periods to classify information on reports.

Click one of the links below for information about another tab on the
Options form:



I:E' Company

I:E' Segments

I:E' Transactions

I:E' Integration
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Project and Job Costing Options —

Segments Tab

You use the Segments tab on the PJC Options form to:

eSpecify a default contract structure to use with new contracts. (You
use the Contract Structures form to specify contract structures, or
formats for your contract numbers.)

eDefine the segments you will use in your Project and Job Costing
contract structures.

You can define up to five segments for your contract numbers. Each
segment can be up to 16 characters long. Contract numbers can be a
maximum of 5 segments long and no longer than 16 characters.

e|ndicate whether to use a validation table for each segment. (You use
the Segment Codes form to specify the valid segment codes that you
can use with each segment.)

eSelect the segment separators that can be used in contract numbers.
You cannot enter these separators manually when you enter a
contract number for a new contract.

For detailed information about another tab on the Options form, click the
corresponding link, below:

I:E' Company

I:E' Settings
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Project and Job Costing Options —

Transactions Tab

The Transactions tab of the PJC Options form:

e|ets you set a Prefix (using up to 6 characters) and Next Number (up
to 16 characters) for each type of transaction you can process in
Project and Job Costing.

e|_ets you specify the source for the default unit cost and the default
billing rate used on timecards. You can override these settings for
selected project categories (on a basic project) and resource
categories (on a standard project). You cannot change the source for
the default unit cost for Payroll employees.

e|_ets you choose whether to use the transaction date or the session
date as the default posting date on transaction-entry forms.

eDisplays the posting sequence number to be used the next time you
post a batch for each type of transaction. (Project and Job Costing
assigns the number; you cannot change it.)

For detailed information about a tab on the Options form, click the
corresponding link, below:

I:E' Company

I:E' Settings
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I:E' Segments

I:E' Integration


javascript:mc22.Click()
javascript:mc23.Click()

Project and Job Costing Options —

Integration Tab

The Integration tab of the PJC Options form lets you choose:

*\Whether to post invoice batches automatically in Accounts Receivable
when you post billing worksheets in Project and Job Costing.

eThe information to use from Project and Job Costing transactions as
the description and comment for transactions you send to Accounts
Receivable from Project and Job Costing.

For detailed information about a tab on the Options form, click the
corresponding link, below:

EE} Company

EE} Settings

EE} Segments
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G/L Integration Form — Overview

When you run the revenue recognition functions or post equipment,
timecard, adjustments, cost, or reopen projects transactions, Project and
Job Costing creates entries for your general ledger.

If you use Sage ERP Accpac General Ledger, Project and Job Costing
creates batches of transactions in General Ledger, where you can edit
and post them. If you use another general ledger system, or if your Sage
ERP Accpac General Ledger system is at another location, the program
creates batches that you can import or enter manually in your general
ledger.

You use the G/L Integration form, available in the PJC Setup folder, to
select options to

eProduce general ledger transactions in the form and at the time that
best suits your requirements.

eAssign a wide range of job related information to the entry description,
detail reference, detail description, and detail comment used in
general ledger transactions.

Note: You cannot save most changes to the G/L Integration form if any
other Project and Job Costing forms are open.

To change General Ledger Integration options

Types of general ledger batches

Project and Job Costing creates separate general ledger batches for the
following types of transactions:

eAdjustments

eCosts

eEquipment Usage
eReopen Projects
eRevenue Recognition

eTimecards



Reporting general ledger data

You can print the L Transactions report, @ IIStIng of the general Iedger
transactions created by Project and Job Costing, whether or not you post
batches in General Ledger.

For more information about the tabs on the G/L Integration form, click one
of the links below:

I:E' Transactions

I:E' Integration
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Planning a Cost Classification System

In Project and Job Costing, you use cost categories, cost types, and cost
classes to create a cost classification system that supports your cost-
reporting needs. Each cost category is associated with a cost type, which
is further characterized by a cost class.

The following overview describes how cost-related setup records affect
the processing and reporting of cost transactions.

Categories

Cost categories let you organize contract and project costs according to
your company's particular needs. For example, you can create categories
that distinguish costs by department (such as design), or by activity (such
as painting or wiring), and you can create as many categories as you
require.

You add category records to your Project and Job Costing system using
the Categories form. Then, you can assign these cost categories to
individual projects, and use them to estimate and track costs for projects
within a contract. You can create generic categories to use in many
projects, or you can set up specific categories for particular projects.

Categories define the following settings for cost transactions that use a
given category code:

eCost Type

eUnit Of Measure

*Billing Type

eOverhead Type

elabor Burden Type

e|ltem Number (for item invoices)

To each category you set up, you assign a cost type.

Cost Types

Cost types let you refine your cost reporting beyond the finite set of cost



classes that come with the program.

You can define as many different cost types as you need to organize
labor, material, equipment, subcontractor, overhead, and miscellaneous
costs into meaningful groupings for the projects your company
undertakes.

For each cost type you set up, you must assign a cost class. Because
they identify the type of resource for each cost type, cost classes are the
most basic cost classification in Project and Job Costing. They help to
define the character of each cost category and, therefore, of all cost
transactions associated with the categories.

The cost types you assign to categories and resource records must use
cost classes consistent with the resource. (In other words, equipment
records must use cost types that have an equipment cost class.)
Therefore, you should create at least one cost type record for each cost
class (labor, material, equipment, subcontractor, overhead, or
miscellaneous costs).

You can assign the following cost classes to cost types:
el abor
eMaterial
eEquipment
eSubcontractor
eOverhead
eMiscellaneous

Resources

You also set up records in Project and Job Costing for each type of
resource that you use to perform the work to complete standard projects.
These resource records, which are used in estimating projects and in
processing cost transactions, are as follows:

eEmployees
eEquipment

eMiscellaneous Expenses



eOverhead Expenses
eSubcontractors
eCharges

Resource classifications provide an additional means of organizing your
cost reporting system. For standard projects, you can assign resources to
projects, to estimate and track costs by resource.

When you enter cost transactions, such as timecards, equipment usage,
material usage, and material returns transactions, you can select only
resources for which you have created a record.

Note that you must assign to each resource a cost type that uses a cost
class consistent with that resource. For example, you can assign to an
equipment record only a cost type that uses an equipment cost class.



Setting Up Resources

Resource classifications provide an additional means of organizing your
cost reporting system. You assign resources to standard projects to
estimate and track costs.

You can assign only resources that you have defined for your Project and
Job Costing system using the related forms in the PJC Setup folder.

When you enter cost transactions, such as timecards, equipment usage,
material usage, and material returns transactions, you can select only
resources that you have assigned to your projects.

Project and Job Costing lets you add records for each type of resource
that you use to perform work on your contracts, as follows:

® Employees

® Equipment

® \iscellaneous Expenses

® Overhead Expenses

® Subcontractors

® Charges

Note that you must assign to each resource a cost type that uses a cost
class consistent with that resource. For example, you can assign to an
equipment record only a cost type that uses an equipment cost class.

When you assign a particular resource code to a project, the program
uses the settings from the resource setup record as the defaults.



Using Optional Fields in Project and Job Costing

Project and Job Costing supports Sage ERP Accpac Transaction
Analysis And Optional Fields Creator.

Optional Fields let you customize your Project and Job Costing system
by letting you store additional information you want to keep with records
and transaction details, and provide an additional means of analyzing
your contracts, projects, and costs.

You can use an unlimited number of optional fields in Project and Job
Costing. However, you must first define optional fields for your Sage
Accpac system using the Optional Fields form in Common Services. (For
more information about setting up optional fields in Common Services,
see the System Manager help.)

Once you have set up optional fields for your Sage ERP Accpac system,
you use the Optional Fields form in the PJC Setup folder to define
optional fields for use in Project and Job Costing records and & gansaction-entry

forms.
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Optional Field Settings

When you set up an optional field for transaction entry forms or for
transaction details, the Settings button becomes available, letting you
open a separate Settings form. You use the optional field Settings form to
restrict the flow of optional field data to Sage ERP Accpac Accounts
Receivable, Inventory Control, US or Canadian Payroll, and General
Ledger.

Other Sage ERP Accpac programs will accept optional field information
sent with transactions from Project and Job Costing if:

eYou use the same optional fields for the affected forms in accounts Receivable
L1, inventory Control, ZlUS or Canadian Payroll &1, OF @accounts IN General Ledger [

eYou selected the settings to send optional field information to these
other programs and accounts.

Accounts Receivable, Inventory Control, and Payroll will respect the
optional field settings you specified in Project and Job Costing when
sending G/L transactions to General Ledger, if you use the same
transaction optional fields for the affected accounts in General Ledger.

For example, if the transaction optional fields assigned to the Billings and
Revenue accounts match the transaction details optional fields used on a
job-related invoice, when you send the invoice transaction to General
Ledger, Accounts Receivable uses the settings from Project and Job
Costing.

To see exactly which accounts are affected by any type of transaction, on
the Optional Fields setup form, select an optional field for the type of
transaction or transaction details (different accounts are affected at each
level), then click the Settings button.

Initially, all optional field settings are selected in Project and Job Costing,
so that all information will be passed to the other programs if the optional
fields match. You should change the settings to ensure that only optional
field information that is required in another Sage ERP Accpac program
will be sent.
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Importing and Exporting Project and Job Costing

Records

If you are entering data from another computerized job costing system,
you may be able to transfer records directly into Sage ERP Accpac
Project and Job Costing by importing them.

You can also export records from another Sage ERP Accpac Project and
Job Costing database, edit them in a spreadsheet or other program to
change codes, amounts, and other information, then import them into the
Project and Job Costing system you are setting up or into another Sage
ERP Accpac program. (You could, for example, export employee records
to a spreadsheet for import into another program, such as Sage ERP
Accpac Payroll.)

Project and Job Costing can create export files in several formats,
including Microsoft Excel and Microsoft Access, Comma Separated
Values and Continuous ASCII file formats, dBase 5.0, and ODBC
formats. You select the format to use when you export the data.

For information about importing and exporting Project and Job Costing
recordS, S€E€ Importing and Exporting.

For step-by-step instructions on importing and exporting, see the System
Manager help on importing and exporting data.



Account Sets Setup Form

The Account Sets form in the PJC Setup folder lets you create groups of
general ledger accounts to which you post Project and Job Costing
transactions.

You assign an account set to each contract to identify the general ledger
accounts to which you post transactions for the contract. You must define
at least one account set before you can add contracts to Project and Job
Costing.

Project and Job Costing lets you add as many account sets as you need.
You can use just one account set for all your contracts, or you can use
separate account sets for different types of contracts or customers. If you
use a multicurrency ledger, for example, you need to add at least one
account set for each of your customers' currencies.

To add or modify an account set




Categories Setup Form — Overview

The Categories form in the PJC Setup folder lets you:

eDefine cost categories for classifying cost information on Project and
Job Costing reports.

eSpecify settings for cost transactions and contract estimates that use
a specific category. (You must assign a category whenever you enter
a cost transaction. You also add categories to projects when
estimating or setting up new contracts.)

oCreate typical categories that you can use for a number of projects, or
you create categories for particular projects. When you use a
category code in the Contracts form, the settings for that cost
category appear, but you can change them for individual projects, if
necessary

To add or modify a category

For information about a specific tab on the Categories form, click the
corresponding button, below:

I:E' Category

I:E' Default Settings For Basic Projects
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Charges Setup Form

You use the Charges form, available in the PJC Setup folder, to set up
records for revenue for which you do not incur costs directly, but for
which you charge your customers (a registration fee, for example).

You can also set up charges for contracts where you bill your customers
in advance. For example, if a customer prepays installments on a time
and materials research contract, you could set up charges to generate
billing for the prepayments. If you set up no-charge categories for your
costs, you avoid billing your customer twice for the same work. (Your
invoice for your actual costs would itemize the time and materials you
expended, but it would not contain amounts.)

To add or modify a charge record




Contract Structures Setup Form

You use contract structures to define formats for contract numbers.

A contract structure determines the number of segments in a contract
number, the order in which the segments appear, and the position and
type of separator and prefix characters in a contract number. You can
define several contract structures, so that you can use several different
contract number formats.

Contract numbers can contain a separator character between
consecutive segments and a prefix character in front of the first segment.
Note that the maximum number of characters permitted for a structure,
including separator characters, is 16.

Before you add contract structures, you must use the Segments tab on
the Options form to define contract number segments and to specify the
separator characters you want to use in contract numbers.

You can define as many structures as you need, but you must define at
least one.

To add a contract structure



Cost Types Setup Form

You use the Cost Types form, available in the PJC Setup folder, to define
additional classifications that you want to use for reporting your cost
transactions.

Cost types let you refine your cost reporting beyond the fixed set of cost
classes that comes with the program. (Because they identify the type of
resource for each cost type, cost classes are the most basic cost
classification in Project and Job Costing. They help to define the
character of each cost category and, therefore, of all cost transactions
associated with the categories.)

To add or modify a cost type

I:E' Related Topics
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Employees Form — Overview

You use the Employees form, available in the PJC Setup folder, to:

eAdd records for employees whose labor costs you want to track in
Project and Job Costing.

You can link employees from Sage ERP Accpac US or Canadian
Payroll to an employee record in Project and Job Costing. If you do
not use a Sage ERP Accpac payroll program, you can simply enter
the information from your own records.

In a multicurrency system, you can set up PJC Employee records for
US or Canadian employees in any currency. You can then process
job-related timecards in US or Canadian Payroll in any currency. (You
can also process timecards directly in Project and Job Costing,
providing the employee record uses the functional currency.)

eSpecify default settings to use for estimates and on timecards you
process for a specified employee.

eRestrict the fields that appear on an employee's timecard.

eSpecify optional fields that you can use on the employee's timecards,
if you also use Sage ERP Accpac Transaction Analysis and Optional
Field Creator.

To add or modify an employee record

For information about another tab, click a button, below:

I:E' Default Settings for Standard Projects
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Equipment Setup Form

The Equipment form in the PJC Setup folder lets you add records for the
equipment that you use on projects.

To add or modify equipment records




Field List

Miscellaneous Expenses Setup Form

Use the Miscellaneous Expenses form, available in the PJC Setup folder,
to set up records for expenses for which no other resource setup form
(employees, equipment, and so on) exists, such as for permit or
inspection costs.

Miscellaneous expenses are different from the charges you set up using
the Charges form. Miscellaneous expenses represent a cost to you that
you pass on to your customer, whereas charges are used to record
revenue items for which you incur no direct cost.

To add or modify a miscellaneous expense



Optional Fields Setup Form

The Optional Fields form is available in the PJC Setup folder if you use
Sage ERP Accpac Transaction Analysis And Optional Fields Creator, a

separately licensed package that you can purchase and use with Project
and Job Costing.

To add or modify optional fields in your Project and Job Costing system

EE} Related Topics
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Overhead Expenses Setup Form

The Overhead Expenses form, available in the PJC Setup folder, lets you
define codes for overhead costs that you can attribute to specific projects
and whose use you want to track — for example, the rental of a trailer that
you park on a construction site.

Overhead expenses, such as rent, insurance, maintenance, and salaries
for administrative staff, are often necessary to perform work on contracts.
Even if you cannot attribute these costs directly to a job, you need a
rational method to allocate them.

There are two ways to allocate overhead in Project and Job Costing:

e|f overhead varies in some proportion to a resource consumed on a
project (such as equipment, labor, or materials), you can specify an
overhead type and rate (or percentage) for the cost category you will
use for that resource.

When you post a transaction that includes the category, Project and
Job Costing automatically calculates and allocates overhead to the
project in the proportion to the cost of the resource used.

e|f overhead cost is traceable to specific projects, you can set up a
separate overhead record for that cost. For example, if you rent office
space for a project, you can set up an overhead expense record
specifically for the office rental. You can then specify the overhead
code in cost transactions. (You can enter the transactions using the
Invoice Entry form in Accounts Payable, or the Costs form in Project
and Job Costing.)

When you post cost transactions for categories that use an overhead
cost class, the program applies overhead to the specified projects.

To add or modify an overhead expense record




Projects Setup Form — Overview

Project and Job Costing tracks revenue and revenue-earning activity by
project.

You use the Projects form, available in the PJC Setup folder, to define
generic project records for the major revenue-earning activities that your
company undertakes (for example, design or pouring foundations). Each
separate job, or work phase, that contributes revenue to a contract is a
project.

Project records contain settings that let you prescribe how and when to
recognize revenues, and the type of billing arrangement for each project.
You can add records for typical projects that you will reuse or adapt for a
number of contracts, and you can set up special projects that you will use
for a particular contract.

You specify a unique code to identify each project record. You use the
project codes in the Contract Maintenance form to assign projects to
contract records. Project and Job Costing displays the settings from
project records as defaults for new contract projects, saving you time
when setting up contracts. (You can change the settings for particular
contract projects, as necessary.)

To add or modify a project record

For information about a specific tab on the Projects form, click one of the
links, below:

I:E' Project
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Segment Codes Setup Form

The Segment Codes form lets you enter valid codes for segments of
contract structures that you want Project and Job Costing to verify before
you can add a new contract number.

To restrict entries for a particular segment to a list of valid codes, you
must first select the Validate option for the segment on the Segments tab
of the PJC Options form. (You can select or cancel the Validate option for
individual segments at any time.) Then, you use the Segment Codes
form to define valid segment codes for your segments.

When you add a new contract number, Project and Job Costing verifies
your entry for segments that use the Validate option against the valid
segment codes you added for each segment. If the segments are all
valid, the program adds the contract number to the system.

Note: You can add segment codes as needed, but you can delete
segment codes only if they are not used in any contract numbers.

To add a segment code



Field List

Subcontractors Setup Form

If you use subcontractors for certain types of work, you can set up
subcontractor records that you can attach later to particular projects.

Your subcontractor records are linked to vendor records in Accounts
Payable. When you enter an invoice from the subcontractor in Accounts
Payable Invoice Entry, you specify the contract, project, and category for
each detail. This information is passed to Project and Job Costing when
you process the invoice.

To add a subcontractor record




Changing Column Order in Data Entry forms

You can change the order in which columns appear on many Sage ERP
Accpac forms.

For example, you can change the order of the Payment Entry detalil
columns to match the field order of a document from which you are
entering data.

To move a column

.-’-'-.u:tul% |F|ecngr11"had:ugnized
0.00

ePoint to the column heading.

eHold down the left mouse button
eMove the column to its new location
eRelease the button.

To restore your original settings

1.0n the Sage ERP Accpac Desktop, select the icon for the form you
changed.

2.From the Object menu, click Restore Defaults, then click All Other
Settings.

The columns will be in the original order the next time you open the form.

I:E' Related Topics
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Changing Column Widths in Data Entry Forms

Double-clicking the division between columns resizes the column on the
left to its minimum size based on the data it contains.

Current Estimate% Committed
n.oo n.oo

To change the width of columns

ePosition the mouse pointer on the vertical line separating a column
heading from the next heading to the right.

eDrag the column to the right (to make the column wider) or to the left
(to make it narrower).

*\When you reach the width you want, release the mouse button.

To restore your original settings

1.0n the Sage ERP Accpac Desktop, select the icon for the form you
changed.

2.From the Object menu, click Restore Defaults, then click All Other
Settings.

I:E' Related Topics
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Data Entry Tools and Shortcuts

Project and Job Costing data entry forms contain many aids to data entry
which you can activate by selecting from a menu command, pressing a
function key on your keyboard, or clicking an icon.

Select the icon or command listed below for which you want information:

F5 4 4 okl
a, or L] Navigation
DNﬂV Find buttons
» or I ~or )
Go Zoom

IE Related Topics
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Project and Job Costing Forms

The following list includes each Project and Job Costing icon that you can
choose from the Sage ERP Accpac Company Desktop. Select from the

keywords below for information on the purpose and operation of the data
entry forms each icon leads to.

Periodic processing

Clear History
Create G/L Batch

Update Payroll

AIR Billing

Create Billing Worksheet

Billing Worksheet
Post Billing Worksheets

Revenue Recognition

Create Revenue Recognition Worksheet
Revenue Recognition

Reopen Closed Projects

Create Reopen Projects Worksheet
Reopen Projects Worksheet

Setup

Account Sets

Cateqgories

Charges

Contract Structures
Cost Types
Employees
Equipment

G/L Integration
Miscellaneous Expenses
Optional Fields
Options

Overhead Expenses
Projects

Seament Codes
Subcontractors

Transactions

Adjustments
Budget Maintenance

Charges
Contract Maintenance
Costs

Equipment Usage




Material Allocation
Material Returns

Material Usage

Opening Balances
Post Transactions

Revise Estimates
Timecards
Transaction History

Update Retainage

Reports

Analytical reports

Aged Work in Progress
AlA Report

Committed Costs Audit List
Contract Details

Contract Summary
Detailed Costs

Over/Under Billings

Profit Analysis
Stored Material Audit Report

Setup reports

Account Sets

Cateqories

Charges

Contract Structures
Cost Types
Employees
Equipment

GI/L Integration
Miscellaneous Expenses
Options

Optional Fields
Overhead Expenses
Projects

Seament Codes
Subcontractors

Transaction reports

Detailed Transaction
G/L Transactions

Posting Errors
Posting Journals
Transaction History

Transaction Listing




I:E' Related Topics
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The File menu appears on all Project and Job Costing forms. Use its
commands as follows:

In report forms, begins printing the
current report. In non-report forms, opens

Print the related report form, letting you make
selections to specify the report you want
to print.

Lets you select the printer or file to which

%}ef you want to print, or select Preview to
print to your screen.
cusomize LELS YOU hide fields on a form, depending
on the user.
Lets you enter information about the data
Import . . .
you want to import, and import it.
Lets you enter information about the data
Export

to export, and export it.

Close Closes the current form.



Help Menu

The commands on the Help menu provide different kinds of information
about the Sage ERP Accpac Project and Job Costing program.

Contents — Displays the table of contents for the Project and Job
Costing on-line help system, from which you can select help on various
aspects of Project and Job Costing.

Using Help — Provides information on how to use help.

About... — Lists the version number of Sage Accpac that is installed on
your system.



Settings Menu

The Settings menu appears on some Project and Job Costing forms with
the following option.

If this option is turned on, each time you close the form,
Autoclear the entries or changes you made to the current form are
cleared automatically.

In some forms, the Settings menu also contains options that let you
save the current settings as personal defaults or restore the
program's original settings.

Save

Settings To save the current settings as your personal defaults for
As the form, select the Save Settings As Defaults option.
Defaults

Clear To revert to the program's original settings, select the
Saved prog g gs,

Settings Clear Saved Settings option.



Setting Up Contracts

In Project and Job Costing, a contract is a collection of projects and cost
categories that represent the substance of your formal agreement with
your customer.

You set up and manage contract records using the Contract Maintenance
form and its related forms, Project Maintenance and Category
Maintenance.

A contract record contains settings that determine how the program
processes transactions for the contract, and how it accumulates cost
information.

®[3] For each project you assign to a contract, YOU SpeCify Settings that determine when
to recognize revenue, how to bill, the excess of your costs to bill as
profit (for cost plus contracts), and the general ledger accounts to
which you will post transactions.

e¢To each contract prOjeCt, [] you assign categories and (for standard projects) resources
representing the costs you will incur fOr the prOjeCt.

You use these categories and resources to estimate project costs @and to track
actual project costs as you incur them.

Note: The level at which you track costs depends on the project style. FOr
a standard project, Categories and estimates are linked to each resource.
For a nasic project, Categories and estimates are linked directly to the
project.

You can assign default settings for all the projects within a contract, or
you can let Project and Job Costing use the default settings specified in
each project record. You can also change the settings for individual
projects on the Contract Maintenance form.

Copying Projects and Categories from Another
Contract
Project and Job Costing provides a new contract wizard that lets you copy the

projects, categories, and resources from an existing contract to a new
contract, which can make even complex contracts much easier to set up.
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The New Contract Wizard also lets you choose whether to use estimates

or actual figures from the existing contract as the estimates for the
projects in the new contract.

To create a new contract

I:E' Related Topics
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Use the Tree View to Work with Contracts

] overview
To turn on the Tree view:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.0n the File menu, click Show Tree.

3.Use the Finder or the navigation buttons beside the Contract field to
select the Contract you want to work with, or type the contract code in
the Contract field.

The panel on the left-hand side of the Contract Maintenance form
displays a folder for a selected contract, with expandable subfolders
for each project, resource, and category.

When you click the folder for a contract, project, category, or resource
on the tree, the corresponding maintenance form appears on the
right, making it easy to enter information at different levels of a
contract.

Right-clicking the contract, a project, or a category on the tree
displays a menu that lets you:

o  Expand or collapse the tree.

o  View the transactions you have posted for the selected contract,
project, or category.

o  Add a new record to the folder you selected on the tree.

[l Related topics


javascript:void(0);
javascript:void(0);

Using Contract and Project Statuses

Project and Job Costing sets Estimate as the default status for all new
contracts and projects. The Estimate status lets you use the Contract
Maintenance form to enter estimates.

As you enter estimates for your projects, the program automatically
calculates and displays the revenue and cost estimates for each project,
category, and (for standard projects) resource, and for the contract as a
whole. If you specified overhead and labor burden rates, the program
calculates the labor burden and overhead amounts, and includes them in
the total cost estimate.

When a contract is signed, you change the contract status to Approved.

When work begins, you change the status of the contract to Open. The
program lets you change the status of all the projects to Open when you
change the contract status. You can do so, if you want.

Projects must have an Open status to be able to process transactions for
them.

Once you change the status of a project from Estimate to Open or
Approved, Project and Job Costing does not allow you to update
estimates directly. However, if you have not processed any transactions
against a project in any Sage ERP Accpac programs, you can change its
status back to Estimate. (Before changing the status back to Estimate,

you should & ensure that the project is not used in unposted transactions in any other Sage ERP_Accpac

program )

You must use the Revise Estimates form, in the PJC Transactions folder,
to update estimates for projects that have been opened — usually
following a change order approved by the customer. Revised estimates
appear in the Current Estimates column of the project summary on the
Project Maintenance form.
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Entering Estimates

In setting up any contract in Project and Job Costing, you:

1. Create a new contract record.

2.Assiqn projects to the contract.

3.Assign to each project the cost categories you will use to classify
project costs.

4.For standard projects, assign the resources you will use to complete
the work on each project. For each project resource, you also assign
categories to use to aggregate the costs for each resource.

5.Estimate both the costs required to complete the contract and the
revenue you need to ensure a decent profit, as described in this topic.




Project Style Affects Project Estimation

Estimating Costs

You normally enter cost estimates before revenue estimates, so that you
can better determine the amount of revenue you need to ensure a profit.

How you add cost estimates depends on the project style:

*On a basic project, cost information is accumulated by broad cost
categories. You assign categories to the project, and then enter cost
estimates directly for each category.

eOn a standard project, cost information is accumulated by category
for each resource. You define the cost categories you want to use in
your project. You assign particular resources (such as equipment or
material) to the project, and then you assign the cost categories to
each resource. You enter cost estimates for each resource category.

Estimating Revenue

Project and Job Costing handles revenue estimates differently,
depending on the project type:

eFor fixed price projects, you enter the fixed price you will charge your
customer on the Totals tab of the Project Maintenance form. When
you change the project status to Open, this amount appears as the
revenue for the current estimate.

Project and Job Costing also calculates a revenue amount based on
the markup percentage specified for the project and the estimated
costs for each category (on a basic project) or resource category (on
a standard project). If necessary, you can change the total revenue
amount for a category or resource category as long as the project has
an Estimate status. This revenue amount remains as part of the
original estimate when you open the project.

eFor cost plus projects, the program automatically calculates the
estimated revenue based on the cost plus percentage and the cost
estimates you enter for each category.



To have the program calculate the cost plus percentage, you can
enter a revenue amount for each category (on a basic project) or
resource category (on a standard project).

eFor time and material projects, the program automatically calculates
the estimated revenue depending on the billing rate and the quantity
you enter for each category (on a basic project) or resource category
(on a standard project).

If you prefer to have the program calculate the billing rate, you can
enter revenue amounts for each category or resource category.

In a multicurrency system, you enter revenue amounts in your functional
currency. The program converts the revenue amount to the customer's
currency, if it is different from your functional currency, using the
exchange rate specified on the project's Totals tab.

To enter estimates for a basic project

To enter estimates for a standard project

Entering an Estimate for an Unprofitable Project

From time to time, you may need to enter an estimate for a project where
the expected revenue is less than the expected costs, or you may even
have to revise the estimate of a previously profitable project.

¢To enter an estimate for an unprofitable cost plus project, you enter a
negative cost plus percentage.

¢To enter an estimate for an unprofitable time and materials project,
either enter a negative revenue amount or enter a billing rate that
produces the expected negative revenue.

You cannot enter a negative revenue amount for a fixed price project.



Checking estimates

e¢To check an estimate for a selected contract, click the Totals tab on
the Contract Maintenance form.

*To check an estimate for a project, select the project on the tree, then
click the Totals tab on the Project Maintenance form that appears.

*To check an estimate for a project category, expand the Category
folder on the tree, then select the category you want to view. The
estimate appears on the Estimates tab of the Category Maintenance
form.

¢To check estimates for a resource on a standard project, expand the
folder for the resource, then select the particular resource. The
estimate appears on the Estimates tab of the resource maintenance
form.

eTo check your estimate for a particular resource category on a
standard project, expand the folder for the particular resource, then
select the resource category. The estimate appears on the Estimates
tab of the Category Maintenance form for the resource.

If you use multicurrency accounting, note that all costs are entered in
your functional currency. The program displays revenue and profit in both
currencies. The program converts the revenue and profit from your
customer's currency to your currency using the exchange rate you
entered for the project.



Revising estimates

Once you change the status of a contract from Estimate to Open or
Approved, you cannot update estimates for existing projects and
categories directly. You use the Reuise Estimates form t0 Update estimates —
usually following a change order approved by the customer.

You can add a new project category or resource for an open project at
any time, for which you can enter an estimate until you add the new
category or resource.

Revised estimate amounts appear in the Current Estimates column of the
project summary on the Project Maintenance form, and revised estimate
transactions appear on the Transaction History form and on transaction
listings.

I:E' Related Topics
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Assigning Projects to a Contract

The projects you add to a contract specify the work that you are going to
perform for your customer. Project and Job Costing lets you:

eAdd any number of projects to a contract. Note that you can add only
projects that you have first set up using the Projects form.

*Add projects using the grid on the prjecttab Of the Contract Maintenance
form, Oor you Can use the project Maintenance form.

eAccept the default settings specified in the project record, or change
the settings to suit the particular contract you are setting up. (You use
the conracttab Of the Contract Maintenance form to specify default
settings for all the projects within a contract.)

For each project you assign to a contract, you identify the period during
which you will complete the work, the method by which you will recognize
revenue, the types of costs that will appear on invoices for the project,
and the markup and any overhead costs that will be included in the
invoiced amounts. You also specify the accounts to which cost and
revenue transactions will be posted.

Depending on the project type and accounting method, you also specify

the tax class and tax included status for the project or its categories.

When you use a template to set up a contract, the new contract will
include the projects, categories, and resources used in the original
contract. You many not need to add any new projects.

Note that you must first add a project to your database (using the
Projects setup form) before you can assign it to a contract.

To assign a project to a contract

I:E' Related Topics
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Defining Global Project Settings

When you add a contract, you can specify default settings for all the
projects that you assign to this contract, or you can let the program use
the settings from project records as the defaults. You can change the
settings for individual projects, as long as the contract has an Estimate
status.



Using the same settings for all contract projects

To use consistent default settings for all the projects that you assign to a
contract, simply select the checkboxes beside the options for which you
want consistency, then select the settings you want to use for the
contract.

When you first select a project setting checkbox, the program displays
the default setting from the Options form. You can specify any of the
following settings to be used as defaults for all the projects in the
selected contract:

® Project Type

® Accounting Method

® Overhead Type
® | abor Type
® Billing Type

® Cost Plus Percentage
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Using default settings from project records

To use the settings from your standard project records as the default for a
particular setting, do not select that checkbox on the Contract tab.



Assigning Categories and Resources to a Project

Once you have added a project to a contract, you can assign cost
categories and, for projects using the standard style, the specific
resources that you will use to complete the project.

eOn a basic project, YOU assign categories directly to a project, and then add
esiimates fOr @ach category using the Category Maintenance form.

eOn a standard project, YOU assign categories and resources to each project,
then add esiimates DY COSt category to each resource you plan to use.

Note that you can assign only categories and resource that you

previously set up using the Categories form and the individual resource
setup forms in the PJC Setup folder.

I:E' Related Topics
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Contract Maintenance — Fast Search

If your contracts include a large number projects and categories, you can
use the Search fields on the Contract Maintenance form to display a
particular project or category, without having to scroll through a long list
to find the one you want to work with.

The Search fields, located on the top right of the Contract Maintenance
form help you to find and display quickly:

¢ A specific project within a contract.
¢ A specific category within a contract.

If the program finds the particular code that you specify, it displays the
project (or category) in the Project (or Category) Maintenance form.

If the program cannot locate the specified code, it displays the closest
match. If the displayed project or category is not the one you want, you
can click the Go button to display the next closest match, or you can
begin a new search.

To display a specific contract project

To display a specific contract category




Specifying General Ledger Accounts for Projects

and Categories

When you set up a contract, you assign an account set that contains the
set of default general ledger accounts to use for processing cost and
revenue transactions for any of the projects in the contract.

You can change the accounts for individual projects, as follows:

*Billings and revenue accounts. The program displays these
accounts on the Project tab of the Contract Maintenance form and on
the Project Maintenance form. You specify these accounts only for the
project.

ePayroll expense, employee expense, equipment, labor allocated,
and overhead accounts. The program displays these accounts on
the Accounts tab of the project Category Maintenance form. You
specify accounts to charge for resource use at the category level —
you do not specify accounts for individual resources, even for
standard contracts.

eMaterials account. Note that you do not specify an account for
material usage in Project and Job Costing. The account specified for
an item in Sage ERP Accpac Inventory Control is used in material
usage and return transactions. (If you do not use Inventory Control,
you enter transactions for the cost of materials through Accounts
Payable, specifying the account to charge in that program.)

eWork in progress and cost of sales. How you specify the work in
progress and cost of sales accounts, however, depends on the project
type and accounting method, as follows:

o  For time and material and cost plus projects that use the accrual-
basis accounting method, you specify the cost of sales account for
each category. (These projects do not use a work in progress
account.)

o  For all other time and materials projects, you specify the work in
progress and cost of sales accounts for each category.

o  For fixed price projects, you specify the work in progress and cost



of sales accounts for the project, not for individual categories.

o Accounts for cost plus projects depend on the accounting method,
as well as the project type:

J For cost plus projects that have a completed project, total cost
percentage complete, or labor hours percentage complete
accounting method, you specify the work in progress and cost of
sales accounts for the project, only.

. For cost plus projects with a billings and costs or category
percentage complete method, you specify the work in progress
and cost of sales accounts for each category.



Specifying Tax Information for Projects and

Categories

When you process cost and charge transactions for cost plus and fixed
price projects, the program calculates the applicable taxes using tax
information specified on the Project Maintenance form for the contract
project. The program credits the tax authorities associated with the tax
group specified for the project.

If you need to use a different tax group than the one normally used for
the customer in Accounts Receivable, Project and Job Costing lets you
specify a different tax group for a contract 2. The tax group you aSSign to the contract is
used as the default for new projects you add to the contract, but you can
change the tax group for individual projects. [

You can also specify default tax classes for a contract. To change the
customer tax classes for any of the tax authorities used by the tax group,
click the Zoom button beside the Tax Group field to open the Customer
Taxes form, where you change the tax classes.

The default tax group and tax classes are used for new projects that you
assign to the contract, but you can change the tax group and tax classes
for individual projects. Whether you specify tax classes and the tax
included status at the project level or at the category level depends on
the project type and the accounting method.
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Specifying tax information for fixed price and
cost plus projects

For fixed price projects that use a project percentage complete or a
completed project accounting method and for cost plus projects that have
a completed project, total cost percentage complete, or labor hours
percentage complete accounting method, you specify the tax class and
tax included status for each tax authority on the Taxes tab of the Project
Maintenance form.

For cost plus projects that use the billings and costs, category
percentage complete method, or accrual-basis accounting methods, and
for fixed price projects that use these accounting methods and a
Summary invoice type, you specify tax information for each category on
the Accounts tab of the Category Maintenance form. The program
displays default tax classes and tax included statuses, as follows:

e|f a customer tax class has a corresponding item tax class for the tax
authority in Tax Services, the program uses the tax class from the
customer record as the default, but you can change it.

e|f a customer tax class does not have a matching item tax class for
the authority in Tax Services, the program uses "1" as the default tax
class, but you can change it (if the tax authority permits).



Specifying tax information for time and materials
projects

For time and materials projects, and for fixed price projects that use an
Item invoice type, you do not specify tax information at the project or the
category levels. Rather, you specify the tax class and the tax included
status when you enter a transaction.

In the transaction entry forms, Project and Job Costing displays the tax
authorities used in the customer record. It displays a default tax class, as
follows:

o|f a tax authority is assigned to A/R item, the A/R item tax class for
that authority is displayed.

o|f the tax authorities are not assigned to the A/R item:

o If a customer tax class is used for the item tax class, it is used as
the default for the transaction.

o If a customer tax class dos not exist for the item tax class, the tax
class "1" is used as the default.

The program displays the default tax included status, as follows:

o|f the tax authorities are assigned to A/R item, the tax included status
for the A/R item is used.

o|f the tax authorities arenot assigned to the A/R item, "No" is used as
the default.

You can change the tax included status for a transaction only if the tax
authority permits it.



Tax Estimates

Note that taxes are not automatically calculated for estimates. You must
include tax in the estimated cost amounts.

I:E' Related Topics
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Using Retainage Accounting

Sage ERP Accpac Project and Job Costing supports retainage
accounting.

If you use retainage accounting in Accounts Receivable, you can track
retainage for contracts, projects, and (depending on the project type and
accounting method) project categories in Project and Job Costing.

The pattern for tracking retainage receivable is the same as for revenue
calculation. If revenue is calculated at the project level, then retainage is
also tracked at the project level. If revenue is calculated for each project
category, then retainage is tracked at the category level.

If you use retainage accounting in Accounts Payable, you can track
retainage for project categories. Retainage payable is tracked at the
category level (the same as the costs with which it is associated).

You select retainage options, as follows:

eYou specify a retainage percentage, retention period, and retainage
terms for your customers in Accounts Receivable. The retainage rate
and retention period you specify in the customer record are used as
defaults for projects for that customer. (

Accounts Receivable also lets you specify retainage terms that apply
only to retainage documents you process to clear outstanding
retainage for a customer. If you do not specify retainage terms in the
customer record, the usual customer terms apply to billings you
generate for a customer in Project and Job Costing.

eRetainage payable is calculated in Accounts Payable when you
process a job-related document in that program.

The Default Retainage From option that you set for a project category
determines whether Accounts Payable will use the retainage
percentage and retention period from the vendor record or from the
category as the default retainage percentage and retention period for
an invoice detail that uses the category.

You specify retainage percentages, retention periods, and retainage
terms for your vendors in Accounts Payable.



Retainage and the Contract Maintenance Form

When you use retainage accounting in Accounts Payable or Accounts
Receivable, additional fields appear on the Contract Maintenance form
(and its associated forms) in Project and Job Costing for managing
retainage for contracts.

If you use retainage accounting in Accounts Receivable, the Totals tab on
the Contract Maintenance form now provides retainage information for
the contract in the following new fields:

®[}] Retainage Receivable

o[} Retainage Payable
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Setting retainage options for projects

You use either the grid on the Projects tab of the Contract Maintenance
form or the Project tab of the Project Maintenance form to set options for
receivable retainage for a selected project. You use the following fields:

®[:] A/R Retainage Percentage

®[:] A/R Retention Period

®[}] Retainage Receivable

The program also displays retainage receivable and retainage payable
for a selected project on the Activity tab of the Project Maintenance form.
Receivable amounts are shown in source (customer) currency, while
payable amounts are shown in your functional currency.

If you use retainage accounting in Accounts Payable, the detail grid on
the Contract Maintenance Project tab and the Project tab on the Project
Maintenance form display the following field for a selected project:

®[}] Retainage Payable
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Setting retainage payable options for categories

Retainage payable is determined and tracked at the category level. When
you enter job-related invoices, debit notes, and credit notes in Accounts
Payable, that program calculates retainage for each document detail
according to the retainage options you specified for each project
category.

A Retainage tab is available on the Category Maintenance form to let you
specify retainage defaults for each project category, as follows:

®[}] Default Retainage From

o[ A/P Retainage Percentage and A/P Retention Period

The Retainage tab also displays the following fields:

®[}] Retainage Receivable

®[}] Retainage Payable

Viewing Retainage Information

The Transaction History form also includes the following retainage
information for each document:

eSource Retainage Amount.
eFunctional Retainage Amount.

eRetainage Due Date.

I:E' Related Topics
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Revise Estimates

You can change estimates using the Contract Maintenance form only for
projects that have an Estimate status. You can revert to Estimate status if
you have not recorded any transactions for a project. However, once you
record transactions, you must use the Revise Estimates form to enter
changes that your customer has approved.

The Revise Estimates form lets you :
eAdjust the price of an open fixed price project.

eAdjust the estimate for an existing project category (on a basic
project).

eAdjust the cost plus percentage, markup percentage, overhead rate
(or percentage), and labor rate (or percentage) for an existing project
category.

eAdjust the estimate for an existing resource category (on a standard
project).

*Assign new categories and resources to open projects.
eChange the billing type for any project.
oEdit the description for any project or category.
If you are assigning a new category on a standard project, you must:

1.Enter and post a revise estimate transaction to assign the new
category.

2.Enter and post a separate revise estimate transaction to assign a
resource that will use the new category.

To revise an estimate for a project

I:E' Related Topics
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Entering Opening Balances for Ongoing

Contracts

To ease the transfer of ongoing contracts from another job-costing
system to Sage ERP Accpac, the Opening Balances form lets you enter
opening actuals balances, opening balances for stored material, and
opening activity statistics for projects.

The Opening Balances form is available in the PJC Transactions folder.

Although general ledger entries are not created for posted opening
balance documents, you can view Actuals opening balance transactions
for a specified contract, project, category, or resource using the
Transaction History form.

Once you enter general information for an opening balance document
(“header” information), you can use the detail entry form to enter opening
information for particular contracts, projects, and, as necessary,
categories and resources.

Note:

eContracts and projects must have Estimate or Approved status to
accept opening Actuals balances.

eYou can enter opening balances for stored materials for contracts and
projects that have Estimate, Approved, or Open status.



Choosing the Opening Type

You enter opening actual balances, stored balances, and activity
statistics separately. The Opening Type field lets you indicate which type
of opening information you want to enter. You can select:

eActuals — This type lets you enter opening Actuals balances. Posting
the document creates opening balance transactions that you can view
on the Transaction History form. It also updates Actuals on the
Contract Maintenance form.

eActivity — This type lets you enter opening statistical information for
specified contracts and projects. (No transactions are produced for
opening statistics.)

eStored — This type lets you enter opening balances for material
placed in storage for a particular project. This information is used to
track the allocation and use of material on projects, particularly for the
AlA report required in US jurisdictions.

When you identify the opening type, contract, project, category, and
resource (depending on the project type and accounting method), the
program displays on the detail grid the rest of the fields you are required
to fill in.

The fields that appear on the grid depend on:
eThe opening type.
eThe project type and accounting method for the specified project.
eThe project style.
eThe actuals type, if you selected Actuals as the opening type.



Entering Actuals

Whether you enter opening balances separately for revenue and costs
parallels the way you enter estimates for the project, and depends on the
project type, project style, and accounting method.

For projects for which you estimate revenue and costs at the same
project level (project, category, or resource), you can use the same detail
to enter revenue and cost balances. That is, you do not specify the
actuals type for:

eStandard projects for which you estimate both revenue and costs at
the resource level (that is, for all time and materials projects and for
fixed price projects that use an item invoice type).

eBasic projects for which you estimate revenue and costs at the
category level (that is, for all time and materials projects, for cost plus
and fixed price projects that use the billings and costs or accrual basis
accounting methods, and for cost plus projects that use the category
percentage complete accounting method).

However, for all projects for which you estimate revenue and costs at
different project levels, you must enter opening revenue and cost
balances using separate details. You use the Actuals Type field to
indicate whether you are entering revenue opening balances or cost
opening balances.

Amounts Remaining to be Billed

For time and materials projects and fixed price projects that use the
billings and costs or accrual-basis accounting methods, you need to
separate the unbilled amount from the actual revenue to produce

invoices for costs that you posted but did not bill in your old system.

You enter the unbilled amount in the Remaining To Be Billed field on the
Opening Balances form.

The program invoices the unbilled amount the next time you post a billing
worksheet that includes the project, and when you next run revenue
recognition, it updates the recognized revenue for the project.

Note: You enter the amount in the customer’s currency.



Modifying Posted Opening Balances

If you specify a contract, project, category, and resource for which you
have already posted opening balances, Project and Job Costing warns
you, then displays the original estimates and current Actuals.

If you change the Actuals opening balances, when you post the revised
opening balances transaction, Project and Job Costing overwrites the
original posted balances. Transaction History will display the original
actual opening balances transactions and their reversal, as well as the
revised opening balances.

Click here for step-by-step instructions on entering opening Actuals balances.




Entering Activity Information

If you choose Activity as the opening type, you can enter opening activity
statistics for a specified contract and project. No transactions are
produced when you post activity opening balances. The program simply
updates the activity tab for the project.

Click here for step-by-step instructions on entering opening activity statistics.




Entering Opening Balances for Stored Material

You choose Stored as the opening type to update opening balances for
material in storage for projects.

The project style determines the level at which you enter balances for
material in storage. For standard projects, you identify material resources
that you have assigned to particular project categories. If you use
Inventory Control or Purchase Orders (standalone), you can enter item
numbers from those programs to identify particular material resources for
basic projects.

If you select the option Use AIA Report, additional fields appear that let
you enter information about total revenue and stored balances previously
reported.

Click here for step-by-step instructions on entering opening balances for stored material.




Posting Opening Balance Documents

Although Project and Job Costing updates opening revenue and costs
when you post Actuals opening balances, it does not generate
transactions for General Ledger. However, you can view opening balance
transactions produced for Project and Job Costing in Transaction History.
(The default prefix for opening balance transaction numbers is “OB”.)

You can also view the Actuals posted to the contracts, projects, and
categories in the Contract Maintenance form. After posting Actuals
opening balances, you should compare the actual revenue for projects
and categories with the revenue recognized for the projects and
categories in your old system.

Posting opening activity statistics does not produce any transactions.
Project and Job Costing simply updates the Activity tab for the specified
projects.

When you post Stored opening balances, the program updates the
qguantity and extended cost of stored materials for the category or the
resource category, depending on the project type. It also updates the
Stored Material Audit report with the change to stored quantities and
costs.

I:E' Related Topics


javascript:mc54.Click()

Updating Retainage

The Update Retainage form, available in the PJC Transactions folder, lets
you enter opening retainage balances for contracts you transfer to
Project and Job Costing from another job-costing system.

The Update Retainage form also lets you adjust the retainage receivable
or retainage payable in Project and Job Costing.

When converting from Sage ERP Accpac Plus, for example, outstanding
retainage payable and outstanding retainage receivable are converted to
open invoices in Sage ERP Accpac. Because job information is not
included on these invoices, posting them in Sage ERP Accpac does not
update Project and Job Costing.

Update Retainage provides the means to record the retainage receivable
or retainage payable that is not passed to Project and Job Costing when
you post the open invoice.

When entering an Update Retainage document, you add retainage
balances at the same level retainage is tracked for the particular project
type and accounting method. For example, for a fixed price project that
uses a completed project accounting method, you enter retainage
balances only for the project. For a fixed price project that uses the
billings and costs accounting method, you enter retainage balances at
the project category level.

Note that the program does not produce General Ledger entries for
posted Update Retainage transactions, nor does it update retainage
amounts in Accounts Receivable and Accounts Payable.

I:E' Related Topics
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Contract Maintenance Form — Overview

The Contract Maintenance form is available in the PJC Transactions
folder. This form is the heart of the Project and Job Costing system. You
use the Contract Maintenance form to define every aspect of a contract,
including the projects (or phases) of the contract, the resources you will
employ to get the work done, and the different categories you will use to
classify your costs. You can also use the form to track internal projects
for your own company.

Use the Contract Maintenance form to:

eAdd contracts to your Project and Job Costing system.

® Specify global settings for projects that you will add to the contract, if you want to
override the settings from project and category records.

® Add projects {0 @ contract.

® Assign cost categories and resources to projects, and SpeCify SettingS that determine
whether the associated costs attract overhead or labor burden.

.Open the project Maintenance form, Category Maintenance form, and (for standard
Projects) resource maintenance forms Where you enter or view information for
each project, category, or resource.

® Estimate revenues and expenses fOr each prOjeCt, Category, and (On a standard
ContraCt) resource.

e specify retainage settings 10 D€ used for receivable retainage and payable
retainage.

® Add optional fields for additional information that you want to store with the contract, if you use
Transaction Analysis and Optional Field Creator (a separately
licensed program available from Sage ERP Accpac).

® Change the status of a contract and its projects.

®\View estimated, actual, and recognized total costs and revenues, and the cost of materials in storage for the

contract.

o\iew prOjeCt data, sSuch as transactions OF revenue and cost summaries.

eTurn on the wee view, Which lets you easily view the structure of a



contract, move between its various levels, and enter information for its
projects, categories, and resources.

To create a new contract

To display an existing contract project

To display an existing contract category

Click the buttons below for information about the corresponding tabs on
the Contract Maintenance form:

I:E' Contract

I:E' Project

I:E' Optional Fields

I:E' Totals
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Opening Balances | FieidList_|

Project and Job Costing lets you enter opening actuals balances,
opening stored material balances, and opening activity statistics for
contract projects and their related categories and resources, letting you
transfer to Sage ERP Accpac contracts that you have been managing in
another system.

This topic describes how to enter opening balances and activity statistics
using the Opening Balances form. For detailed background information
on processing opening balance transactions and entering activity
StatiStiCS, SE€€ Entering Opening Balances for Ongoing Contracts.

Note: You update retainage opening balances separately, using the
Update Retainage form. For more information, see Updating Retainage
Opening Balances.

Contracts and projects for which you want to enter Actuals opening
balances must have Estimate or Approved status.

Contracts and projects for which you want to enter Stored balances must
have Estimate, Approved, or Open status.

To enter opening balances for a project in Project and Job Costing

After Entering Opening Balances

It is possible that, in your previous job-costing system, revenue was
calculated slightly differently than in Project and Job Costing. You should
compare the revenue recognized in your previous system to the Actual
revenue amounts shown for a contract and its projects and categories in
the Contract Maintenance form.

If the revenue amounts are different, you need to record manual General
Ledger entries to adjust the appropriate accounts (revenue, billings, cost
of sales, and work in progress accounts). Because opening balances are
tracked only in functional currency, you may also need to record manual

General Ledger entries to adjust source currency amounts.



Updating Opening Retainage Balances

If you use retainage accounting in your Sage ERP Accpac accounting
system, the Update Retainage form lets you enter opening retainage
balances for contracts you are transferring to Project and Job Costing
from another job-costing system.

The Update Retainage form also lets you adjust the retainage receivable
or retainage payable in Project and Job Costing.

Note that the program does not produce General Ledger entries for
posted update retainage transactions, nor does it update retainage
amounts in Accounts Receivable or Accounts Payable. However, the
Transaction History form displays update retainage transactions posted
to a specified project category or resource category. (The default prefix
used for update retainage transaction numbers is "UC.") You can also
view the retainage receivable or retainage payable amounts in the
Contract Maintenance form.

To enter opening retainage amounts




Posting Update Retainage Transactions

When you post Update Retainage transactions, the program updates
retainage receivable or retainage payable for each contract, project, and

Category, [ depending on the retainage type. project type. and accounting method.

I:E' Related Topics
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Adding and Maintaining Budgets

The Budget Maintenance form, available from the PJC Transactions
folder, lets you forecast revenues and costs over several fiscal periods,
so that you can budget your contracts effectively.

You can use the Budget Maintenance form to:
®[t] Enter budgets

®[}] view actual, recognized, and budgeted amounts

®[}] Compare budget sets by fiscal year and period

Note: Although you can view budgeted figures for a contract or a project,
you add budget amounts only at the category level for a project,
regardless of the project type or accounting method.

Budgeting Tools

The Budget Maintenance form provides several tools and calculation
methods to help you create budgets for a project category.

You can use any combination of the following methods to arrive at the
budget amounts:

o[} Import budgets

o[}l Enter budget amounts manually

®[}] calculate budget amounts

®[}] Use the lookup feature

I:E' Related Topics
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Processing Transactions

You choose icons from the PJC Transactions folder to process the
following transactions.

® Adjustments

® Charges

® Costs

® Equipment usage
® Material Allocation
® Material returns

® Material usage
®Revise Estimates

® Timecards

Note: The Material Usage, Material Returns, and Material Allocation
forms are available only if you use Inventory Control with Project and Job
Costing.

You record job-related direct overhead, miscellaneous, subcontractor,
and (if you do not use Inventory Control) material costs using Accounts
Payable Invoice Entry. When you post the invoices, the program updates
your Project and Job Costing contracts.

For step-by-step instructions on processing different types of
transactions, click the following links:

® Adjust a posted transaction

® Allocate stored material for the AIA Report

® Charge a project for equipment usage

® Charge a project for fees and services

® Fnter a miscellaneous cost

® Fnter an employee's timecard

® Reimburse an employee for job-related expenses




® Transfer material to a project

® Return material to inventory

As you process transactions for a project, the program updates the costs
for each project category. When you recognize revenue, the program
updates the portion of costs for which you have recognized revenue.



Contract, project, and resource statuses affect
transactions

Contracts and projects must be open or on hold to be able to post
transactions for them. You will receive a warning when you add a
transaction for a contract or a project that is on hold, but the program will
not prevent posting.

Note that you cannot post transactions for a project that is on hold if the
project has never been opened.

You cannot use resources that have an Inactive status in transactions.
You can, however, use projects and categories with Inactive status.



A note on locked fiscal periods

Fiscal periods are locked separately for each Sage ERP Accpac
program, including Project and Job Costing. Note the following effects of
locked periods on job-related transaction processing:

eThe program checks the status of a fiscal period when you enter
certain dates in Project and Job Costing transactions.

el ocking a fiscal period for PJC does not normally prevent other Sage
ERP Accpac programs from updating information in the Contract
Maintenance form. For example, posting a job-related invoice in
Accounts Receivable or Accounts Payable updates the associated
values for the contracts, projects, categories, and resources in PJC.

An exception to this rule can occur if you post material usage or
material return transactions to a period that is later locked for PJC. If
the period is locked before running Day End Processing, Day End
Processing will not process these transactions, and will generate an
error. To clear the error, you must unlock the period for PJC, and then
run Day End Processing. (Material allocation transactions do not
produce this error.)

e|_ocking a fiscal period for Inventory Control does not prevent Day
End Processing from creating transactions for, or from updating
contracts in, PJC. However, if the period is locked for PJC, you might
not be able to post the transactions in PJC.

I:E' Related Topics
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Using the Transaction Forms

This topic introduces some common elements shared by all Project and
Job Costing transaction forms — once you know how to enter
transactions using one form, the operation of other transaction forms will
seem very familiar.

All transaction forms have the following fields in common:
[ A/R Iltem Number

[ Billing Rate

[t Billing Type

[}l Extended Billing Amount

[}l Extended Cost

[ GI/L Accounts

[ Quantity

[t status

[} Transaction Date

& vear/Period and POSting Date

[} Unit Cost
[}l Unit of Measure

The fields that appear and which ones you can edit depend on the
contract and project type used in the detail

When entering transactions in Project and Job Costing, you can enter
details on the detail entry grid provided with all transaction forms, or you
can enter them on a separate detail entry form that you open by clicking
the Detail/Tax button on any transaction form. The detai entry forms iNclude
additional fields for changing accounts and tax information.
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Multicurrency

In multicurrency systems, you do not enter currency or exchange rate
information with transactions. Instead, you enter amounts in your
functional currency, and Project and Job Costing uses the current
exchange rate at the time of billing. If no current rate exists for that date,

the program uses 1.0000000 as the default rate.



Detail/Tax forms

The transaction forms also let you open Detail/Tax forms where you can
view existing details or enter new details for the transaction. Entering
details on the Detail/Tax forms provides two advantages over the detalil
entry grid on the transaction form:

eYou can view all the information for a single detail at once.

In addition to the detail fields that appear on the main transaction
form, the form also displays tax fields for time and materials projects,
as follows:

o  Tax Authority and Description. The program displays the tax
authority and description from the customer record.

o Tax Class and Description. The program displays the tax class
from the A/R item record.

If no tax authorities are assigned to the A/R item, the customer tax
class is used, if there is a corresponding item tax class for the tax

authority (in Tax Services). If there is no matching tax class in Tax

Services, the tax class "1" is used.

You can change the tax class for the detail.

o  Tax Included. If tax authorities are assigned to the item, the Tax
Included status from the A/R item record is used as the default for
this field. Otherwise, No is the default. You can change the tax-
included status for the detall, if the tax authority permits it.



Journal Entries Generated from Posted

Transactions

This topic describes the general ledger journal entries created from cost
transactions you post in Project and Job Costing. These entries appear
on the G/L Transactions report.

It also describes general ledger journal entries created for job-related
transactions by Accounts Receivable, Accounts Payable, and Inventory
Control.

It also describes the transactions created during revenue recognition.

Material Usage (source code PM-MU)

When you run Day End in Inventory Control, that program calculates
material costs based on the costing method used for the item in Inventory
Control. Then it credits the inventory account assigned to the inventory
item and the overhead allocated account and debits work-in-progress (or
cost of sales, for projects that use the accrual-basis accounting method).

General
Ledger Debit | Credit
Account

WIP (or COS) X

Inventory X

Overhead

Allocated X

Material Returns (source code PM-MR)

When you run Day End in Inventory Control, that program debits the
inventory account assigned to the inventory item and the overhead
allocated account and credits work in progress (or cost of sales, for
projects that use the accrual-basis accounting method) for materials
returned to inventory.

General




Ledger Debit | Credit
Account

Inventory X
Overhead X
Allocated

WIP (or COS) X

Equipment Usage (source code PM-EQ)

When you post equipment charges to a project category, the program
creates entries to debit work in progress (or cost of sales, for projects that
use the accrual-basis accounting method) and credit overhead and the
equipment contra-account you specify.

General
Ledger
Account

Debit

Credit

WIP (or COS)

X

Equipment
(contra-
account)

Overhead
Allocated

X

Timecards (source code PM-TC)

When you post timecards in Project and Job Costing, the program debits
work in progress (or cost of sales, for projects that use the accrual-basis
accounting method) and credits the wage expense and related labor and
overhead accounts (if applicable).

General

Ledger Debit | Credit
Account

WIP (or COS) X




Wage Expense X
Labor (Burden) X
Allocated
Overhead X
Allocated

Charges (source code PM-CH)

The following entry is posted in Accounts Receivable when you post an
invoice that includes a charge transaction.

General
Ledger
Account

Debit

Credit

Receivables
Control

Billings

X

Accounts Receivable

Posted invoices debit the general ledger receivables control account
assigned to the customer and credit the billings account (or the revenue
account, for projects that use the accrual-basis accounting method).

General Ledger Account | Debit

Credit

Receivables Control

X

Billings

Accounts Payable

Posted invoices debit the work in progress account (or cost of sales, for
projects that use the accrual-basis accounting method) and credit the

payables control account.

General Ledger Account | Debit

Credit

WIP (or COS)

X




Payables Control ‘ ‘ X

Revenue Recognition (source code PM-RR)

The program generates general ledger entries to recognize revenue and
gross profit, and to record the matching costs for the period (for
percentage completion and billings and costs methods) or for the entire
project (for the completed project method).

The journal entries, and their timing, vary according to the project type
and accounting method. To review the journal entries for each project
type and accounting method, click the following links:

eRevenue recognition for cost plus projects

o Accrual Basis

o Billings and Costs

o Completed Project Revenue

o Percentage Complete Methods

eRevenue recognition for fixed price projects
o Accrual-Basis
o Billings and Costs

o Completed Project

o Project Percentage

eRevenue Recognition for time and materials projects

o Accrual-Basis
o Billings and Costs

o Completed Project

If you use the option to clear billings and work in progress during revenue
recognition, Project and Job Costing also creates general ledger entries
to debit the billings account and credit work in progress for projects that
use a percentage complete accounting method.

Note: If you reopen a project, you may have to reverse some or all of the
revenue recognition entries, depending on the project's accounting



method. To read more about reversing revenue entries, see the entry
Reversing Revenue Recognition 1IN the Reopening Projects topic.




Multicurrency Accounting

Sage ERP Accpac Project and Job Costing supports multicurrency
accounting.



Estimates

For project estimates, you enter all costs in your functional currency, and
you enter revenue in the customer currency.

You also enter a rate type, rate date, and exchange rate for the original
project estimate. Once you open the project for transactions, the program
saves the original exchange information separately, so you can enter the
current exchange rate for the current estimate.

Project and Job Costing displays estimated revenue for a project in both
customer and functional currencies. It uses the original exchange rate to
convert the original estimated revenue to functional currency; it uses the
current exchange rate to convert the current estimated revenue and
actual revenue to functional currency.

Note that when you specify units of measure in an estimate or on
transactions for time and materials projects, you must choose a unit of
measure that is defined for the currency in the A/R item record.



Cost transactions

In Project and Job Costing transaction entry forms, you enter costs in
your functional currency. For transactions involving time and materials
projects, you enter the billing rate or the extended billing amount in the
customer currency.

Cost transactions are posted in Accounts Payable in both vendor and
functional amounts, as for any Accounts Payable invoice.



Billings

Project and Job Costing produces invoices using your customer's
currency.

eFor time and materials projects, transactions are stated on customer
invoices using the extended billing amount from the transaction.

eFor cost plus and fixed price contracts, amounts are converted to
customer currencies at the time of billing using the current exchange
rate. If no default exchange rate exists, the program uses 1.0000000
as the exchange rate.



Exchange gains and losses

Exchange gains and losses are not posted to Project and Job Costing.
They are calculated in Accounts Receivable or Accounts Payable at the
time of payment, or when you post an applied debit note, an applied
credit note, or an adjustment in those programs.

Exchange gain and loss amounts are sent back as reconciling items to
Project and Job Costing, so that Accounts Receivable and Accounts
Payable remain in balance with Project and Job Costing. You can view
these items using the Transaction History form.

I:E' Related Topics
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Managing Commitments

Project and Job Costing integrates with Sage ERP Accpac Purchase
Orders, letting you track committed and actual quantities and costs by
contract, project, category, and — on standard projects — resource.

When you post a job-related purchase order, the Purchase Orders
program updates the committed quantities and costs for the specified
contracts, projects, categories, and resources in Project and Job Costing.

Any of the following types of changes in a job-related purchase order will
also generate transactions for Project and Job Costing:

eChange in quantity.

eChange in cost.

eAdding new detail lines.

eDeleting a detail line or a purchase order.
eChange in exchange rate.

eChange in tax rates.

When you post a job-related receipt, Purchase Orders reverses the
commitments in Project and Job Costing and updates the actual
guantities and costs for the received amounts. It also records any
additional costs you post with receipts.

Purchase Orders also updates actuals when you post an adjustment to a
job-related receipt for any of the following:

eQuantity received.
eCost.

eAdditional cost.
eTax amounts.
eExchange rates.

If you use retainage accounting, retainage amounts are calculated during
day-end processing using defaults as specified for the project category in
Project and Job Costing.



Note that Project and Job Costing performs any overhead calculations,
and sends the information back to Purchase Orders, so it can be used in
the general ledger entries.

For information about entering job-related transactions in Purchase
Orders, see the Purchase Orders help.

Viewing Purchase Orders Information in Project
and Job Costing

Project and Job Costing lets you track information sent from Purchase
Orders in variety of ways. You can:

ePrint transactions generated by Purchase Orders on the PJC Detailed

Transactions report.

e\/iew transactions sent from Purchase Orders on the Transaction

History form, which also lets you drill down to an original Purchase
Orders transaction.

*View committed quantities and costs for each level of a contract using

o

the:

Totals tab on the Contract Maintenance form to view commitments
for the contract as a whole.

Totals tab on the Project Maintenance form to view commitments
for an entire project, or use the individual project resource tabs (for
example, Employee or Equipment) to view commitments for the
project by resource type.

Estimates tab on the Category Maintenance form to view
commitments for a specific project category.

Estimates tab on the resource maintenance form to view
commitments for a specific project resource.

Estimates tab on the resource category form to view a breakdown
for a project resource by category.



Allocating Serial and Lot Numbers in Material

Transactions — Overview

If you have a license to use Sage ERP Accpac Serialized Inventory and
Lot Tracking, you can allocate serial numbers and/or lot numbers to items
that you remove from or return to inventory in material usage and
material returns transactions.

When you process material usage transactions that include @ serialized OF
lotted ItEMS, YOU USE the serial/Lot Numbers Allocation fOrm to allocate serial numbers
or lot numbers to items in a transaction detail.

When you return serialized or lotted items to inventory in material return
transactions, you use the serialiLot Numbers Generation fOrm to reassign serial
numbers or lot numbers to the items you are returning in each detail.

Note: You can use the PJC Adjustments form to transfer material usage
or material return transactions for serialized or lotted items to a different
contract, project, or category. However, you cannot adjust these
transactions using the Adjustment type. If you need to change the
guantity or an item number used in a transaction, you can process a
material return, then process another, correct, material usage transaction
using the correct quantities and items.

Before you can allocate serial numbers or lot numbers to items in
transactions:

eThe I/C item record must require serial numbers Ol lot numbers.

eSufficient serial numbers or lot numbers must available for the item at
the inventory location from which you are shipping the items.

Use the Serial Number Inquiry and Lot Number Inquiry forms in
Inventory Control to check whether serial numbers or lot numbers are
available for the items you plan to use in a material usage transaction.

If the 1/C item record allows the serial quantity or the lot quantity to be
different from the entry quantity, you can post a transaction even if
you have not allocated numbers to the total quantity of serialized or
lotted items.

eIf you are returning serialized inventory, identify the serial numbers
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assigned to the items, as well as the contract, project, category, and
resource used in the transaction that transferred the items to the job.

eIf you are returning lotted items to inventory using material returns
transactions, identify the lot, or partial lot, from which you are
returning items.

To allocate serial numbers in material usage transactions

To allocate serial numbers in material return transactions

To allocate lot numbers in material usage transactions

To allocate lot numbers in material return transactions




Adjustments | Fieid Lit_|

You use the Adjustments form to adjust or transfer a timecard, equipment
usage, material usage, material return, cost, or charge transaction that
you have posted in Project and Job Costing. (Note that both the contract
and project must be open or on hold to be able to transfer a transaction
between projects or categories.)

To adjust transactions originating in another Sage ERP Accpac program,
you use that program. For example, to adjust a transaction that you have
invoiced in Accounts Receivable, you must use the Adjustment Entry
form in Accounts Receivable. To adjust amounts originating in Purchase
Orders, you must adjust the purchase order, receipt, or return in the
Purchase Orders program.

The Adjustments form lets you adjust the A/R item number, the unit of
measure and the unit cost, the quantity, extended cost, and billing rate for
a posted transaction, or transfer a transaction to the correct contract,
project, or category, if the original transaction was posted incorrectly.

Note:

¢A contract and project must be open or on hold to be able to receive a
transfer.

eYou cannot adjust or transfer items that use serial numbers or lot
numbers.

eYou can transfer a transaction from a time and materials project only
to another time and materials prOjeCt Or tO a [ fixed price project that uses an item

invoice type.

eYou can transfer a transaction from a cost plus project to another cost
plus project or to a fixed price project that uses the project percentage
complete or completed project accounting method.

eYou can transfer a transaction from a fixed price project that uses the
project percentage complete or completed project accounting method
to a fixed price project that uses either of these accounting methods,
or to a cost plus project..

eYou can transfer a transaction from a fixed price project that uses the
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billings and costs or accrual-basis accounting method to a fixed price
project that uses either of these accounting methods. However, both
projects involved in the transfer must use the same invoice type (item
or summary).

eYou must use the Adjustment Entry form in Accounts Receivable to
adjust a transaction that you have billed in Accounts Receivable.

eYou must use the Adjustment Entry form in Accounts Payable to
adjust a transaction originating in Accounts Payable.

e|f you adjust or transfer a timecard for a payroll employee, Project and
Job Costing will update the timecard only if you have not yet updated
Payroll. If you have sent the timecard to US or Canadian Payroll, you
must adjust the timecard in Payroll, also.

To enter an adjustment

I:E' Related Topics
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Budget Maintenance

The Budget Maintenance form, available from the PJC Transactions
folder, lets you forecast revenues and costs over several fiscal periods,
so that you can budget your contracts effectively.

You can use the Budget Maintenance form to:
®[t] Enter budgets

®[}] view actual amounts

®[}] Compare budget sets by fiscal year and period

You choose the Budget Maintenance form from the PJC Transactions
folder.

Before Using Budget Maintenance

Make sure you have selected the Update Budgets option on the PJC
Options form, so that Project and Job Costing will update Budget
Maintenance whenever you process cost transactions or revenue
recognition transactions. Project and Job Costing maintains Actuals for
contracts you add after you turn the option on.

Note: This option affects only budget sets set up in the Budget
Maintenance form. Project and Job Costing continues to update the
estimates, actuals, committed, recognized, and stored amounts you see
on the Contract Maintenance form, regardless of your choice for this
option.

[ To add a budget for a project category

[}l To display period amounts for any project category

[l To change a budget for a project category

[l To clear all the period amounts for the displayed budget set

[l To delete a budget set
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Charges

The Charges form lets you apply fees and service charges for which you
have not incurred a cost to the following types of projects:

eTime and materials projects.

eFixed price projects that use the billings and costs or accrual-basis
accounting method.

You can also use the form to trigger billings for these types of projects if
customers are to make prepayments. (You would then use no-charge
categories when you process cost transactions to avoid billing customers
twice for the same work, and to itemize the actual costs on subsequent
invoices.)

Note that because Charge transactions do not transfer actual costs or
expenses to your projects, the Charges form does not provide fields for
Work In Progress, Cost Of Sales, or an expense account.

To enter a charge transaction

I:E' Related Topics
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Costs

The Costs transaction form, available in the PJC Transactions folder, lets
you use Project and Job Costing to post miscellaneous cost transactions
without affecting Accounts Payable. For example, you might use the
Costs form to record a purchase paid from petty cash, where you do not
need to credit a vendor account.

You can post cost transactions for any project category or resource
category in a contract.

When you post a cost transaction, Project and Job Costing debits a work
in progress account (or cost of sales account) and it credits a specified
cost account.

The program displays the work in progress account or the cost of sales
account from the project or category (depending on the project type and
accounting method). You can change the work in progress account in
transactions only for projects that use an item invoice type. You can
change the cost of sales account for any project that uses the accrual-
basis accounting method.

The program also displays the cost account assigned to the project
category as the default, but you can change the account for any cost
transaction.

Note: To record a job-related miscellaneous cost for which you paid a
vendor, you must use Accounts Payable or Order Entry. See the Help for
these programs for further information.

To enter a cost transaction

I:E' Related Topics
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Equipment Usage

You use the Equipment Usage form to record the use of equipment that
you own. Equipment usage transactions transfer a portion of the cost of
your equipment to the projects for which the equipment is used.

To enter an equipment usage charge

To print a transaction listing, choose Print Transaction Listing from the
File menu. The Transaction Listings report form opens, where you can

specify the transaction type and range of document numbers to include
on the report.

I:E' Related Topics
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Material Returns

If you use Sage ERP Accpac Inventory Control, you use the Material
Returns form to:

eReturn to Inventory Control the cost of unused items you have
charged to projects.

eAllocate serial numbers and/or lot numbers serialized and lotted items
used in a material return transaction detail, if you use Sage ERP
Accpac Serialized Inventory and Lot Tracking.

If you do not use Inventory Control, you enter a credit note in Accounts
Payable when you return material to a supplier. (You also enter a credit
note in Accounts Payable if you did not receive the item in Inventory
Control, and now need to process the return directly.)

To return the cost of material to Inventory Control

To print a transaction listing, choose Print Transaction Listing from the
File menu. The Transaction Listings report form opens, where you can
specify the transaction type and range of document numbers to include
on the report.

I:E' Related Topics
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Material Usage

If you use Sage ERP Accpac Inventory Control, you use the Material
Usage form in Project and Job Costing to:

eTransfer the costs of items from Inventory Control to specific projects
in Project and Job Costing.

eAllocate serial numbers and/or lot numbers to serialized or lotted
items used in a material usage transaction detail, if you use Sage
ERP Accpac Serialized Inventory and Lot Tracking.

If you do not use Sage ERP Accpac Inventory Control, the Accounts
Payable Invoice Entry form lets you enter job-related purchases of
materials for the contracts, projects, and categories for which the material
will be used. You can also enter an invoice in Accounts Payable if you
want to charge the cost of materials directly to a project, without first
receiving the items in Inventory Control.

Before you process a material usage charge, ensure that:
eThe items are assigned to the project as material resources.

*An |I/C item record exists in Inventory Control. Because you are
required to supply an Inventory Control item number and an Accounts
Receivable item number for material usage transactions, ensure that
item records exist in both programs for each item used in projects.

The I/C item number is required to transfer the cost from Inventory
Control to the project.

The A/R item number is used on item invoices when billing
customers. (You use item invoices to bill for all time and materials
projects, and for some fixed price projects.)

To enter a material usage transaction
To print a transaction listing, choose Print Transaction Listing from the
File menu. The Transaction Listings report form opens, where you can

specify the transaction type and range of document numbers to include
on the report.
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Material Allocation

You use the Material Allocation form, available in the PJC Transactions
folder, to reduce the amount of material stored for a project as the
material is used.

The stored and allocated amounts are used to produce the aaRrepor.

Note: Material Allocation transactions do not generate entries for general
ledger, and they do not affect actuals. They are for tracking and reporting
purposes, only.

For more information on tracking material in Project and Job Costing, see

Tracking Material Used on Projects.

To enter a material allocation transaction

I:E' Related Topics
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Timecards

In Project and Job Costing, you charge job-related labor costs to projects
using timecards. Note that:

eThe program uses weekly timecards as the default, but you can edit
the start and end dates for individual timecards, if you use a different
pay period.

eYou enter wage cost transactions for individual employees using the
[] Time Details tab or the separate Timecard - Time form. YOU enter a Separate timecard for
each pay period.

eYou reimburse employees' out-of-pocket expenses using the Expense
tab.

If you use security in your Sage ERP Accpac system, employees with
timecard access can enter their own timecards, indicating when the
timecards are ready for approval. Later, someone with the required
authorization can approve the timecards for posting.

If you use Sage ERP Accpac Payroll, you run Update Payroll to create
timecards in Payroll from those that you have posted in Project and Job
Costing. You can then generate employee checks in the usual way. You
can also import timecards from and export timecards to Payroll.

To enter an employee's timecard

To print a transaction listing, choose Print Transaction Listing from the
File menu. The Transaction Listings report form opens, where you can
specify the transaction type and range of document numbers to include
on the report.

I:E' Related Topics
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Post Transactions

You use the Post Transactions form in the PJC Transactions folder to
post transactions to contracts.

You can post a single transaction or a range of transactions, but you can
only post transactions of a single type at one time. Note that you can also
post selected transactions individually using the Post button on the
original transaction entry form.

Project and Job Costing assigns a unique posting sequence number to
each posting run. This number appears on the posting journal for each
transaction type, providing an audit trail. (The next posting sequence
number to be assigned appears on the Transactions tab of the Options
form for each transaction type.)

Posting also creates all necessary general ledger transactions arising
from posted transactions. On the Integration tab of the G/L Integration
form, you can choose whether transactions are placed in a general

ledger batch during posting, or later, using the Create G/L Batch form.

To post transactions




Transaction History

You use the Transaction History form to view by contract, project,
category, and resource, the details of all transactions posted in Project
and Job Costing and job-related transactions posted in Accounts
Receivable, Accounts Payable, Purchase Orders, Order Entry, and US or
Canadian Payroll.

To display the Transaction History form, either

eDouble-click the Transaction History icon in the PJC Transactions
folder.

You can specify a particular contract number to view only transactions
for that contract. To narrow the display still further, you can also
specify the project, category, and resource.

eRight-click a particular contract, project, category, or resource on the
tree in Contract Maintenance, then click Transactions. The
Transaction History form then opens, displaying transactions for the
selected contract, project, category, or resource.

You can also restrict the display to transactions that originated in an
application you specify (say, Accounts Payable, or Canadian Payroll).

The display includes all the data from transactions posted for the
specified contract, project, category, or resource. You can use the
horizontal and vertical scroll bars to view all the rows and columns.

Drilling Down from Transaction History

You can also drill down from a transaction displayed on the Transaction
History form to view source documents, including revised estimates and
transactions originating in other ledgers (such as an invoice in Accounts
Receivable).

To drill down to a transaction from the Transaction History form

eIn the grid on the Transaction History form, double-click a transaction
to display the source document in the originating ledger and entry
form, or select the transaction, then click the Details button.



Retainage Information

If you use retainage accounting, the Transaction History form includes
the following retainage information for each document:

eSource Retainage Amount.

eFunctional Retainage Amount.

eRetainage Due Date.

eSource Total (amount plus retainage in source currency).
eFunctional Total (amount plus retainage in functional currency).

I:E' Related Topics
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Create Billing Worksheet

Use the Create Billing Worksheet form to generate billing transactions
automatically in Project and Job Costing.

When you post a billing worksheet, Project and Job Costing uses the
worksheet transactions to create invoices for Accounts Receivable.

Overview of the billing process

Calculation of Billing Amounts

To create a billing worksheet

EE} Related Topics
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Calculation of Billing Amounts

Together, the project type and the accounting method determine the & jevel

of detail included on invoices.

This topic provides the formulas the program uses to calculate invoice
detail amounts according to project type and accounting method, and
notes the treatment of revenue amounts in a multicurrency system.
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Time and Materials

For all time and materials invoices, the billing amounts are calculated
when you post transactions; these are the amounts that are used for the
billing detalils.

For each billable transaction, the program calculates the billing amount
as follows:

Billing amount = Quantity * Billing rate (in customer currency)

The billing amount is converted to functional currency using the current
exchange rate at the time of invoicing. The cumulative amounts billed for
the project appear as Actual Revenue on the project's Totals tab in both
functional and source currencies. The total billing amounts from unbilled
transactions appear in the customer currency as Expected Billings on the
project's Activity tab.



Fixed Price Projects

Project and Job Costing calculates invoice amounts in the customer
currency for fixed price projects.

The invoiced amount for a project is converted to functional currency
using the current exchange rate, and is displayed as Actual Revenue on
the project's Totals tab. Current billings (from unposted worksheets and
from invoices in Accounts Receivable) are shown in the customer
currency on the project's Activities tab.

Accrual-basis and billings and costs

For fixed price projects that use the accrual-basis or billings and costs
accounting method, the program calculates a summary invoice detail for
each billable transaction, as follows:

Billing rate

- — ity * -
Billing amount = Quantity (in customer currency)

Completed Project

For fixed price projects that use the completed project accounting
method, Project and Job Costing produces invoices only when the project
is marked Complete. The program creates one invoice detail for a
project's fixed price amount (in the customer currency).

Project Percentage Complete

For fixed price projects that use the project percentage complete
accounting method, the program creates an invoice for each project
using the current percentage complete calculated for the project. It
calculates the billing amount as follows:

[%compiete * Fixed price amount] - Amounts already billed



Cost Plus Projects

The current exchange rate is used to convert the functional billing amount
to customer currency. The cumulative amount billed is shown in both
currencies on the project Totals tab.

Current billings for the project are shown in the functional currency on the
project's Activity tab.

Percentage Complete Accounting Methods

For cost plus projects that use a percentage complete accounting
method, the program first calculates the current percentage complete,
then applies that percentage to the revenue estimate for the project (or
category, for the category percentage complete method) to determine the
amount to bill.

Note that in multicurrency systems, the program first calculates the billing
amount in functional currency (using the functional revenue estimate),
and then applies the current exchange rate to convert the amount to the
customer currency.

The cumulative billed amounts are shown in both currencies on the
project's Totals tab. Current billings for the project are shown in the
functional currency on the project's Totals tab.

The following sections provide the formulas used to calculate the amount
to bill for each aCCOl,Inting methOd, given the current percentage complete.

Note that the estimates and billed amounts used in these formulas are in
functional currency.

Total cost percentage complete

For projects that use the total cost percentage complete accounting
method, Project and Job Costing calculates an invoice detail for each
project as follows:

[% compiete * Current revenue estimate]- Amounts already billed

Labor hours percentage complete
For cost plus projects that use the labor hours percentage complete



accounting method, the program calculates an invoice detail for each
project as follows:

[%compete * Current revenue estimate] - Amounts already billed

Category percentage complete

For cost plus projects that use the category percentage complete
accounting method, the program calculates an invoice detail for each
project category:

[ , Current category revenue _ Amounts already
Complete estimate] billed

Billings and costs

For projects that use the billings and costs accounting method, the
program calculates one detail line for each project category as follows:

[Actual category , Cost plus _ Amounts already
cost percentage] billed

Accrual-basis

For cost plus projects that use the Accrual-basis accounting method, the
program calculates an invoice detail for each project category as follows:

[Actual category , Cost plus _ Amounts already
cost percentage] billed

In a multicurrency system, Project and Job Costing sends all billing
amounts to Accounts Receivable in each customer's currency. To
determine the amounts to invoice in the customer currency, Project and
Job Costing:

eFor time and material projects, uses the billing amount specified in the
customer currency from each transaction.

eFor cost plus projects, calculates the amount to bill in functional
currency, then converts this amount to the customer currency.

eFor fixed price projects, calculates the amount to bill in the customer
currency. (The fixed price for the project is given in the customer
currency.)

When you post the invoices, Accounts Receivable calculates and sends



billing amounts in both customer and functional currencies to Project and
Job Costing. The project is updated in both currencies.



Billing Worksheet

You use the Billing Worksheet form to review, adjust, and individually post
billing worksheets.

You can also print the giling worksheet report. (ON the File menu, click Print.)

Before posting the worksheet entries, you can adjust amounts and
descriptions. Also, you can change the percentage complete for a project
that uses a percentage complete accounting method, if you want to use a
different percentage than the one the program calculates.

To view, edit, or post a billing worksheet

I:E' Related Topics
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Post Billing Worksheets

You use the Post Billing Worksheets form to create Accounts Receivable
invoice batches for a range of worksheets.

When you post a billing worksheet, Project and Job Costing adds the
invoices to an open "PM" source batch, if one exists in Accounts
Receivable. If there is no open invoice batch, Project and Job Costing
creates a new invoice batch for the invoices. You can edit and print the
invoices in Accounts Receivable, as you would for any other type of
invoice.

When you post the invoices in Accounts Receivable, Accounts
Receivable:

eCreates general ledger journal entries to debit the receivables control
account and credit the billings account. For item invoices, it also
creates entries to debit the work in progress account and credit
inventory.

eSends posting information back to Project and Job Costing. Any
changes you made to invoices in Accounts Receivable are made in
Project and Job Costing, also.

To post a range of billing worksheets:
1.Choose Post Billing Worksheets from the A/R Billing folder.

2.Select All Worksheets to post all unposted worksheets, or select
Range and specify a range of worksheets to post.

3.Click Post.

I:E' Related Topics
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Recognizing Revenue

You use the icons from the Revenue Recognition folder to generate and
edit transactions to recognize project revenue for all projects except
those that use the accrual-basis accounting method.

eYou use the Create Revenue Recognition Worksheet form to generate
entries that recognize revenue for all your projects or for a selected
range of projects or project categories. Revenue recognition also
closes projects that you have marked Completed.

*The Revenue Recognition Worksheet form lets you edit the account
numbers, the debit amount, and the credit amount for each entry that
appears on the worksheet. Once you are satisfied that the entries are
correct, you post the entries from the Revenue Recognition
Worksheet form.

Project and Job Costing lets you select projects for which to recognize
revenue in a number of ways. You can recognize revenue for a single
contract, a range of contracts, or for all contracts. You can also limit
revenue recognition to particular projects, categories, account sets,
project types, and accounting methods.

You can also include on revenue recognition worksheets projects to
which you have processed no transactions in the period, letting you
complete and close a project in a subsequent period after recognizing all
revenues for the project.



Project Type and Accounting Method Affect
Revenue Recognition

In Project and Job Costing, the project type and accounting method
jointly determine how revenue recognition proceeds. Except for projects
that use the accrual-basis accounting method, billing and revenue
recognition are separate processes that trigger different accounting
entries:

*\When you post invoices, the program debits Accounts Receivable
control and credits the billings account.

*\When you create and post a revenue recognition worksheet, the
program debits the specified work in progress and cost of sales
accounts and credits revenue.

For projects using the accrual-basis accounting method, billing and
revenue recognition are simultaneous processes — invoices are posted
directly to the Accounts Receivable control and revenue accounts.

For projects using any other accounting method, however, billing and
revenue recognition are separate processes. When you post invoices for
these projects, the program debits the Accounts Receivable control
account and credits the billings account for invoiced amounts. The
revenue account is unaffected by billing. For these projects, you use the
revenue recognition functions to recognize revenue.



Clearing Billings and Work In Progress
Accounts During Revenue Recognition

If you use the option Clear Billings And WIP During Revenue
Recognition, the program performs the following operations for
completed projects that use a percentage complete accounting method:

1.Calculates revenue that has not yet been recognized.
2.Sets the project status to Closed.

3.Creates general ledger entries to debit the billings account and credit
the revenue account for the current revenue, and to debit work in
progress and credit cost of sales for the remaining costs.



Timing of Revenues

When you run the revenue recognition functions, the program recognizes
the revenue earned since you last ran the function, charging the billings
account and crediting the revenue account. It also debits the cost of sales
account and credits the work in progress account.

For projects that use the completed project accounting method, you
recognize revenue only after you have finished all the work for the project
and you have set the project status to Completed.



Expensed Taxes and Revenue Recognition

If you expense taxes separately and you do not expense taxes directly to
the work in progress account, you may need to create manual journal
entries to debit the work in progress account for separately expensed
taxes following revenue recognition.



Multicurrency

Note that in multicurrency systems, the program calculates revenue in
functional currency, and then, for projects using a percentage completion
accounting method, converts the recognized revenue to the customer
currency using the current exchange rate. The recognized revenue is
then displayed in the customer currency on the Project Totals tab, on the
Contract Maintenance form.

For the billings and costs and completed project accounting methods, the
exchange rate is imputed based on the amounts invoiced in source and
functional currencies.

I:E' Related Topics
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Create a Revenue Recognition Worksheet

You use the Create Revenue Recognition Worksheet form to generate
entries to recognize revenue for all your projects or for a selected range

of projects or project categories. Revenue recognition also closes projects that
you have marked Completed.

To recognize revenue

EE} Related Topics
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Revenue Recognition for Cost Plus Projects

This topic describes revenue recognition for cost plus projects under the
following accounting methods.

® Percentage Completion Methods

®Bijllings and Costs Method

® Completed Project Method

® Accrual-Basis Method




Percentage Completion Methods

For cost plus projects using any of the percentage completion methods,
the program first calculates the percentage compiete. Then, to determine the
amount of revenue to recognize for the period, the program:

1.|I| Determines the revenue earned to date.

2.|I| Determines the amount of revenue to recognize for the period.

3.|I| Determines the profit earned to date.

4.|I| Determines the profit to recognize for the period.

5.|I| Determines the cost for the period.

6.1f the project is marked Complete, or if you use the option to clear
billings and work in progress during revenue recognition, the program
clears the accumulated, offsetting amounts from the billings and work
in progress accounts and marks the project Closed.

The journal entry to record revenue periodically throughout the project
depends on your selection for the Percentage Completion Method
option on the Settings tab of the PJC Options form.

oIf you opted to clear the billings and work in progress accounts when
you close percentage completion projects, the entries are as follows:

General Ledger
Account

Debit

Credit

Work in Progress
(gross profit)

X

Cost of Sales

X

Work in Progress
(loss)

X

Revenue

X

The following general ledger entry is used when you complete a
project that uses a percentage complete accounting method:

General Ledger

Debit

Credit
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Account
Billings X

Work in Progress X

If there are any unrecognized amounts in the billings account (from
invoices entered manually through Accounts Receivable), the
program adjusts the revenue account, accordingly. Note that this entry
may be combined with the closing entry.

General Ledger Debit | Credit
Account

Billings X
Revenue X

If there are any unrecognized costs in the work in progress account
(that is, non-labor costs that were not recognized under the labor
hours percentage complete method), the program adjusts the cost of
sales account:

General Ledger Debit | Credit
Account

Work in Progress X

Cost of Sales X

e|f you opted to clear the billings and work in progress accounts during
revenue recognition, the entry is:

General Ledger Account |Debit|Credit

Billings X
Revenue X
Cost of Sales X
Work in Progress X

Cost of Sales (for an
overall loss, if any)




Work in Progress (for an X
overall loss, if any)

Note that if a change in an estimate or in actual costs results in an
anticipated overall loss, the program creates an additional debit to the
cost of sales account and a credit to the work in progress account to
recognize the entire loss immediately.



Billings and Costs Method

To calculate revenue for cost plus projects that use the billings and costs
accounting method, the program determines:

eThe amount to credit the revenue account for the period.

This is the total amount billed for the project to the specified cut-off
date or fiscal year and period, or since you last recognized revenue.

General Ledger Debit | Credit
Account

Billings X
Revenue X

eThe amount that will be charged to the cost of sales account for the
period.

This is the total cost incurred on the project to the specified cut-off
date or fiscal year and period, or since you last recognized revenue.

General Ledger Debit | Credit
Account

Cost of Sales X

Work in Progress X

eThere is no entry to the work in progress account for gross profit,
since revenue and costs are recognized independently.



Completed Project Method

For cost plus projects that use the completed project accounting method,
the program does not credit the revenue account or charge the cost of
sales account until the project is marked Completed. Until then, all costs
are accumulated in the work in progress account, and billings are
accumulated in the billings account.

When you change the status of a project to Completed, the next time you
run the revenue recognition functions, the program recognizes as
revenue the sum of all the billings for the project. It also charges the total
costs incurred to the cost of sales account and credits the work in
progress account to eliminate project-related balances from the latter
account, as follows:

General Ledger

Account Debit | Credit
Billings X
Revenue X
Cost of Sales X

Work in Progress X




Accrual-Basis Method

For cost plus projects that use the accrual-basis accounting method, you
do not run the revenue recognition functions to recognize revenue.

For these projects, costs are automatically debited to the cost of sales
account when you post cost transactions. For example, when you post an
equipment usage transaction, the general ledger entry is:

General Ledger Debit | Credit
Account

Cost of Sales X
Equipment X

When you post invoices for a project in Accounts Receivable, the
transaction is immediately posted to the revenue account, as follows:

General Ledger Debit | Credit
Account
Accounts Receivable

X
Control
Revenue X

I:E' Related Topics
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Revenue Calculation for Fixed Price Projects

This topic explains the effects of the following accounting methods on
revenue recognition for fixed price projects:

® Accrual-Basis
®Billings And Costs

® Completed Project

® Project Percentage Complete




Accrual-Basis Method

For fixed price projects that use the accrual-basis accounting method,
you do not run the revenue recognition functions to recognize revenue.

For these projects, costs are automatically debited to the cost of sales
account when you post cost transactions. For example, when you post an
equipment usage transaction, the general ledger entry is:

General Ledger Debit | Credit
Account

Cost of Sales X
Equipment X

When you post invoices for a project in Accounts Receivable, the
transaction is immediately posted to the revenue account, as follows:

General Ledger

Account Debit | Credit

Accounts Receivable

Control X

Revenue X




Billings And Costs Method

To calculate revenue for fixed price projects that use the billings and
costs accounting method, the program determines:

eThe amount to credit the revenue account for the period.

This is the total amount billed for the project to the specified cut-off
date or fiscal year and period, or since you last recognized revenue.

General Ledger Debit | Credit
Account

Billings X
Revenue X

eThe amount that will be charged to the cost of sales account for the
period.

This is the total cost incurred on the project to the specified cut-off
date or fiscal year and period, or since you last recognized revenue.

General Ledger Debit | Credit
Account

Cost of Sales X

Work in Progress X

eThere is no entry to the work in progress account for gross profit,
since revenue and costs are calculated independently.



Completed Project Method

For fixed price projects that use the completed project accounting
method, the program does not credit the revenue account or charge the
cost of sales account until the project is marked Completed. Until then, all
costs are accumulated in the work in progress account, and billings are
accumulated in the billings account.

When you change the status of a project to Completed, the next time you
run the revenue recognition functions, the program recognizes as
revenue the sum of all the billings for the project.

It also charges the total costs incurred to cost of sales and credits the
work in progress account to eliminate project-related balances from that
account, as follows:

General Ledger

Account Debit | Credit
Billings X
Revenue X
Cost of Sales X

Work in Progress X




Project Percentage Complete Method

For fixed price projects that use the project percentage complete method,
the program first calculates the percentage complete. Then, to determine
the amount of revenue to recognize for the period, it:

1.|I| Determines the revenue earned to date.

2.|I| Determines the amount of revenue to recognize for the period.

3.|I| Determines the profit earned to date.

4.|I| Determines the profit to recognize for the period.

5.|I| Determines the cost for the period.

6.1f the project is marked Complete, the program clears the
accumulated, offsetting amounts from the billings and work in
progress accounts and marks the project Closed.

The journal entry to record revenue periodically throughout the project
depends on your selection for the Percentage Complete Method option
on the Settings tab of the PJC Options form.

o|f you opted to clear the billings and work in progress accounts when
you close percentage completion projects, the entry is:

General Ledger
Account

Debit

Credit

Work in Progress
(gross profit)

Cost of Sales

Work in Progress
(loss)

Revenue

The following general ledger entry is used when you complete a
project that uses a percentage complete accounting method:
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General Ledger

Account Debit | Credit
Billings X
Work in Progress X

If there are any unrecognized amounts in the billings account (from
invoices entered manually through Accounts Receivable), the
program adjusts the revenue account, accordingly. Note that this entry
may be combined with the closing entry.

General Ledger

Account Debit | Credit
Billings X
Revenue X

If there are any unrecognized costs in the work in progress account
(that is, non-labor costs that were not recognized under the labor
hours percentage complete method), the program adjusts the cost of

sales account:

General Ledger

Account Debit | Credit
Cost of Sales X
Work in Progress X

e|f you opted to clear the billings and work in progress accounts during
revenue recognition, the entry is:

General Ledder | pebit| Credit
Billings X
Cost of Sales X
Work in Progress X




Revenue X
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Revenue Recognition for Time and Materials

Projects

This topic describes revenue recognition for time and materials projects
under different accounting methods.

Note that for time and materials projects, billing amounts and billable
costs are specified with each transaction.



Billings and Costs Method

To calculate revenue for projects using the billings and costs accounting
method, the program determines:

eThe amount to credit the revenue account for the period.

This is the total amount billed for the project to the specified cut-off
date or fiscal year and period, or since you last recognized revenue.

General Ledger Debit | Credit
Account

Billings X
Revenue X

eThe amount that will be charged to the cost of sales account for the
period.

This is the total cost incurred on the project to the specified cut-off
date or fiscal year and period, or since you last recognized revenue.

General Ledger Debit | Credit
Account

Cost of Sales X

Work in Progress X

eThere is no entry to the work in progress account for gross profit,
since revenue and costs are calculated independently.



Completed Project Method

For time and materials projects that use the completed project accounting
method, the program does not credit the revenue account or charge the
cost of sales account until the project is marked Completed. Until then, all
costs are accumulated in the work in progress account, and billings are
accumulated in the billings account.

When you change the status of a project to Completed, the next time you
run the revenue recognition functions, the program recognizes as
revenue the sum of all the billings for the project.

It also charges the total costs incurred to cost of sales and credits the
work in progress account to eliminate project-related balances from that
account, as follows:

General Ledger

Account Debit | Credit

Billings X

Revenue X
Cost of Sales X

Work in Progress
(loss)




Accrual-Basis Method

For time and material projects that use the accrual-basis accounting
method, you do not run the revenue recognition functions to recognize
revenue.

For these projects, costs are automatically debited to the cost of sales
account when you post cost transactions. For example, when you post an
equipment usage transaction, the general ledger entry is:

General Ledger Debit | Credit
Account

Cost of Sales X
Equipment X

When you post invoices for a project in Accounts Receivable, the
transaction is immediately posted to the revenue account, as follows:

General Ledger Debit | Credit
Account
Accounts Receivable

X
Control
Revenue X

I:E' Related Topics
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Recognizing Losses for Percentage Complete

Accounting Methods

For projects that use a percentage complete accounting method, you run
the revenue recognition functions periodically throughout the term of a
contract to recognize revenues or record any losses.

Project and Job Costing recognizes two types of losses for projects that
use a percentage complete accounting method:

eCurrent period loss on a profitable project. The loss is for the
current period on an otherwise profitable project or, for projects using
the category percentage complete method, on an otherwise profitable
category.

eAn overall loss on a project. The project has become unprofitable
because of an increase in actual or estimated costs.

To recognize a loss, the program calculates revenue as usual. If the
amount of gross profit to recognize to date is less than the amount
previously recognized, a loss arises. The program then credits the work
In progress account for the excess gross profit recognized in prior
periods.

The cost of sales to be recorded for the period is the difference between
the revenue and the negative gross profit.

The general ledger entry to record a loss for the current period on a
profitable project is:

General Ledger Debit | Credit
Account
Cost of Sales X
Revenue X
Work in Progress

X
(loss)

To record an overall loss, the program recognizes the revenue and cost
for the period, and records the entire expected loss, as follows:



General Ledger
Account

Debit

Credit

Billings

Revenue (for the
period)

Cost of Sales

Work in Progress (for
period costs)

Cost of Sales

Work in Progress
(overall loss)




Category Percentage Complete

For the category percentage complete accounting method, the program
recognizes losses category by category, rather than for the project as a
whole. The program recognizes the entire loss for each project category.



Revenue Recognition in a Multicurrency System

Note that in a multicurrency system, job-related Accounts Receivable
transactions are posted to the billings account in both the customer's
currency and in the functional currency. Also, Accounts Payable
transactions are posted to the work in progress account in both the
vendor's currency and in the functional currency.

For customers who do not use your functional currency, Project and Job
Costing:

eDebits the billings account in each currency (using the sum of the
revenue amounts for each currency).

¢Credits the work in progress account for the sum of the cost of sales
amounts in each currency.

eCredits (or debits) the work in progress account with the profit (or
loss) amount in the functional currency.

*Credits or debits any rounding differences (due to exchange) to the
billings account.



Percentage Complete Methods

For the total cost percentage complete, labor hours percentage complete,
and category percentage complete accounting methods, the program
calculates:

1.The total estimated project revenue in functional currency.

For the category percentage complete accounting method, the
estimated revenue for each category is used.

2.The total estimated costs in functional currency.
3.The costs incurred to cut-off in functional currency.
4.The gross profit amount in functional currency.

5.The actual revenue in functional currency, based on the percentage
complete.

Using the current exchange rate, the program converts the revenue
amount in functional currency to the customer's currency. The program
then generates general ledger entries to:

oCredit revenue in customer and functional currencies.
eDebit work in progress in functional currency only.

eDebit cost of sales in functional currency only.



Project Percentage Complete

For the project percentage complete accounting method, the program
calculates:

1.The percentage of the project's fixed price to recognize in the source
currency, using the percentage complete for the project.

2.The revenue amount in functional currency, using the current
exchange rate.

3.The percentage of costs to match to revenue, in functional currency.

4.The gross profit amount in functional currency (the amount from step
2 less the amount from step 3).

The program then generates general ledger entries to:
oCredit revenue in functional and customer currencies.
eDebit work in progress in functional currency only.
eDebit cost of sales in functional currency only.



Completed Project and Billings and Costs

For the completed project and the billings and costs accounting methods,
the program generates entries for the billings account in both source and
functional currency using various exchange rates, corresponding to the
rates used on customer invoices.

During revenue recognition, Project and Job Costing sums the amounts
in each currency to determine a single exchange rate for the revenue
recognition transaction.

Similarly, transactions entered through Accounts Payable to the work in
progress account can have varying exchange rates. When you recognize
revenue, the program derives an exchange rate for the work in progress
account in the same manner.

Note that the program generates entries to the cost of sales account in
functional currency only.

I:E' Related Topics
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Revenue Recognition Worksheet

You use the Revenue Recognition Worksheet form to:
eReview revenue recognition entries before posting them.

eChange the percentage complete for individual projects, if you want to
use different completion percentages than those calculated by the
program.

ePost a revenue recognition worksheet.

ePrint the Rrevenue Recognition Worksheet report. (On the File menu, click Prlnt)

To review, edit, or post the revenue recognition entries

I:E' Related Topics
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Create Reopen Projects Worksheet

You use the Create Reopen Projects Worksheet to create a worksheet
that includes:

o A range of prOjeCtS that you want to reopen.
.Any journal entries that are needed tO reopen those prOjeCtS.

To reopen any project, you must create and post a Reopen Projects
Worksheet that includes the project.

You must post the worksheet to reopen the projects, whether or not any
reversing entries are required.

When you post the worksheet, Project and Job Costing creates any
required journal entries, and reopens the projects included on the
worksheet.

To reopen closed projects

I:E' Related Topics
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Reopen Projects Worksheet |_Field List_|

The Reopen Projects Worksheet is available in the Reopen Closed
Projects subfolder in the Periodic Processing folder.

To reopen any closed project, you use the Create Reopen Projects
Worksheet form to create and post a Reopen Project Worksheet that
includes the project you want to reopen and any journal entries that are
required to reopen those projects.

The Reopen Projects Worksheet shows the projects that will be
reopened. It also displays general ledger entries that will be created
when you post the worksheet. You cannot change the general ledger
entries, but you can delete projects from the worksheet, in which case the
projects will not be reopened.

To view or edit a worksheet to reopen projects

1.Choose Reopen Projects Worksheet from the Reopen Projects
subfolder (in the Periodic Processing folder).

2.0n the worksheet that appears use the navigation buttons or the
Finder to display the number of the worksheet you want to view.

The program displays the date and the fiscal year and period you
specified and the description you entered for the selected worksheet
on the Create Reopen Projects Worksheet form.

It also displays the projects included in the range you specified when
you created the worksheet, as well as the contract number, project
type and accounting method.

If reversing entries are required to reopen a project, the Details button
is available when you select the project on the grid.

3.To view reversing entries that will be created when you post the
worksheet:

Select a project on the grid

b.  Click the Details button, if it is available, to display the Entry
Details form.

c. When you have finished examining the details, click Close to



return to the worksheet.
4.To delete a project on the worksheet, select the line, then click Delete.

If you delete a line, the program also deletes any general ledger
entries, and the status of the project will not be changed when you
post the worksheet.

5.When you are satisfied with the entries on the worksheet, click Post,
to post the worksheet, generate the general ledger entries, and reset
the projects’ statuses to Open.

Note: To delete an entire worksheet, you display the worksheet, and then
click the Delete button on the worksheet form.



Closing Projects

Marking a project Completed is the first step in closing the project.

The next time you recognize revenue, the revenue recognition function
performs some extra steps for projects marked Completed:

e|t recognizes any revenue or costs not recognized previously (from
manually entered invoices or due to non-labor costs incurred on
projects that use the labor hours percentage complete accounting
method).

e|t clears the project-related amounts from the billings and work in
progress accounts.

*\When you post the revenue recognition worksheet, the program asks
whether you want to close the project. If you choose Yes, the program
marks the project Closed.

If you do not close completed projects at that time, you can close them
later by choosing the option Include Completed Projects (For Closing)
when you create a subsequent revenue recognition worksheet.

A project can be completed at any time, even if you have not fully billed
the customer or completely recognized the revenue for the project. (That
s, total costs and billings do not need to match the estimated costs or
revenue for the project to be completed.)

You can close projects for which there is outstanding retainage
receivable or retainage payable. However, you will have to reopen the
project if you want to post retainage documents, later.

To close a project
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Clear History Form

The Clear History form removes obsolete data from your Project and Job
Costing system. You can clear ranges of the following information:

ePrinted posting journals

ePosted documents
eTransactions for closed contracts
*Closed contracts

eCommitted cost audit list
ePosting errors

To use the Clear History form




Create G/L Batch

Use the Create G/L Batch form to produce batches of general ledger
transactions from the timecard, equipment usage, revenue recognition,
and adjustment transactions you post in Project and Job Costing.

You use this form to create the batches only if you do not use the option
to create general ledger batches during posting.

Before You Start

eSelect general ledger batch-creation options on the Integration tab of
the G/L Integration form.

ePost all outstanding transactions.

ePrint the G/L Transactions report. (You cannot print this report after
you create the general ledger batches.)

Note on locked fiscal periods

You can create G/L batches for a fiscal period that is not locked for
Project and Job Costing. However, if the period is locked for General
Ledger when you try to post the G/L batch, the transactions will be placed
in an error batch in General Ledger. If the option to create and
automatically post G/L batches is selected on the G/L Integration form,
the transactions will be placed in an error batch in General Ledger when
you create the batch in Project and Job Costing.

To create general ledger batches

After using

ePost the batches in Sage ERP Accpac General Ledger, if you use it,
or in your other general ledger.



Update Payroll

Project and Job Costing lets you send job-related timecards from Project
and Job Costing to your payroll program, where you can produce checks
for your employees, as usual.

If you use Sage ERP Accpac Canadian or US Payroll, the program sends
the timecards to Payroll.

If you do not use Sage ERP Accpac Payroll, Project and Job Costing
exports the timecard entries to a CSV file that you can import into another
payroll program.

To clear timecards and update your payroll data



Project and Job Costing Reports

Project and Job Costing reports are divided into three groups:

®[}] Setup reports that list the information entered to define your Project and Job Costing system.

®[}] Transaction reports that provide you with transaction listings and status information.

®[}] Analytical reports that you can use to interpret, analyze, and summarize your data.

While the report contents vary, all Project and Job Costing reports
include:

eThe date and time the report was printed.

eThe report title.

eThe company name, as entered in the company profile.
ePage numbers.

eSelection criteria for the report, if applicable.

Note that you specify the print destination using the File menu on the
company desktop. The system updates the report status to printed after
printing to any print destination.

All the reports can print on an 8%2" by 11" or an A4-sized laser-printed
page depending on the options you choose in the System Manager.
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Aged Work In Progress Report

The Aged Work in Progress report provides a breakdown of billable and
no-charge costs that have not yet been invoiced and posted in Accounts
Receivable for @ projects that use item invoices.

You can print the report showing totals for a selected range of contracts
or for selected ranges of contracts and projects.

All the projects in a contract are grouped and subtotaled by currency.

The report groups costs into a current period and four aging periods. It
also shows:

eThe last invoice date and the total work in progress amount for each
contract.

*An aged work in progress amount for each project.

eAged work in progress amounts and total work in progress amounts
for each customer.

¢ A total work in progress amount for the report.

Print the report any time you want a report of work in progress amounts.

Before you start

ePost in Accounts Receivable any unposted batches (including
documents with zero totals) created in Project and Job Costing to
ensure that the Aged Work in Progress report is up to date.

To print the Aged Work in Progress report:

1.Choose the Aged Work In Progress icon from the PJC Analytical
Reports folder.

2.Specify the following report options:

o Age As Of [1]

o Cutoff By
o Sort By

o Print By L]
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o Customer Number/To Customer Number [
o Contract/To Contract [

o Project/To Project

o Contract Start Date/To Contract Start Date &

o Project Start Date/To Project Start Date D]

o Contract Status [

o Project Status

o Work In Progress Balance/To Work In Progress Balance D]
o Include Contracts And Projects With A Zero Balance D]

o Use Aging Periods

3.Click Print.

% Related Topics
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AlA Report

You use the AIA Report form to print American Institute of Architects’
G703 and G702 forms, required in the United States for the Application
and Certificate for Payment for some contracts.

The AlA report separately identifies the cost of material stored and the
cost of material actually used on a project.

The report includes only projects that use the same currency as the
contract customer.

All amounts on the report are in the customer’s currency. (Functional
amounts are converted using the cutoff date as the rate date.

Note:

eThe report does not include headings that appear on the pre-printed
AlA report forms.

eThe report includes only billing amounts, not costs.

Back up your data before printing

The AlA report uses information from the last AlA report to generate the
report for the current period. For this reason, the report is saved as of the
last report printing, and the data is used the next time you print the report.

Therefore, be sure to back up your data — and ensure the backup is
valid — before printing the AIA report. You will need the backed-up
data to reprint the report in case you print it using the wrong date range
or incorrect criteria, or you experience technical problems (such as a
power failure) during printing.

To print the AlA report:
1.Choose the AIA Report icon from the PJC Analytical Reports folder.
2.Select the type of report to print. You can select one of the following:
o AIAG702
o AIAG703

You need to print both reports at the same time, to ensure that the



same transactions are included on both reports. You should always
print the G703 report first, because information from that report is
used to produce the G702 report.

3.Complete the remaining fields on the form as follows:
Select By. Use this field to specify the level of detail for the report.

If you select Contract, Project and Category, the report includes
details at the category level.

If you select Contract and Project, the report includes details at the
project level. (On standard projects, information for categories and
resource categories is "rolled up” to the project level.)

Contract From | To. Use these fields to specify the range of contracts
for which to produce a report. The program prints a separate report
for each contract included in the range.

Project From /| To. Use these fields to specify the range of projects
for which you are printing the report. Only projects included in the
range will be included on the reports for the associated contracts.

Category From | To. These fields do not appear if you selected the
option to print details by contract and project.

Use these fields to specify the range of categories for which you are
printing the report.

Note: If you select by contract, project, and category for the following
types of projects and accounting methods, you must include all
categories :

o  Fixed price projects that use the completed project, project
percentage complete, accrual basis, or billings & costs accounting
methods.

o  Cost plus projects that use the completed project, total cost
percentage complete, or labor hours percentage complete.

Because the program summarizes these project types and accounting
methods at the project level, if you try to restrict the categories, the
report will be incorrect.

Cutoff By. Enter an ending date for the report. The program uses the



cutoff date in the Application Date and Period To fields on the AIA
report.

Be very careful not to overlap date ranges. The values you enter for
the AIA report in one period are used to generate the report in the
subsequent period, so you need to keep the dates and ranges
consistent from one reporting period to the next.

You can check the last AIA amount and dates for a contract on the
Contract Maintenance form.

Include Non-billable / No Charge Stored Amount. Select this option
if you are printing the G703 and you want to include non-billable or no
charge project categories. Stored amounts are then included in the
billing calculations regardless of the billing type.

If the project category is non-billable, the billing rate is zero.

If you do not select this option, non-billable or no charge project
categories are excluded from the report G703 and are not considered
in the billing calculations.

Include Contracts on Hold. Select this option if you are printing the
G703 and you want the G703 report to include contracts that are on
hold.

Projects on Hold. Select this option if you are printing the G703 and
you want the G703 report to include projects that are on hold.

Completed Projects. Select this option if you are printing the G703
and you want the G703 report to include projects that use the
completed project accounting method, whether or not they are
marked completed.

4.Click Process/Print when you are ready to print the report.

IMPORTANT: Clicking Print/Process clears all the values from the
previous report.

If you are printing the G702 report, or if you want to reprint the
G703 report you printed last time, click Reprint.

If you are printing the G703 report, Project and Job Costing
displays a message, warning you to make sure you have backed up



your data before proceeding.

o If you have not backed up your data, click Cancel, close the AIA
report form, and back up your data before printing the report.

o If you have backed up your data, click Continue.

Once the report has been printed, Project and Job Costing
displays a message asking whether to save the report data
permanently.

If the report is correct, click Yes. If the report is not correct, click No
to return to the report form and correct your entries before
reprinting the report.

Applying for Payment for Retainage

Before you can apply for payment for retainage on the AlA report, you
must clear the retainage amount for the project, as follows:

1.In the Contract Maintenance form, display the contract and project.

2.0n the Project tab of the Project Maintenance form, set the A/R
Retainage Percentage field to zero.

3.Generate the AlA report.

If, at any point during the project life cycle, you change the retainage
percentage, the program applies the new rate to costs or stored material
charged to the project since you last ran the AlA report.

After printing the report

Keep a log of the values you used to print the AlA report. You will need
them for the next report. Also, you should use the same dates and
ranges when you produce the billing worksheet to ensure that the AIA
report and your Accounts Receivable billings are consistent.
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Committed Costs Audit List

The Committed Costs Audit List, available from the PJC Analytical
Reports folder, lets you print a list of commitments effected by:

ePurchase orders and receipts posted in Purchase Orders.

Commitments for Purchase Orders documents are updated during
day end processing or during posting, depending on [ when you create

subledger transactions for Purchase Orders.

eTax on retainage calculated for invoices posted in Accounts Payable,
if the tax will be reported only when you post a retainage invoice,
later. (See the Accounts Payable help for information on reporting tax
on retainage.) Commitments for tax on retainage are updated during
invoice posting in Accounts Payable.

Note that because recoverable taxes are not considered
commitments in Project and Job Costing, Accounts Payable does not
send them to Project and Job Costing.

To print the Committed Costs Audit List:

1.Choose the Committed Costs Audit List icon from the PJC Analytical
Reports folder.

2.Specify ranges of records to include on the report, consisting of the
following:

o  Contracts

o  Projects

o  Categories

o  Vendor Numbers
o  Transaction Dates

3.Select the type of committed costs to include in the report. You can
select A/P (to include only tax on retainage calculated by Accounts
Payable), P/O (to include only commitments generated by purchase
orders and receipts), or All (to include both types of commitments).

4 .Click Print.
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Contract Details Report

The Contract Details report provides a report of estimates and basic
project information for contracts.

Print the report when you require a printed record of contract and project
details. For example, you might print reports of the estimates you submit
to your customer, the contracts and projects that have been approved, or
contracts that have been completed.

All the projects in a contract are grouped and subtotaled by currency, in a
multicurrency system.

The customer number for each project is also printed, so that you can
distinguish between the project customer and the contract customer.

You can choose the level of detail to report. For instance, on a report for
a completed contract, you might not want to include category estimates.

For each contract number you include in the selected range, the report
lists details for projects at the contract level you specify.

To print the contract details report:

1.Choose the Contract Details icon from the PJC Analytical Reports
folder.

2.Specify report options using the following fields:
o Contract From/To
o Project From/To [

o Category From/To [

o Customer Number To/From [
o Contract Start Date To/From
o Project Start Date From/To
o Contract Status L]

o Project Status [

o Include options

3.Click Print.
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Contract Summary Report

The Contract Summary report provides a summary for each contract and
project in a specified range, showing the current estimated revenue, total
actual costs, actual revenue, and customer receipts.

The report also shows the amount of costs compared to the amount of
revenue and the amount of receipts for each contract and project. For
projects that use a percentage complete accounting method, it shows the
completion percentage.

If you print the report in customer currency, all the projects in a contract
are grouped and subtotaled by currency.

When to print the report

You can use the report to check cost and receipt totals for individual
customers and contracts or projects, and to obtain an overview of the
cash generated and used by your contracts.

To print the contract summary report:

1.Choose the Contract Summary icon from the PJC Analytical Reports
folder.

2.Specify the report options using the following fields:

o Print By L]

o Contract From/To [
o Project From/To [
o Customer Number From/To ]

o Contract Start Date/To

o Project Start Date/To
o Contract Status L]

o Project Status [

o Print Amounts In

3.Click Print.
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Detailed Costs Report

The Detailed Costs report provides a summary breakdown of direct costs
by cost type for each contract, project, category, and resource,
depending on the options you select when you print the report.

The report includes one line for each contract, project, and category
(depending on the report options you choose), showing:

eThe total for each cost type.
eThe quantity, unit of measure, and unit cost.

When to print
Print the report whether you need to analyze your project costs.

To print the detailed costs report:
1.Choose the Detailed Costs icon from the PJC Analytical Report folder.
2.Specify options for the report, as follows:

o Print By

o Print L)

o Contract From/To
o Project From/To [

o Category From/To [
o Cost Class

o Customer Number From/To

o Contract Start Date/To

o Project Start Date/To
o Contract Status [
o Project Status [

3.Click Print.
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Over/Under Billings Report

The Over/Under Billings report provides a breakdown of your costs
versus billings by contract or by contract and project, depending on the
options you choose for the report.

Print the report to determine the progress of your billings before and after
generating billing worksheets.

Features

The report includes columns that show, for each contract and (if you
printed the report by contract and project) for each project listed on the
report:

eThe contract code and project code.
eThe estimated revenue and estimated cost.
eThe amount billed to date and the actual costs.

eThe estimated cost to complete each project, and the percentage
complete for each project.

eThe current estimated overall profit or loss (the estimated revenue
less the estimated costs).

eThe profit or loss earned to date (the actual costs less the amount
billed to date).

.The [}l amount over-billed or under-billed for each project.

eAny unearned profit or loss.

e|n a multicurrency system, if you print the report in customer currency,
all the projects for a contract are grouped and subtotaled by currency.

To print the Over/Under Billings report:

1.Choose the Over/Under Billings icon from the PJC Analytical Reports
folder.

2.Specify report options using the following fields:

o Print By
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o

Contract From/To ]

Project From/To D]

Customer Number From/To ]

Contract Start Date/To ]

Project Start Date/To D]

Contract Status [

Project Status D]

Include Labor Amounts L

Include Overhead Amounts &
Use

Print Amounts In (]

3.Click Print.

% Related Topics
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Profit Analysis Report

The Profit Analysis report helps you to quickly determine the profitability
of selected contracts and projects.

You can print the report either for contracts or for contracts and projects.
You can restrict the report to contracts or projects that have a certain
status. You can also choose to print the report in customer currency or in
functional currency.

If you print the Profit Analysis report in customer currency, all the projects
for a contract are grouped and subtotaled by currency.

Features

The report compares estimated and actual revenue, costs, and gross
profit. It also shows the current actual gross profit margin.

To print the Profit Analysis report:
1.Choose Profit Analysis from the PJC Analytical Reports folder.

2.Select the following report options:
L print By
& Contract /To
& Project /To
L] Contract Start Date /To

[t Project Start Date /To

[}l contract Status
[ Project Status

[t Print Amounts In

3.Click Print.
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Serials and Lots Report

This report provides a list of the serial numbers and lot numbers that
have been assigned in Project and Job Costing. It also shows the
contract and projects to which they were assigned.

Report Types

You can print two types of Serials and Lots report:

eSerials/Lots By Contract/Project/Category/Res. This report lists the
serial numbers and/or lot numbers assigned to each project, category,
and resource on a contract.

It also shows the document numbers, transaction types, transaction
dates, and locations for all material usage and material return
transactions that used serial and/or lot numbers in the range you
specify.

eSerials/Lots By Resource. This report lists the serial numbers and/or
lot numbers assigned to each material (item) resource.

For each serial number and lot number assigned to an item, it also
shows:

o  The document numbers, transaction types, transaction dates, and
locations for all material usage and material return transactions
that used the serial and/or lot numbers.

o  The contract, project, category, and customer.
To print the Serials and Lots report:

1.Choose the Serials and Lots Report icon from the PJC Analytical
Reports folder.

2.Specify the following report options:
Print. Select Serial Numbers, Lot Numbers, or All from the list.
Report Type. Select the type of report.

Serial Numbers From | To. These fields appear if you specified
Serial Numbers or All in the Print field. Use them to specify the range



of serial numbers to include on the report.

Lot Numbers From | To. These fields appear if you specified Lot
Numbers or All in the Print field. Use them to specify the range of lot
numbers to include on the report.

Contract From | To. Use these fields to specify a range of contract
numbers to include on the report.

Project From |/ To. Use these fields to specify the range of projects to
include on the report.

Category From | To. Use these fields to specify the range of
categories to include on the report.

Resource From | To. Use these fields to specify the range of
resources to include on the report.

Customer Number From | To. Use these fields to specify the range
of customers for which to print the report.

Contract Start Date From |/ To. Use these fields to specify the range
of start dates for the contracts you want to include on the report.

Project Start Date From / To. Use these fields to specify a range of
start dates for the projects you want to include on the report

3.Click Print.
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Stored Material Audit List

The Stored Material Audit List, available from the PJC Analytical Reports
folder, provides a history of material transactions that have affected
stored quantity and cost amounts.

Material usage, cost, Accounts Payable invoices, and Purchase Orders
receipts normally increase the quantities and costs of stored material.
Material returns and material allocation transactions normally decrease
the quantities and costs of stored material.

To print the Stored Material Audit List:

1.Choose the Stored Material Audit List icon from the PJC Analytical
Reports folder.

2.Fill in the fields on the Stored Material Audit List form, as follows:

Contract From | To. Specify the range of contracts to include in the
report. Skip the fields (leaving a blank in the first field and Zs in the To
field) to include all contracts.

Project From |/ To. Specify the range of projects to include in the
report. Skip the fields (leaving a blank in the first field and Zs in the To
field) to include all projects that are in the specified ranges of
contracts and projects..

Category From | To. Specify the range of categories to include in the
report. Skip the fields (leaving a blank in the first field and Zs in the To
field) to include all categories that are in the specified ranges of
contracts, projects and categories.

Item Number From / To. Specify the range of items to include in the
report. Skip the fields (leaving a blank in the first field and Zs in the To
field) to include all items.

Transaction Date From / To. Specify the range of dates in which a
transaction must be posted to be included in the report. The session
date appears as the default To Transaction Date.

3.Click Print.
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Account Sets Report

The Account Sets report lists the account sets added to your Project and
Job Costing system.

For each account set, the report shows

e¢The account numbers for your general ledger work in progress, cost
of sales, billings, revenue, payroll expense, employee expense, labor
allocated, overhead allocated, equipment, and cost accounts.

eThe currency for the account set.
Print the report when you add, change, or delete account sets.
To print the Account Sets report:

eChoose the Account Sets icon from the PJC Setup Reports folder,
then select a range of account sets.

I:E' Related Topics
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Categories Report

The Categories report provides a reference for selecting categories when
setting up new contracts, for verifying current figures when revising
standard (unit) costs and billing rates, or for determining when categories
can be added or deleted.

The report shows, for each category:

eThe category code, cost type, A/R item number, unit of measure, unit
cost, overhead type and overhead percentage, labor type and labor
percentage (for labor cost types), and billing rate for each category.

eThe segments and the segment codes used to override any G/L
account segments.

eThe date you last saved changes for, or added, the record. If a
category is inactive, the report shows the date you set the record
Inactive.

Print this list when you need a printed reference for any or all categories.

To print the Categories report:
1.Choose the Categories icon from the PJC Setup Reports folder.

2.Specify a range of categories for which to print the report, or skip the
From and To Category fields to include all categories on the report.

3.Specify a range of cost types to restrict the report to certain cost
types, or skip the From and To Cost Type fields to include all cost
types for the range of categories on the report.

4.1f you use optional fields, and want to include optional field information
on the report, select the option Include Optional Fields.

5.Click Print.
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Charges Report

The Charges report provides a record of charges that you have set up for
use with time and materials projects and fixed price projects that use the
billings and costs or accrual-basis accounting methods.

The report lists charge codes, along with the description, charge type,
billing amount, and A/R item number and unit of measure for each
charge.

If a charge is inactive, the report also shows the date on which the record
was set Inactive.

Use the Charges report as a reference when you are setting up new
contracts or entering charge transactions. You can also use the Charges
report to determine whether you need to add or delete charge records.

To print the Charges report:
1.Choose the Charges icon from the PJC Setup Reports folder.
2.Select the range of charge codes you want to list on the report.

3.If you use optional fields, and want to include optional field information
on the report, select the option Include Optional Fields.

4 .Click Print.
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Contract Structures Report

The Contract Structures report provides a record of the structures you set
up in the Contract Structures form, including the codes, descriptions, and
the segments used in each structure.

Print the report after you add, delete, or modify contract structure codes.

The report lists, for each structure code included in the specified range of
codes, the description for the structure code, the names and lengths of
the segments included in the structure, the total length of the structure,
and a sample of the structure.

To print the Contract Structures report:

1.Choose the Contract Structures icon from the PJC Setup Reports
folder.

2.Specify the range of contracts structures for which to print the report.
3.Click Print.
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Cost Types Report

The report lists the cost classes you have added to your Project and Job
Costing system. You can choose to print the report for a specific cost
class or for all cost classes, for a range of cost types or for all cost types.

Print the Cost Types report when you need a reference for setting up cost
categories or for determining which cost types should be added or
deleted.

To print the cost types report:
1.Choose the Cost Types icon from the PJC Setup Reports folder.
2.Specify the range of cost types for which to print the report.

3.Specify a specific cost class to limit the report to labor, material,
equipment, subcontractor, overhead, or miscellaneous charge cost
types. Choose All to include all cost classes.

4 .Click Print.
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Employees Report

The Employees report provides a listing of employee records you have
added to Project and Job Costing, showing the details from each
employee record.

Print the report whenever you need a listing of your employees,
particularly after adding, editing, or deleting employee records..

To print the Employees report:
1.Choose the Employees icon from the PJC Setup Reports folder.

2.1f you want to print the report for a range of employees, select the
range of employee codes.

3.Select the payroll type. You can print the report for all employees, for
Sage ERP Accpac Canadian or US Payroll, or for employees whose
records are set up in Project and Job Costing only (None).

4.1f you use optional fields, and want to include optional field information
on the report, select the option Include Optional Fields.

5.Click Print.
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Equipment Report

The Equipment report provides a list of equipment you use for your
projects, showing the details from each equipment record you have
added to your Project and Job Costing system.

You can print the report for a range of equipment records or for all
equipment records.

Print the report whenever you need a current list of your equipment.
To print the Equipment report:
1.Choose the Equipment icon from the PJC Setup Reports folder.
2.Specify the equipment codes for which to print the report.

3.If you use optional fields, and want to include optional field information
on the report, select the option Include Optional Fields.

4 .Click Print.
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G/L Integration Report

The G/L Integration report lists the options you selected and other
information you entered on the G/L Integration form to specify how your
Project and Job system interacts with General Ledger.

Print the report whenever you change G/L integration settings for your
system.

To print the G/L Integration report:

eChoose the G/L Integration icon from the PJC Setup Reports folder,
and then click Print.

I:E' Related Topics
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Miscellaneous Expenses Report

The Miscellaneous Expenses report lists the records you set up for
miscellaneous expenses.

Use the Miscellaneous Expenses report as a reference when you are
setting up new contracts or entering charge transactions. You can also
use the Miscellaneous Expenses report to determine whether you need
to add or delete miscellaneous expense records.

To print the Miscellaneous Expense report:

1.Choose the Miscellaneous Expense icon from the PJC Setup Reports
folder.

2.Specify the miscellaneous expense codes for which to print the report.

3.If you use optional fields, and want to include optional field information
on the report, select the option Include Optional Fields.

4 .Click Print.
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Options Report

The Options report lists the options you selected and other information
you entered on the Options form to specify how your Project and Job
system operates.

Print the report whenever you change options or settings for your system.
To print the Options report:

eChoose the Options form from the PJC Setup Reports folder, and
then click Print.

EE} Related Topics
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Optional Fields Report

The Optional Fields report lists the optional fields you have set up for
Project and Job Costing, listing by optional field type:

eThe optional field code and description.

eThe default value for the optional field.

e\Whether the optional field is marked for automatic insertion in the
records or transactions for which it was defined.

eOptional field settings, if you choose to include them. (The settings
specify whether optional field data will be passed to other Sage ERP

Accpac programs, as well as the types of General Ledger accounts to
which optional fields can be passed.)

The report also shows the number of optional field records set up for
each type of optional field.

Print the report when you add, delete, or change optional field records.
To print the Optional Fields report:

1.Click File, Print on the Optional Fields setup form, or choose the
Optional Fields icon from the Setup Reports folder.

2.Click Show Settings, if you want to include the settings for each
optional field on the report.

3.Click Print.
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Overhead Expenses Report

The Overhead Expenses report is a listing of the records that you set up
for overhead expenses. (It is not a listing of overhead charged to
projects.)

Use the Overhead Expenses report as a reference when you are setting
up new contracts or entering overhead transactions. You can also use
the Overhead Expenses report to determine whether you need to add or
delete charge records.

Features

The report shows all the information from each overhead expense record
printed, including the overhead code and description, A/R item number,
unit of measure.

The report also includes the date you added or last updated each
overhead expense record. If an overhead expense record is inactive, it
includes the date on which the expense record was set inactive.

To print the Overhead Expenses report:

1.Choose the Overhead Expenses icon from the PJC Setup Reports
folder.

2.Specify the overhead expense codes for which to print the report.

3.If you use optional fields, and you want to include optional field
information on the report, select the option Include Optional Fields.

4 .Click Print.
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Projects Report

The Projects report provides a reference for selecting projects when
setting up new contracts, for verifying current figures when revising
standard (unit) costs and billing rates, or for determining when projects
can be added or deleted.

You can choose to print the report for all projects or for a range of
projects, and for a particular project type or for all types of projects.

Print this report when you are setting up or revising a contract, or
whenever you need a printed list of any or all projects that you have set
up as templates for use in contracts.

Features

The report shows details from each project record in the specified range,
including:

eThe project code and description, project type, accounting method,
billing type, and the date you added or last updated the project record.

eThe date you last changed the project setup record. If a project record
Is inactive, the date the project was set inactive.

*The segments and the segment codes used to override any G/L
account segments.

To print the Projects report:
1.Choose the Projects icon from the PJC Setup Reports folder.

2.Specify a range of project codes for which to print the report, or leave
the From Project field blank and skip the To Project field to include all
project codes.

3.Specify a specific project type to limit the report to fixed price, cost
plus, or time and material projects. Choose All to include all project
types.

4.1f you use optional fields, and want to include optional field information
on the report, select the option Include Optional Fields.

5.Click Print.
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Segment Codes Report

The Segment Codes report provides a record of the codes and their
descriptions for the segments you added for contract numbers.

The report prints the data in order by segment code for each segment
name defined in PJC Options.

You can choose to print all segments, or to print a specific segment. If
you choose to print a specific segment, you can specify the range of
segment codes to be printed.

Print the Segment Codes report whenever you add, modify, or delete
segment code records. You can also use the report to determine the
codes you need to add or delete to update your Project and Job Costing
system as your needs change.

To print the Segment Codes report:
1.Choose the Segment Codes icon from the PJC Setup Reports folder.

2.Choose whether to print the report for all segments or for a specific
segment.

If you choose Specific Segment, identify the segment, then specify
the range of segment codes to include on the report.

3.Click Print.
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Subcontractors Report

The Subcontractors report provides a list of the subcontractors you use to
work on your projects. The report includes the information contained in
the subcontractor setup records.

Print the report as a reference when you are setting up contracts, or
whenever you add, modify, or delete subcontractor records.

To print the Subcontractors report:
1.Choose the Subcontractors icon from the PJC Setup Reports folder.
2.Select the range of subcontractor codes you want to list on the report.

3.If you use optional fields, and want to include optional field information
on the report, select the option Include Optional Fields.

4 .Click Print.
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Detailed Transactions Report

The Detailed Transactions report lets you print details of cost and/or
billing transactions.

You can select criteria to restrict the report to a limited set of transactions.

You can also choose to include details of resources and expensed taxes
on the report, and you can print account descriptions, if you want.

The report also includes the customer number for each project, so that
you can distinguish between the project customer and the contract
customer.

To print the Detailed Transactions report:

1.Choose the Detailed Transactions Report icon from the Transaction

Reports folder.

2.Use the O print and & report Type fields to specify the type of report you

want to print.

3.Choose from the following selection criteria to restrict the transactions

e}

e}

o

included on the report:

Contract

Project

Category

Cost Class
Customer Number

Contract Start Date

Project Start Date

Contract Status

Project Status

Transaction Date

4.Select Print Account Descriptions to include this account descriptions

with transactions.
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5.Specify whether to include the following details:
o Resources used in transaction details
o  A/R interest invoices
o  A/R write-off transactions
o  Expensed taxes
o Opening balance transactions
6.Click Print.
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GL Transactions Report

The G/L Transactions report lists the general ledger transactions created
from posted Project and Job Costing transactions.

Use the G/L Transactions report as an audit trail for the general ledger
transactions generated by Project and Job Costing.

When to print
Print this report before using the Create G/L Batch form.

To print the G/L Transactions report:

1.Choose the G/L Transactions icon from the PJC Transaction Reports
folder.

2.Specify the following options for the report:
o Through Posting Sequence [
o [] Report Format
o Sort By [t

o Multicurrency Report Currency [

3.Click Print.

I:E' Related Topics


javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:mc112.Click()

Posting Errors Report

If you post a transaction that contain an error, Project and Job Costing
displays an error message, and records the error in the Posting Errors
report. The document is not posted.

Print the report if Project and Job Costing warns of an error when you
attempt to post a transaction. You print the report for all transaction
posting errors. You must correct the entries that appear on the error
report before you can post them.

Features

The Posting Errors report lists the incorrect entries, and explains why
they could not be posted.

To print the Posting Errors report:

1.Choose the Posting Errors icon from the PJC Transaction Reports
folder.

2.Select a range of error sequences.
3.Click Print.
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Posting Journals Report

Project and Job Costing posting journals provide printed records of the
transactions that you posted either from the PJC Post Transactions form
or from the transaction entry forms.

You can print posting journals for timecard, equipment usage,
adjustment, revise estimate, revenue recognition, reopen project, cost,
and material allocation transactions.

You should print posting journals to a printer or file after each posting run,
then file them with your other audit trail records.

Before printing

If you want to keep a copy of the report for your audit trail, set the printing
destination to Printer or File, using the File menu on the company
desktop.

To print posting journals:

1.Choose the Posting Journals icon from the PJC Transaction Reports
folder.

2.Specify report options using the following fields:

o Select Posting Journal

o From Posting Sequence and To Posting Sequence
o Include Tax Information

o Reprint Previously Printed Journals

o Include Optional Fields

o Include G/L Integration Detail

o Sort By

3.Click Print.
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Transaction History Report

The Transaction History report provides a printed listing of transactions
that appear on the tansacion History fOrm, with the advantage that you can
print the report for a selected range of contracts, projects, categories,
cost classes, customers, contract status, and project status.

You can print the report fOr any or all subledgers that integrate with Project and Job Costing I,

The report also includes the customer number and name, so that you can
distinguish between the project customer and the contract customer.

When to print

You print the transaction history report any time you need a printed report
of transaction history.

Before printing

If you want to keep a copy of the report for your audit trail, set the printing
destination to Printer or File using the File menu on the company
desktop.

To print the Transaction History report:

1.Choose the Transaction History icon from the PJC Transaction
Reports folder.

You can also print the report by choosing Print from the File menu on
the Transaction History form.

2.In the Select Transactions By field, specify whether to select
transactions by transaction date or by fiscal year and period. L]

3.Choose from the following selection criteria to restrict the transactions
included on the report:

o Contract
o Project [
o Category [

o Cost Class [
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Customer Number [

Contract Start Date

Project Start Date [
Contract Status L]
Project Status [

Transaction Date or Fiscal Year/Period

Sort By [

Include [

4 .Click Print.
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Transaction Listing

A transaction listing provides a record of the transactions that you have
added to your Project and Job Costing system, including posted
transactions.

You can print transaction listings for material usage, material return,
timecard, equipment usage, charge, adjustment, revise estimate, cost,
and material allocation transactions.

When to print

You should print transaction listings after entering, importing, generating,
editing, or posting transactions, then file them with your other audit trail
records. If you select the Force Listing Of Transactions option on the PJC
Options form, you must print transaction listings before you can post the
transactions.

Before printing

If you want to keep a copy of the report for your audit trail, set the printing
destination to Printer or File using the File menu on the company
desktop.

To print a transaction listing:

1.Choose the Transaction Listing icon from the PJC Transaction
Reports folder.

2.Specify report options using the following fields:

o Transaction Type

o Reprint Previously Printed Transactions
o Include Comments Ll

o [Transaction Type] Number From/To [

o Transaction Date From/To L]

o Type [

o Status
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o Include Tax Details [

o Include Optional Fields [
o Include Serials/Lots
3.Click Print.

You can also print transaction listings directly from any transaction entry
form by clicking the Print Transaction Listing choice on the File menu.
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Worksheet Reports

From the Worksheets Report form you can print:
oThe Billing Worksheet Report.

This report prints the same information you see on the Billing
Worksheet form. Details are grouped by worksheet header and
customer line.

*The Revenue Recognition Worksheet Report

This report prints the same information you see on the Revenue
Recognition Worksheet form. For each worksheet, the report includes
a header followed by the worksheet details.

You can choose the Worksheets icon, available in the PJC Transaction
Reports folder, to print worksheets.

You can also print the current worksheet by clicking File > Print when you
are using the Billing Worksheet form or the Revenue Recognition
Worksheet form. The Worksheets form appears, with information for the
current worksheet displayed as defaults.

To print the Worksheets report:

1.Choose the Worksheets icon from the PJC Transaction Reports folder
to display the Worksheets form.

2.Specify Billing Worksheet or Revenue Recognition Worksheet,
depending on the type of worksheet you want to print.

3.The remaining options you can select depend on the worksheet type
you specify.
If you are printing the billing worksheets report:

a. Use the Worksheet Number From and To fields to specify a range
of worksheets to print.

b. Use the Document Date From and To fields to print only
worksheets that have document dates in the range you specify, or
accept the dates displayed to print all the worksheets.

c. Select the following printing options for the report, as required:



o Reprint Previously Printed Worksheets.

o Print Details (to include billing details).

o Print G/L Account Description. (This field appears only if you
selected Print Details.)

o Include Billing Optional Fields.

o Include Billing Detail Optional Fields. (This field appears only if
you selected Print Details.)

o Include Comments. This field appears only if you selected Print
Details.)

o Include Tax Reporting Currency. (Select this option to include
the tax reporting currency, rate type, rate date, and exchange
rate.)

d. Select the statuses of the worksheets that you want to include in

the report. (You can include Created and/or Posted worksheets.)

e. Specify the invoice type for the worksheets that you want to
include in the report. (You can include worksheets for Item and/or
Summary invoice types.)

If you are printing the revenue recognition worksheets report:

a. Use the Worksheet Number From and To fields to specify a range
of worksheets to print.

b. Use the Worksheet Date From and To fields to print only
worksheets that have worksheet dates in the range you specify, or
accept the dates displayed to print all the worksheets.

c. Use the Contract From and To fields to specify a range of
contracts to include on the report.

d. Use the Project From and To fields to specify the range of projects
to include on the report.

e. Select the following printing options for the report, as required:
o Print G/L Details (to include details for G/L entries).

o Print G/L Account Description. (This field appears only if you
selected Print G/L Details.)



o Include Optional Fields

f.  Select the statuses of the worksheets that you want to include in
the report. (You can include Created and/or Posted worksheets.)

4.1f you have a multicurrency system and you are printing details, you
also specify the currency for the amounts that appear on the report.

From the Print Amounts In list, select Customer Currency, Functional
Currency, or Both Customer And Functional Currency.

5.Click Print.

I:E' Related Topics
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Project and Job Costing — Security Overview

If security is turned on for vour Sage Accpac ERP system, you have no access to PrOject and
Job Costing unless you have Project and Job Costing security
authorizations.

To view records and to print reports in Project and Job Costing, you must
belong to a security group that has common inquiy authorization.

To edit records or perform processing tasks, you must belong to a
security group that has authorization for additional tasks from the
following list:

®[}] Setup Maintenance.

®[t] Contract Inquiry.

®[}] Contract Maintenance.

®[t] Contract Approval.
®[t] Contract Open.
®[t] Contract On Hold.
®[}] Contract Inactive.
®[}] Contract Closed.

®[}] Add A New Category and Resource.

®[t] Adjustment Inquiry.

o[t] Adjustment Entry.

®[] Adjustment Approval.

®[}] Adjustment Posting.

o[} Charges Inquiry.
o[ Charges Entry.
o[} Charges Approval.

o[} Charges Posting.

o] Costs Inquiry.
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o] Costs Entry.
o] Costs Approval.
o] Costs Posting.

®[t] Equipment Usage Inquiry.

®[t] Equipment Usage Entry.

®[t] Equipment Usage Approval.

®[t] Equipment Usage Posting.

®[] Material Usage Inquiry.

®[}] Material Usage Entry.

®[] Material Usage Approval.

®[}] Material Usage Posting.

®[}] Material Return Inquiry.

®[}] Material Return Entry.

®[}] Material Return Approval.

®[}] Material Return Posting.

®[2] Material Allocation Inquiry.

®[:] Material Allocation Entry.

®[}] Material Allocation Approval.

®[}] Material Allocation Posting.

®[}] Revise Estimates Inquiry.

®[}] Revise Estimates Entry.

®[}] Revise Estimates Approval.

®[}] Revise Estimates Posting.

o] Timecard Inquiry.
®[}] Timecard Entry.
o] Timecard Approval.

®[}] Timecard Posting.


javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

®[:] Can See All Timecards.

®[t] |mport Processing.

®[t] Export Processing.

®[t] Budget Actuals Inquiry.

®[}] Budget Recognized Revenue Inquiry.

o[ Budget Entry.

®[}] Transaction Optional Fields.

®[t] Opening Balances Inquiry.

®[}] Opening Balances Entry.

®[] Opening Balances Approval.

®[}] Opening Balances Posting.

®[t] Update Retainage Inquiry.

®[}] Update Retainage Entry.

®[}] Update Retainage Approval.

®[}] Update Retainage Posting.

®[3] Billing Worksheet Inquiry.

®[3] Billing Worksheet Creation.

®[}] Billing Worksheet Maintenance.

®[}] Billing Worksheet Posting.

®[}] Revenue Recognition Worksheet Inquiry.

®[:] Revenue Recognition Worksheet Creation.

®[] Revenue Recognition Worksheet Maintenance.

®[] Revenue Recognition Worksheet Posting.

®[:] Reopen Projects Worksheet Inquiry.

®[}] Reopen Projects Worksheet Creation.

®[:] Reopen Projects Worksheet Maintenance.

®[}] Reopen Projects Worksheet Posting.
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o[ Payroll Update.

o] Clear History.

O[] G/L Batch Creation.

o[ Employee Inguiry.

®[:] Employee Maintenance.

O[] Transaction Reports.

o[ Analytical Reports.

o[ AlA Report.
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Create a New Contract

[l overview

[l Before you start
To create a hew contract:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.Add the contract using the new contract wizard.

3. Enter settings for the contract, S necessary.

4. Add projects to the contract, S required.

For projects added when you ran the New Contract wizard:

o  Verify the project information. If you need to change estimates, use
the procedures outlined in steps 5 and 6 for adding estimates.

o Delete any projects that are not required for this contract.

5. Add categories and estimates to each basic project you aSSigned to the contract.

6. Add cateqories, resources, and estimates to each standard project you aSSigned to the contract.

7.1f you are transferring information from another job-costing system:

a. Post Opening actuals balances, activity StatiStiCS, and stored material balances.

b. If you use retainage, post opening retainage amounts fOr retainage receivable
and retainage payable.

8.Click Add (or Save) to save the contract.

[}l After adding the contract

[l Related topics
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Assign a Project to a Contract

Overview

L] Before you start
To assign a project to a contract:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.Use the Finder or the navigation buttons beside the Contract field to
select the contract you want to work with, or type the contract code in
the Contract field.

3.0n the tree, select the contract folder, right-click, then click New
Project on the menu that appears.

4.0n the Project Maintenance form that appears on the right side of the
screen, enter a project code in the Project field, or select the project
using the Finder.

5.Enter a description of the project using up to 60 characters. The
program displays the default description from the project setup record,
but you can change it.

6.Enter your customer's purchase order number, if you know it.
7.Complete the remaining fields on the project tab.
8.Click the Add button under the Project tab to save the new project.

9.Click the Save button on the lower left-hand side of the Contract
Maintenance form to save your change to the contract.

[}l After adding a project to a contract
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Estimate a Standard Project

Overview

L] Before you start
To add an estimate for a standard project:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.Use the Finder or the navigation buttons beside the Contract field to
select the contract you want to work with, or type the contract code in
the Contract field.

3.|I| Assign cost cateqgories to the standard project.

4Add particular [*] resources to the project.
5.For each resource you added in Step 4, in turn:
a. Select the resource on the contract tree.

b. [}l Assign categories to the resource.

C. Enter an [ estimate for each resource category.

6.When you have finished adding estimates for the resource categories,
click the Save button on the lower left-hand side of the Contract
Maintenance form to save your changes to the contract.

[}l After adding cost estimates

[l Related topics
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Estimate a Basic Project

Overview

L] Before you start
To add an estimate for a basic project:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.Use the Finder or the navigation buttons beside the Contract field to
select the contract you want to work with, or type the contract code in
the Contract field.

3.1 use the tree to assign cost categories 10 the basic prOjeCt.

4.For each assigned category:

a. Onthe contract tree, expand the project, and then click the
category to display the Category Maintenance form.

b.  On the Estimate tab:
a. Enter the quantity for the current category.

The program calculates the extended cost based on the
specified quantity and the unit cost. (The unit cost and unit of
measure from the category record are used as defaults, but
you can change them.)

If you enter a different extended cost for a category, when you
leave the field, the program recalculates the unit cost for the
guantity you entered.

Note: Remember to include provision for taxes in the cost
amounts.

b. Accept or change any additional information that is required for
the estimate, such as the billing type or the overhead and labor
amounts or rates.

For time and materials projects and for fixed price projects that
use a billings and costs or accrual-basis accounting method,
Project and Job Costing displays a billing rate according to the
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o

@

Default Billing Rate option specified for the Project. You can
change the billing rate, and, if the project and category are both
billable, you can change the billing type for a particular
category.

The program calculates a default total revenue amount for the

Category [}l according to the project type and accounting method .

If necessary, change the revenue amount for the category. If
you change the revenue amount, the program recalculates the
cost plus or markup percentage, or the billing rate.

In a multicurrency system, you enter the revenue amount in
your functional currency. The program converts the revenue
amount to the customer's currency, if it is different from your
functional currency, using the exchange rate specified on the
project's Totals tab.

Click the Accounts tab.

Ensure that the dISpIayed [}l accounts are the ones you require for this category.

[ It tax fields appear ON the Accounts tab, enter the tax classes and
the tax included status for the category.

If you use retainage accounting:
Click the Retainage tab.

In the Default Retainage From field, select Category or Vendor
as the source for the default retainage options to use as
defaults on payables invoice, debit note, and credit note details
that use this project category.

If you specified Category in the Default Retainage From field,
specify the retainage percentage and retention period to use for
the project category.

If this is a labor category:
Click the Transactions tab.

Specify the & gefaurt unit cost and, depending on the project type and
accounting method, the @ piling rate setiings t0 be used for this
category in timecard details.
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f.  If you use optional fields, click the Optional Fields tab to check the
optional fields that appear.

You can edit or delete any automatically inserted optional fields,
and you can add different optional fields that you have defined for
categories.

g. Click Save to save your estimate.

h.  Click the Save button in the lower left corner of the Contract
Maintenance form to save your changes to the contract.

[l After adding estimates

[l Related topics
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Specify Start and End Dates for Project
Categories and Resources

Overview

L] Before you start
To assign the same dates to project resources and categories:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.In the Contract field, type the contract number or use the navigation
buttons or the Finder to display the contract to which the project
belongs.

3.0n the @ conract ree, Click the number for the project whose start and end
dates you want to set.

4.0n the project record, beside the [ end pate field, Click the zoom (a)
button.

The Set Dates form opens. The program displays the start and end
dates from the project record as defaults.

5.Enter the start and end dates you want to assign as defaults to project
categories and resources.

6.Click OK to update the start and end dates for all the categories,
resources, and resource categories in the project.
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Enter Opening Actuals Balances

[l overview

L] Before you start
To enter opening Actuals balances:

1.0pen Project and Job Costing > PJC Transactions > Opening
Balances.
Click here for help on the fields on the Opening Balances form.

2.Use the fields in the top section of the Opening Balances form to & enter

or select general information for the opening balances document.

3.Click the Detail button, then use the Detail Opening Balance form to
enter Actuals balances.

4.0n the Detail Opening Balance form, in the Opening Types field,
select Actuals, if it is not already selected.

5.Enter the following general information for the detail you are entering:

Contract |/ Project. Specify the contract and project for which you are
entering the actuals balances.

Actuals Type & (i available). Select Revenue as the actuals type.

Category | Resource (if available). Specify the category and
resource for which you are entering the actuals balances.

6.Use the detail entry grid to enter opening balance amounts for the
detail. The columns that appear in the detail grid depend on the
project style, project type, accounting method, and (for fixed price and
cost plus projects) the actuals type.

a. Inthe Actuals column, in the Total Revenue field, enter the amount
of revenue recognized in your previous job-costing system for this
project level. If you previously entered an opening revenue
balance for this project level, the program overwrites the existing
revenue amount when you post the opening balance document.

If you use multicurrency, you enter revenue amounts in your
functional currency and in the customer currency.

For time and materials projects and fixed price projects that use
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the billings and costs or accrual-basis accounting method, you
enter the amount less any revenue that was not billed in your old
system.

For time and materials projects and for fixed price projects that use
the billings and costs or accrual-basis accounting method, also
enter for the specified project level:

The amount of any unbilled revenue in the Remaining To Be
Billed field.

Cost balances (quantity, extended cost, overhead amount, and,
for labor categories, the labor amount).

In a multicurrency system, you enter cost amounts in your
functional currency.

Click the Add button to add the detail.

If you are entering balances for a project that tracks revenue and
costs at different levels, enter cost balances for each project
category or project resource (depending on the project style), as
follows:

Click the New (1) button beside the Line Number field.
Select Actuals as the opening type.

Specify the contract and project, as you did when entering
revenue balances.

Select Cost as the actuals type.

Enter the cost balances for the category or the resource
(quantity, extended cost, overhead amount, and, for labour
categories, the labor amount).

In a multicurrency system, you enter cost amounts in your
functional currency.

Click Add to add the detail.

If you want to enter additional actuals balances, click the New (&)
button beside the Line Number field to start a new detail, then
repeat steps 4, 5, and 6 until you have finished adding opening
balance details.



7.Click Close to return to the Opening Balances form.
8.Click Add (or Save) to add the opening balance document.

You can use the Opening Balances form to recall the document and
modify the opening balances, until you post the document.

9.Click Post when you are ready to post the document.

[}l After adding opening Actuals balances

[l Related topics
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Enter Opening Activity Statistics

Overview

L] Before you start
To enter opening activity statistics:

1.0pen Project and Job Costing > PJC Transactions > Opening
Balances.

Click here for help on the fields on the Opening Balances form.

2.Use the fields in the top section of the Opening Balances form to & enter

or select general information for the opening balances document.

3.Click the Detail button, then use the Detail Opening Balance form to
enter opening statistics.

4.In the Opening Types field, select Activity.

5.in the Total A/R Customer Receipts field, enter the total received from
the customer for this project.

If you use multicurrency, enter the amount in the customer currency.

6.Enter the total payments made to vendors for this project. In a
multicurrency system, you enter the amount in your functional

currency.
7.Enter dates in the date fields, as required.
8.Click Add to add the statistical information for the project.
9.Click New, if you want to add information for another project.
10.Click Close to return to the Opening Balances form.
11.Click Add to add the opening balances document.
12.Click Post when you are ready to post the document.

[l After adding opening balances

[l Related topics
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Enter Opening Balances for Stored Material

Overview

L] Before you start
To enter opening balances for stored material:

1.0pen Project and Job Costing > PJC Transactions > Opening
Balances.

Click here for help on the fields on the Opening Balances form.

2.Use the fields in the top section of the Opening Balances form to & enter

or select general information for the opening balances document.

3.Click the Detall button to open the Detail Opening Balance form.
4.In the Opening Types field, select Stored as the opening type.

5.Enter the following general information for the document on the Detalil
Opening Balance form:

Contract |/ Project. Specify the contract and project for which you are
entering opening Stored balances.

Category. Enter or select the project category for which you are
entering balances for stored material.

Resource. If you are entering stored balances for a standard project,
enter an item number for a material resource that you have assigned
to the project category. You must enter a valid item number, and you
cannot leave the field blank

If you are entering stored balances for a basic project, you can either
leave the field blank, or:

o  If you use Inventory Control, select an item number from Inventory
Control.

o  If you use Purchase Orders as a standalone program, you can
select an item number from Purchase Orders.

o  If you use neither Inventory Control nor Purchase Orders, enter
any reference using up to 24 characters.

[ use AIa Report. Select this option if you need to keep stored balances for
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the AlA report.
6.Enter Stored-type opening balances on the entry grid, as follows:

Quantity. Enter the opening quantity of material stored for this
category or resource category.

If you use Inventory Control and that program allows fractional
guantities, you can enter a stored quantity using up to four decimal
places. If you do not Allow Fractional Quantities in Inventory Control,
you must enter a whole number in this field.

If you do not use Inventory Control, you can enter a stored quantity
using up to five decimal places.

Extended Cost. In this field, enter the extended cost for the opening
guantity of stored material for the specified category or resource
category.

If you use multicurrency, enter the amount in your functional currency.

Overhead Amount. In this field, enter the amount of overhead costs
associated with the stored quantity you entered.

If you use multicurrency, enter the amount in your functional currency.

Total Cost. Project and Job Costing calculates and displays the
stored total cost for the category or resource category, in your
functional currency. You cannot change the amount.

The following fields appear on the grid only if you selected the option
Use AIA Report. (If you use multicurrency, you enter the amounts in
the customer currency.)

Total Revenue. Enter the amount of any revenue previously reported.

Previous Work Completed. Enter the amount from columns D and E
on the last AIA Report you generated for this project. The amount you
enter in this field appears in column D when you next generate the
AlA report.

Previous Certificates for Payment. Enter the amount reported on
Line 7 of the previous AIA G702 report.

7.Click the Add button to add the detail.



8.1f you want to enter additional balances, click the New (1) button
beside the Line Number field to start a new detail, and then repeat
steps 6 and 7 until you have finished adding balance details.

9.Click Close to return to the Opening Balances form.
10.Click Add (or Save) to add the opening balance document.

You can use the Opening Balances form to recall the document and
modify the opening balances, until you post the document.

11.Click Post when you are ready to post the document.

[}l After adding opening Stored balances

[l Related topics
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Enter Opening Retainage Balances

Overview
[l Before you start

To enter opening retainage for contracts, projects, categories, and
resources:

1.0pen Project and Job Costing > PJC Transactions > Update
Retainage.

Click here for help on the fields on the Update Retainage form.

2.Enter general information for the document on the Update Retainage
form using the following fields:

Retainage Number. Accept ***New*** in this field to let the program
assign a number if you are entering a new document. The program
assigns the next number specified on the Options form when you add
the document.

To edit an existing document, type its number in the Document
Number field, then press the Tab key, or use the Finder or the
navigation buttons to select the document.

Status. Accept New as the transaction status when you are adding a
new Opening Balances document.

Transaction Date and Year/Period. The program displays the
session date as the default transaction date, and the year and period
in which the session date falls as the default year and period.

You can accept or change the transaction date, year and period to
which to post the transaction, if you want.

Retainage Type. Select one of the following options:
o Opening Retainage Receivable.
o Opening Retainage Payable.

o Invoice Retainage Receivable. This option lets you adjust the
retainage receivable for a specified project or category.

o Invoice Retainage Payable. This option lets you adjust the
retainage payable for a specified project or category.
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3.Click the Details button to open the Detail form.
4 Fill in the detail information, as follows:

Contract |/ Project | Category. These fields identify the level used to
track retainage for the project.

You must identify the contract and project you are updating for each
retainage amount.

You specify a category, depending on the retainage type you selected
for the transaction, as well as the project type and accounting method:

o If you selected Opening Retainage Payable or Invoice Retainage
Payable as the retainage type, you must specify a category.

o If you selected Opening Retainage Receivable or Invoice
Retainage Receivable as the retainage type, you must specify a

category for:
o A time and materials project.
o A fixed price project that uses a billings and costs or accrual-

basis accounting method.

o A cost plus project that uses a billings and costs, accrual-basis,
or category percentage complete accounting method.

Original Document Number. Enter the original document number, if
any, or enter another useful reference.

Retainage Receivable. This field appears if you selected Opening
Retainage Receivable as the retainage type. Enter the opening
retainage receivable amount. If Accounts Receivable is multicurrency,
specify the amount in the customer currency used in the contract.

Retainage Payable. This field appears if you selected Opening
Retainage Payable as the retainage type. Enter the opening retainage
payable amount.

Retainage Invoice Amount. This field appears if you selected
Invoice Retainage Receivable or Invoice Retainage Payable as the
retainage type. Enter the amount by which to adjust the retainage
receivable.

Entering a positive amount reduces the retainage receivable or



retainage payable; entering a negative amount increases the
retainage receivable or retainage payable.

Currency. This field appears only if you selected Opening Retainage
Receivable or Invoice Retainage Receivable, and your Accounts
Receivable system is multicurrency.

Comment (optional). Use this field to enter a comment to describe
the Update Retainage transaction.

5.Click Add to add the current detail.

6.Click New, if you want to add retainage balances for another contract,
project, and category.

7.When you have finished adding details, click Close to return to the
Update Retainage form.

8.Click Add to add the document.
9.Click Post when you are ready to post the document.

[}l After posting opening retainage balances

[l Related topics
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Change the Status of a Contract

Overview

L] Before you start
To change the status of a contract:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.In the Contract field, type the contract number or use the navigation

buttons or the Finder to display the contract whose status you want to
change.

3.In the Contract Status field, select the saws to assign to this contract.

The program displays a message asking whether you also want to
change the statuses of the projects in the contract.

o  To change the status of all the projects at once, in the Change
Project Status To field, select the status to assign to all the
projects, and then click Change.

o  If you prefer to leave the project statuses as they are, so that you
can change them individually, later, click Don't Change.

4 .Click Save.

[l Related topics


javascript:void(0);
javascript:void(0);
javascript:void(0);

Change the Status of a Project

Overview

] Before you start
To change the status of a project:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.In the Contract field, type the contract number or use the navigation
buttons or the Finder to display the contract whose status you want to
change.

3.0n the @ contract Tree, Click the number for the project whose status you
want to change.

4.In the Project Status field, select the & saws to assign to this project.

5.Click the Save button under the Project tab to save your change to
the project.

6.Click the Save button for the Contract Maintenance form to save your
change to the contract.

[}l After changing the status of a project

[l Related topics
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Revise an Estimate

Overview

L] Before you start
To revise estimates for a project:

1.0pen Project and Job Costing > PJC Transactions > Revise
Estimates.

Click here for help on the fields on the Revise Estimates form.

2.Click the New button beside the Revise Estimates Number field.

3.Enter & nheader information for the revise estimate transaction.

4.Click the Detail button, or click the first line on the grid and press F9 to
display a detail entry form.

5.Enter [ details of the revised estimate.

6.Click Add (or Save) to add or save the transaction.

[}l After revising an estimate

[l Related topics
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Close a Project

Overview

L] Before you start
To close a project:
1.Mark the project Completed, as follows:

a. Open Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

b. Inthe Contract field, type the contract number or use the
navigation buttons or the Finder to display the contract to which
the project belongs.

C. On the @ contract Tree, Click the number for the project you want to
close.

d. On the Project tab of the Project Maintenance form, change the
status of the project you want to close to Completed.

e. Click Save under the Project tab to save your change.
f.  Click Save on the Contract Maintenance form to save the contract.

2.Use the Create Revenue Recognition Worksheet to recognize
revenue for a range of projects that includes the one you want to
close.

3.Display the worksheet in the Revenue Recognition Worksheet form,
then click Post to post the entries. The program displays a message,
asking if you want to confirm closure of each project separately, or
only for projects whose revenue exceeds the estimate, or close all
projects without confirmation.

a. Select whether or how to confirm closure of the projects, then click
OK.

b. If you selected an option to confirm closure, the program displays
a message for each project until it has finished closing projects,
unless you subsequently select the option to close all projects.

c. Click Yes to mark the project, or projects, Closed.
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When you post the revenue recognition worksheet, click Yes when
asked whether you want to close the project.

[l Related topics
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Charge for Fees and Services

] overview
To charge a project for fees or services that you levy:
1.0pen Project and Job Costing > PJC Transactions > Charges.

Click here for help on the fields that appear on the Charges form.

2.Click the New button beside the Charge Number field. Project and
Job Costing will assign a new transaction number when you add the
transaction.

3.Enter [ header information for the transaction.

4.Click the Detail/Tax button, or click the first line on the grid and press
F9 to display the Detail Charges/Taxes form.

5.ENnter [ details for this transaction.

6.When you have finished entering details, click Close to return to the
Charges form.

7.Click Add (or Save) to add or save the transaction.

8.To enter another transaction, click the New button next to the Charge
Number field, then complete steps 2 through 7 again, or click Close.

[l After adding charges

[l Related topics
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Charge for Equipment Usage
Overview
To record a charge for equipment used on a project:

1.0pen Project and Job Costing > PJC Transactions > Equipment
Usage.

Click here for help on the fields that appear on the Equipment Usage form.

2.Click the New button beside the Equipment Number field.

3.Enter [ header information for the transaction.

4.Click the Detail/Tax button, or click the first line on the grid and press
F9 to display the Detail Equipment Usage/Taxes form.

5.ENnter [ details for this transaction.

6.When you have finished entering details, click Close to return to the
Equipment Usage form.

7.Click Add (or Save) to add or save the transaction.
8.Click Post to post the equipment usage charge.

[l Related topics
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Enter an Employee's Timecard

Overview

L] Before you start
To enter a timecard:
1.0pen Project and Job Costing > PJC Transactions > Timecards.

Click here for help on the fields that appear on the Timecards form.

2.Click the New button beside the Timecard Number field.

3.Enter [ header information for the timecard.

4.Click the Detail/Tax button, or click the first line on the grid and press
F9.

5.0n the PJC Timecard — Time form that appears, 1 enter the timecard Time

details.

6.Click Add (or Save) to save the detalil.

7.To enter another detail, click the New button beside the Line Number
field, and then complete steps 5 and 6 again.

8.When you have finished entering details, click Close to return to the
Timecards form.

9.To review the time details you have added to the timecard, click the
Time Detalil tab.

10.Before pOSting the timecard, reimburse the employee’s out-of-pocket expenses, if there
are any.

11.1f the timecard is complete for the week, indicate that it is ready for
approval in the Status field.

12.Click Add (or Save) to save the transaction.

[l After adding timecards

[l Related topics
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Reimburse an Employee for Job-Related

Expenses

& overview

To reimbursement an employee for job-related expenses:
1.0pen Project and Job Costing > PJC Transactions > Timecards.

Click here for help on the fields that appear on the Timecards form.

2.0 Start a new timecard OF [ select an existing timecard {0 Which you can add
reimbursements.

3.Click the Expenses tab, and then click the Detail/Taxes button to
display the Timecard - Expenses form.

4.Enter the expense details.
5.Click Add (or Save) to add the expense detail.

6.Click the New button beside the Line Number field, then repeat steps
4 and 5 to add additional expense details.

7.When you have finished adding expense details, click Close to return
to the timecard.

8.1f the timecard is complete for the week, indicate that it ready for
approval in the Status field.

9.Click Add (or Save) to save the transaction.

10.Click Post to post the transaction.

[}l After posting a timecard in Project and Job Costing

[l Related topics
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Charge for Subcontractor Expenses

You use Accounts Payable Invoice Entry to process job-related
subcontractor charges that update your Project and Job Costing
contracts when you post them.

If you do not need to update a vendor payable account, you can use the
Costs form to enter costs directly in Project and Job Costing for any
contract, project, category, and resource.

See the topic "Enter a Job-Related Invoice" under the heading, "What Do
You Want to Do?," in the Accounts Payable Help.



Enter a Miscellaneous Cost

Overview
To enter a miscellaneous cost:
1.0pen Project and Job Costing > PJC Transactions > Costs.

Click here for information on the fields that appear on the Costs form.

2.Click the New button beside the Document Number field. Project and
Job Costing assigns a new transaction number when you add the
transaction.

3.Enter [ header information for the transaction.

4.Click the Detail/Tax button, or click the first line on the grid and press
F9 to display the Detail Costs/Taxes form.

5.ENnter [ details for this transaction.

6.When you have finished entering details, click Close to return to the
Costs form.

7.Click Add (or Save) to add or save the transaction.
8.Click Post.

[}l After posting a cost transaction

[l Related topics
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Transfer Material to a Project from Inventory
Control

Overview

L] Before you start
To record the transfer of material from inventory:
1.0pen Project and Job Costing > PJC Transactions > Material Usage.

Click here for help on the fields on the Material Usage form.

2.Accept the New status in the Material Usage Number field.

3.Enter [ nheader information for the transaction.

4.Click the Detail/Tax button, or click the first line on the grid and press
F9 to display the Detail Material Usage/Taxes form.

5.ENnter [ details for this transaction.

6.When you have finished entering details, click Close to return to the
Material Usage form.

7.Click Add (or Save) to add or save the transaction.

8.To enter another transaction, click the New button next to the Material
Usage Number field, then complete steps 2 through 7 again, or click
Close.

[ After adding a material usage transaction
[l Related topics
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Allocate Lot Numbers in Material Usage
Transactions

[l overview

L] Before you start

To allocate lot numbers in a material usage transaction:
1.0pen Project and Job Costing > PJC Transactions > Material Usage.
2.Enter header information for the transaction, as usual.

3.Enter transaction details, using the Quantity field for each lotted item,
as follows:

a. [] select the detail on the grid, and then click the Zoom button (A) for the
Quantity field.

If you are editing an existing detail and you don't want to change
the quantity, click the Zoom button for the Quantity field.

The Serial/Lot Numbers Allocation form appears.
Click here for help on the fields on the Serial/Lot Numbers Allocation form.
b. Click the Lots tab.

The quantity that you need to allocate from lots appears in the Lot
Qty. Required field.

c. Use the grid on the Lots tab to specify lot numbers and the
guantities to allocate from each lot.

o To allocate items from one lot at a time € Type or select
each lot number in the Lot Number column, and then enter the
guantity of items to allocate from the specified lot.

o To allocate all items at once, starting with the first
available lot number € Click the Auto-Alloc. button.

o To allocate all items all at once, starting with a lot number
you specify € Select the Auto-Allocate From option, type or
select the starting number for the sequence in the field that
appears, and then click the Auto-Alloc. button.
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As you allocate from lots, the quantity in the Remaining field is
reduced.

d. When the quantity in the Remaining field is zero, click Close.
e. Click Add (or Save).

f.  If you are using the Detail Material Usage /Taxes form and you
have finished entering details, click Close.

7.When you are ready to post the transaction, click Post.

[l Related topics
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Allocate Serial Numbers to Items in Material
Usage Transactions

[l overview

L] Before you start

To allocate serial numbers to items in a material usage transaction:
1.0pen Project and Job Costing > PJC Transactions > Material Usage.
2.Enter the header for the material usage transaction, as usual.

3.Enter transaction details, using the Quantity field for each serialized
item, as follows:

a. [ onthe detail grid, €NtEr @ quantity, then press the Tab key or click the
Quantity column heading.

Note: You cannot assign a serial number to a fractional quantity.

Therefore, [l enter a quantity that will result in a whole number when the program converts the unit of

measure to stocking units.

If you are editing an existing transaction and you don't want to
change the quantity, click the Zoom button beside the Quantity
field.

The Serial/Lot Numbers Allocation form appears.
Click here for help on the fields on the Serial/Lot Numbers Allocation form.
b. Click the Serials tab.

The quantity of serial numbers that you need to allocate appears in
the Serial Nos. Required field.

c. Use the grid on the Serials tab to allocate serial numbers in one of
the following ways:

o To allocate serial numbers one at a time, type or select the
serial numbers in the Serial Number column.

o To allocate the required serial numbers beginning with the first
available serial number, click the Auto-Alloc. button.

o To allocate all the required serial numbers from a particular
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range of numbers, select the Auto-Allocate From option, type or
select the starting number for the sequence in the field that
appears, and then click Auto-Alloc.

The quantity in the Remaining field is reduced as you allocate
serial numbers.

d. When the quantity in the Remaining field is zero, click Close.
e. Click Add (or Save).

f.  If you are using the Detail Material Usage /Taxes form and you
have finished entering details, click Close.

4.When you are ready to post the transaction, click the Post button.

[l Related topics
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Allocate Stored Material for the AIA Report

Overview
To allocate stored material used on a project:

1.0pen Project and Job Costing > PJC Transactions > Material
Allocation.

Click here for help on the fields on the Material Allocation form.

2.Click the New button beside the Material Allocation Number field.
Project and Job Costing will assign a new transaction number when
you add the transaction.

3.Enter [ header information for the transaction.

4.Click the Detail button, or click the first line on the grid and press F9 to
display the Detail Material Allocation form.

5.ENnter [ details for this transaction.

6.When you have finished entering details, click Close to return to the
Material Allocation form.

7.Click Add (or Save) to add or save the transaction.
8.Click Post to post the transaction.

[ After posting a material allocation transaction

[l Related topics
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Return Material to Inventory

Overview
To record the return of material to inventory:

1.0pen Project and Job Costing > PJC Transactions > Material
Returns.

Click here for help on the fields on the Material Returns form.

1.Accept the New status in the Material Return Number field.

2.Enter [ nheader information for the transaction.

3.Click the Detail/Tax button, or click the first line on the grid and press
F9 to display the Detail Material Returns/Taxes form.

4 .Enter @ details for this transaction,

5.When you have finished entering details, click Close to return to the
Material Returns form.

6.Click Add (or Save) to add or save the transaction.

7.7o enter another transaction, click the New button next to the Material
Return Number field, then complete steps 2 through 7 again, or click
Close.

[}l After adding a material return transaction

[l Related topics
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Allocate Serial Numbers to Items in Material
Returns Transactions

LI overview

To allocate serial numbers to items you are returning:

1.0pen Project and Job Costing > PJC Transactions > Material
Returns.

2.Enter header information for the transaction, as usual.

3.Enter the transaction details, using the Quantity field for each
serialized item, as follows:

a. [ onthedenailarid, €NtEr @ quantity, and then press the Tab key or click

the Quantity column heading.

Note: You cannot assign a serial number to a fractional quantity.

Therefore, [l enter a quantity that will result in a whole number when the program converts the unit of

measure to stocking units.

If you are reallocating serial numbers for an existing detail and you
don't want to change the quantity, accept the value in the Quantity

field, and then click the Quantity column heading.
The Serial/Lot Numbers Generation form appears.

Click here for help on the fields on the Serial/Lot Numbers Generation form.

b. Click the Serials tab.

The quantity of serial numbers that you need to allocate appears in

the Serial Nos. Required field.

c. Allocate serial numbers in one of the following ways:

o To allocate serial numbers manually € Type or select the
serial numbers in the Serial Number column.

o To allocate all the required serial numbers beginning with
the first available serial number@ Click the Auto-Alloc.
button.

o To allocate serial numbers from a particular range of

numbers € Select the Auto-Allocate From option. In the
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adjacent field, type or select the serial number to begin the
series, and then click the Auto-Alloc. button.

The quantity in the Remaining field is reduced as you allocate
serial numbers.

d. When the quantity in the Remaining field is zero, click Close.
e. Click Add (or Save).

f.  If you are using the Detail Material Returns/Taxes form and you
have finished entering details, click Close.

4.When you are ready to post the transaction, click Post.

[l Related topics
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Allocate Lot Numbers in Material Returns
Transactions

[l overview

1.0pen Project and Job Costing > PJC Transactions > Material

Returns.

2.Enter header information for the transaction, as usual.

3.Enter the transaction details, using the Quantity field for each lotted

a.

item, as follows:

[ on the detail arid, €NtEr @ quantity, and then press the Tab key or click
the Quantity column heading.

If you are changing a lot number for an existing detail and you
don't want to change the quantity, accept the value in the Quantity
field, and then click the Quantity column heading.

The Serial/Lot Numbers Generation form appears.
Click here for help on the fields on the Serial/Lot Numbers Generation form.
Click the Lots tab.

The quantity that you need to allocate to lots appears in the Lot
Qty Required field.

If you are generating lot numbers for the items, specify whether to
use a fixed number of lots with evenly distributed quantities, or lots
that include a specific quantity.

To generate a fixed number of lots with evenly distributed
quantities, type the number of lots to create in the Make [ ] Lots
field.

To generate lots that include a specific quantity, type the
guantity each lot should have in the Each Lot Has [ ] field.

Assign quantities to lot numbers in any the following ways:

To assign existing lot numbers, using one line in the grid for
each lot, type or select the lot number in the Lot Number
column, and then enter the quantity you are returning for that
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lot.

o To generate new lot numbers one at a time, accept the
number in the Next Lot Number field or type a different number,
and then click the Add button.

o To generate all required lot numbers at once, accept the
number in the Next Lot Number field or type a different number,
and then click the Auto-Gen. button.

The quantity remaining to be allocated is reduced as you allocate
numbers.

d. When the quantity in the Remaining field is zero, click Close.
e. Click Add (or Save).

f.  If you are using the Detail Material Usage /Taxes form and you
have finished entering details, click Close.

4.When you are ready to post the transaction, click Post.

[l Related topics
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Post Transactions
[l Before you start
To post a range of transactions:

1.0pen Project and Job Costing > PJC Transactions > Post
Transactions.

2.Select a @ transaction type.

3.Choose to post all unposted transactions or a specified range of
transactions of the selected type.

4.Specify the O saws Of the transactions you want to post.
5.Click Post.

[ After posting
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Adjust a Posted Transaction

Overview

Note: You cannot adjust or transfer details for items that use serial
numbers or lot numbers.

To adjust a posted transaction:

1.0pen Project and Job Costing > PJC Transactions > Adjustments.

Click here for help on the fields that appear on the Adjustments form.

2.Click the New button beside the Adjustment Number field to let
Project and Job Costing assign a number when you add the
transaction.

3.Enter [ header information for the adjustment.

4.Either click the Detail button or select a detail line, then press F9 to
open the detail form.

5.|I| Enter detail information using the Detail Adjustments form that appears.
6.Click Add (or Save), then:

o  Click the New button beside the Adjustment Number field, if you
want to enter another transaction.

o  Click Post to post the transaction, if it has been approved.

o  Click Close to close the Adjustments form.

[}l After posting adjustments

[l Related topics
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Bill Customers

[l overview

L] Before you start
To create a billing worksheet:

1.0pen Project and Job Costing > Periodic Processing > A/R Billing >
Create Billing Worksheet.

Click here for help on the fields that appear on the Create Billing Worksheet form.

2.Choose whether to cut off transactions by transaction date or by year
and period, and specify the date or year and period.

3.Specify the date to use on the invoices.

4SpeC|fy the © invoice type.
5.1f you use retainage accounting and you have a multicurrency system,

specify whether to use the exchange rate from the original document
or the current exchange rate when converting amounts.

6.Specify, in the Create Invoices By field, whether to create separate
invoices for each customer, contract, or project.

7.Specify up to four selection criteria. [

8.Specify additional criteria, depending on the type of invoice you are
generating (item or summary), and whether you want to include
customers on hold, inactive customers, contracts on hold, projects on
hold, zero-billed fixed price projects, transactions on hold, or non-
billable transactions (for time and materials projects, only).

9.Click Generate to produce a billing worksheet.

Project and Job Costing uses the entries on the worksheet to create
invoices for Accounts Receivable, unless you change them on the
worksheet.

[}l After creating the billing worksheet

[}l Additional information

[l Related topics
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Check, Edit, or Post a Billing Worksheet

Overview

[*] Before you start
To check, edit, or post a billing worksheet

1.Choose Project and Job Costing > Periodic Processing > A/R Billing >
Billing Worksheet.

Click here for help on the fields on the Billing Worksheet form.

2.I1n the Worksheet Number field, enter or select the number of the
worksheet you want to review or edit.

3.To change the posting date, click the Zoom button beside the
Year/Period field, then edit the Posting Date field in the Posting Date
Override form that appears.

4.To view or edit invoice details for a customer, select the line on the
worksheet grid, then click the Details button or press F9.

Note: The information that is included with an invoice detail @ depends on
the project type and accounting method and the invoice type.

To view a detail for an item invoice in the original transaction entry
form, click the Drilldown (¥) button.

5.Adjust amounts or descriptions, percentages complete, retainage
percentages, or retention periods, as necessary, then close the form.
(Note that the program uses retainage terms from the customer
record; you cannot change them on the billing worksheet.)

Project and Job Costing updates the amount billed for the contract,
project, and (for some projects) category when you post the
worksheet entries.

6.To post the entries for the worksheet, click the Post button.

You can also post ranges of worksheets using the post gilling worksheets form.

[}l Additional information

[l Related topics
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Recognize Revenue

Overview

L] Before you start
To create a revenue recognition worksheet:

1.0pen Project and Job Costing > Periodic Processing > Revenue
Recognition > Create Rev. Rec. Worksheet.

Click here for help on the fields that appear on the Create Rev. Rec. Worksheet form.

2.Enter [ header information for the worksheet.

3.Identify the period for which to recognize revenue using the following
fields:

Cutoff By. [t]

[}l Year/Period / Cutoff Date.

4.In the Worksheet Date field, enter the date for the revenue recognition
entries.

5.1f you want to change the fiscal year and period to which the entries
will be posted, click the Zoom button beside the worksheet
Year/Period field, then edit the posting date on the Posting Date
Override form that appears. (The posting date determines the fiscal
year and period to which the entries are posted .)

6.Use the following fields to specify selection criteria, if you want to limit
the contracts, projects, and categories for which to recognize
revenue:

[ Select By.
Then By. [
Include Contracts On Hold/Include Projects On Hold. [

[ Include Projects With No Costs.

[ Include Completed Projects (for closing).

7.Click Generate to create a worksheet that contains revenue
recognition entries for the selected contracts, projects, and
categories.

[}l After creating the revenue recognition worksheet

[}l Additional information
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[l Related topics
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Update Payroll Records

Overview

To clear timecards and update records in US Payroll or in Canadian
Payroll:

1.0pen Project and Job Costing > PJC Periodic Processing > Update
Payroll.

2.Specify the payroll timecards to update, using the following fields:
From End Date/To End Date [
From Employee Number/To Employee Number [

Payroll Type [
Update Status [

3.Click Update to create the timecards in your payroll program or to
export them to a CSV file.

[}l After updating payroll
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Create Transactions for General Ledger

L] Before you start
To create general ledger transactions:

1.0pen Project and Job Costing > PJC Periodic Processing > Create
G/L Batch.

The form shows the posting sequence number assigned to the last
posting run for each type of transaction.

2.Select the types of posted transactions for which you want to create
general ledger transactions.

If you use Sage ERP Accpac General Ledger, Project and Job
Costing either adds the new transactions to existing General Ledger
batches or creates new batches, depending on your choice for the
Create G/L Transactions By option.

If you do not use Sage ERP Accpac General Ledger, you see a
message asking whether to append transactions to an existing batch
file or to overwrite the file.

3.For each type you select, type the posting sequence number
assigned to the latest posting run for which you want to create general
ledger batches, or accept the displayed numbers.

You can look up the number of the last posting sequence processed
for each batch type in the G/L Transactions Generated Through box
on the Integration tab of the Options form.

4.Click Process to create the batch.
5.When finished, click Close to close the form.

[}l After creating general ledger transactions
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Set up and Maintain Budgets
Overview
To add or change a project budget:

1.0pen Project and Job Costing > PJC Transactions > Budget
Maintenance.

Click here for help on the fields that appear on the Budget Maintenance form.

2.In the fields provided, type or select the contract, project, and
category for which you want to enter a budget, or select the project
category on the tree.

3.Using the Budget Set and Year fields, select the budget set and year
for which you are adding the budget.

4.1f you have a multicurrency system, select the currency rate type and
rate date, or enter the rate.

5.In the Show field, specify whether to display original, current, or actual
amounts in the Quantity, Cost, and Revenue fields.

If you do not want to view this additional information, accept the
default, None.

6.Click the Go (ss)button, or press the F7 key, to display existing
information for the budget set and year, if it is not displayed
automatically.

7.1f you are basing the budget on an existing budget, use the Budget
Set Lookup fields to identify the contract, project, category, budget
set, and year whose budget will be the basis for the new budget.

Note: To view the differences between the budget you are adding and
the inquiry budget, the option Display Comparison Columns must be
selected on the File menu.

8.1f you want the system to calculate amounts for you, select a budget
method.

Based on the method you choose, a field may appear requesting a
percentage and/or an amount. Supply the requested information.

To copy inquiry amounts to your new budget, you must select one of
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the Copy budget methods.

9.Click the Add To button to add the amounts in the Inquiry column to
the amounts in the Budget column.

Or

Click the Replace button to replace the amounts in the Budget column
with the amounts in the Inquiry column.

The new budget amounts will appear in the Budget Quantity, Budget
Costs, or Budget Revenue column.

10.Review the budget entries to ensure they are correct.
11.When you finish, click Add or Save.

[}l To display period amounts for any project category

[l To change a budget set for a project category

[l To clear all the period amounts for the displayed budget set
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Clear History

[l overview

[l Before you start

To clear obsolete information from Project and Job Costing:

1.0pen Project and Job Costing > PJC Periodic Processing > Clear

History.

Click here for help on the fields on the Clear History form.

2.Select the types of records you want to clear, then:

a.

a.

If you are clearing printed posting journals:

Select the type of posting journal to clear.

In the Through Posting Sequence Number field, type the number
of the posting sequence through which you want to clear.

Select the types of posting journals you want to clear at this time.

If you are clearing posted documents:

In the Cutoff By field, indicate whether to clear posted documents
that have a transaction date up to a specified transaction date or
year and period.

If you select Transaction Date in the Cutoff By field, specify the
date in the Transaction Date field.

If you select Year/Period, specify the year and period in the
Year/Period field.

Select the types of documents you want to clear at this time.

After you clear posted documents, you can view the transactions
using the Transaction History form, but you cannot drill down to the
document in the original entry form.

If you are clearing transactions for contracts that you have
closed:

Use the From and To fields to specify the range of contracts for
which to clear transactions.
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b. In the Cutoff By field, indicate whether to clear transactions that
have a transaction date up to a specified transaction date or year
and period.

c. If you select Transaction Date in the Cutoff By field, specify the
date in the Transaction Date field.

d. If you select Year/Period, specify the year and period in the
Year/Period field.

If you are clearing closed contracts:

a. Specify the range of contract numbers for which you want to clear
closed contracts.

If you are clearing the Posting Errors report:

a. Inthe Through Posting Sequence Number field, enter the highest
posting sequence through which you want to clear. (The most
recent posting sequence appears as the default.)

If you are clearing a range of transactions from the Committed
Costs Audit List, specify:

a. The ranges of contracts, projects, and categories for which you
want to clear committed cost transactions.

b.  The transaction date up to which transactions can be cleared.

3.Click Process.



Reopen a Closed Project
Overview
To reopen a project that you have closed:

1.0pen Project and Job Costing > PJC Periodic Processing > Reopen
Closed Projects > Create Reopen Worksheet.

Click here for help on the fields on the Create Reopen Worksheet form.

2.Type a description for the worksheet, and then identify the contract
and the projects you want to reopen. (You must create a separate
worksheet for each contract.)

3.When you have completed all the fields, click Generate to create the
worksheet.

[}l After reopening a project
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Quickly Display a Contract Project

[l overview

L] Before you start
To display a specific contract project:

1.In the Contract Maintenance form, from the Search list at the top right
corner of the form, select Project.

2.Click the next field to the right, and then enter the code for the project
you want to display.
3.Click the Go (s») button beside the project code.
o If the program finds a project that has the code you entered, it
displays that project in the Project Maintenance form.

o If the program cannot locate a project that has the specified code,
it displays the project whose code is the closest match to that
code.

a. If the displayed project is not the one you want, you can click
the Go button again to display the next match.

[l Related topics
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Quickly Display a Contract Category

[l overview

L] Before you start
To display a specific contract category:

1.In the Contract Maintenance form, from the Search list at the top right
corner of the form, select Category.
2.Click the next field to the right, and then enter the code for the
category you want to display.
3.Click the Go (s») button beside the category code.
o If the program finds a category that has the code you entered, it
displays it in the Category Maintenance form.

o If the program cannot locate a category that has the specified
code, it displays the category whose code is the closest match to
that code.

a. If the displayed category is not the one you want, you can click
the Go button again to display the next match.

[l Related topics
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View Contract Totals

To view totals for a contract:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.Use the Finder or the navigation buttons beside the Contract field to
select the contract you want to review, or type the contract code in the
Contract field.

3.Click the mtais ab ON the Contract Maintenance form that appears in the
panel on the right to view aggregate totals (extended cost, labour,
overhead, total, revenues, and profit) for all the projects in the
contract, including estimated, committed, actuals, and recognized
amounts, as well as retainage receivable and retainage payable.

[}l Additional information

[l Related topics
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View Project Totals

To view totals for a project:

1.0pen Project and Job Costing > PJC Transactions > Contract
Maintenance.

Click here for help on the fields on the Contract Maintenance form.

2.Use the Finder or the navigation buttons beside the Contract field to
select the contract you want to review, or type the contract code in the
Contract field.

3.1um on the tree view, If the contract tree is not already visible.

4.0n the contract tree, click the folder for the project you want to review.

5.Click the maistab 0N the Project Maintenance form that appears in the
panel on the right to view totals (extended cost, labour, overhead,
total, revenues, and profit) for all the projects in the contract, including
estimated, committed, actuals, and recognized amounts, as well as
retainage receivable and retainage payable.

[l Related topics
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View Transaction History

Overview

To view transactions using the Transaction History form:
1.0pen the Transaction History form in one of the following ways:

o Open Project and Job Costing > PJC Transactions > Transaction
History.

Or

o Open Project and Job Costing > PJC Transactions > Contract
Maintenance, and then:

a. Use the Finder or the navigation buttons for the Contract field
to display the contract.

b. Turn on the tree view, If the contract tree is not already visible.

C. Right-click a particular contract, project, category, or resource

on the tree in Contract Maintenance, then click Transactions on
the menu that appears.

The Transaction History form opens, displaying transactions for
the selected contract, project, category, or resource.

The display includes all the data from the posted transactions. You
can use the horizontal and vertical scroll bars to view all the rows and
columns.

2.To drill down to a transaction from the Transaction History form,
either:

o  Double-click a transaction to display the source document in the
originating ledger and entry form.

Or
o  Select the transaction on the grid, then click the Details button.
3.To print a transaction history report for your records:
a. On the File menu, click Print.
b.  Select options on the Transaction History Report form that



appears, according to your needs, and then click Print.

[}l Additional information
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Add or Modify Cost Types

[l overview

[l Before you start
To add, edit, or delete a cost type:
1.0pen Project and Job Costing > PJC Setup > Cost Types.

Click here for help on the fields that appear on the Cost Types form.

2.1f you are adding a new cost type:

a. Inthe Cost Type Code field, enter a unique code to identify the
cost type, using up to 10 alphanumeric characters.

b.  Enter a description of the cost type.

c. Select a cost class, consistent with the cost type you are setting up
(for example, Labor, Overhead, or Material).

d. Click Add.
If you are editing an existing cost type:

a. Use the Finder or the navigation buttons beside the Cost Type
Code field to display the cost type record.

b. Make the required change.
c. Click Save.
If you are deleting a cost type:

a. Use the Finder or the navigation buttons beside the Cost Type
Code field to display the cost type record.

b. Click Delete.

3.To work with another cost type record, use the buttons beside the
Cost Type Code field to start a new record (&) or select an existing
one ().

4.When you have finished, click Close to close the form.

[}l After adding or modifying cost types

[}l Additional information



javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

Add or Modify Optional Fields

[l overview

[l Before you start

To add, edit, or delete an optional field:
1.0pen Project and Job Costing > PJC Setup > Optional Fields.

Click here for help on the fields that appear on the Optional Fields form.

2.Select from the Optional Fields For list the type of optional fields you

are defining, then:

3.If you are adding a new optional field:

a.

g.

Click the first blank line in the grid, or press the Insert key on your
keyboard.

Double-click in the Optional Field column, then type or use the
Finder to select the @ optional field code for the optional field.

[} Type or select the value to use as the default entry in new records or transactions for which you are defining
the optional field.

If you specify a value that is defined in Common Services, the
program displays the description for the value.

Double-click the Value Set column to Show & whether or not the optional field has

a default value.

Double-click in the Required column to display Yes if you want to
make this field mandatory & .

Double-click in the Auto Insert field to display Yes if you want to
display the optional field entry automatically in new records or
transactions.

If this is an optional field for a transaction or transaction details,
click the Settings button to open the setings form, then specify whether
to pass data to matching optional fields in Sage Accpac Accounts
Receivable, Inventory Control, or US or Canadian Payroll, and
General Ledger accounts.

Click Add to add the new optional field.

If you are editing an existing optional field:
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a. Make any required changes on the line for the optional field you
want to change.

b.  Click the Settings button if you need to edit the programs or
accounts to which optional field information can be passed.

c. Click Save to save your changes.
If you are deleting an existing optional field:
Click the line for the optional field you want to delete.
b. Press the Delete key on your keyboard.

If you want to delete all the optional fields for the selected type of
record , click the Delete button

c. Click Yes to confirm the deletion.

[}l After adding or modifying optional fields

[}l Additional information
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Add or Modify Contract Structures

[l overview

[*] pefore you start
To add, edit, or delete a contract structure:
1.0pen Project and Job Costing > PJC Setup > Contract Structures.

Click here for help on the fields that appear on the Contract Structures form.

2.1f you are adding a new contract structure:

a. Inthe Structure Code field, type a unique code using up to 6
alphanumeric characters.

b.  Type a meaningful description for the contract structure in the
Description field.

c. If you wantto use a prefix at the beginning of contract numbers
using this structure, select one from the drop-down list. The
program displays only the separators you allow to be used on the
PJC Options form.

d. Double-click the Segment Description field, then select the first
segment of the contract structure.

e. If you want to use a symbol to separate this segment from the next
one in the contract structure, click the Segment Separator field on
the same line, then select a symbol from the & jis. (If you select a
separator character for the last segment in a contract structure, the
character appears at the end of contract numbers using that
contract structure.)

f.  Press the Insert key to add another segment to the structure.

g. After ensuring that the segments are correct and in the order you
want, click Add.

If you are modifying an existing contract structure:

a. Use the Finder or the navigation buttons beside the Structure
Code field to display the contract structure record.

b. Use the remaining fields to make your changes, just as you would
if you were adding a new contract structure.
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c. After ensuring that the segments are correct and in the order you
want, click Save.

If you are deleting a contract structure

a. Use the Finder or the navigation buttons beside the Structure
Code field to display the contract structure record.

b. Click Delete.

3.To work with another record, use the buttons beside the Structure
Code field to start a new record (&) or select an existing one (2) .

4.When you are finished, click Close to close the form.

[}l After adding or modifying contract structures

[l Related topics
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Add or Modify Segment Codes

Overview

L] Before you start
To add, edit, or delete a segment code:
1.0pen Project and Job Costing > PJC Setup > Segment Codes.

Click here for help on the fields that appear on the Segment Codes form.

1.In the Segment Name field, select the segment for which you want to
enter valid segment codes.

2.Press the Tab key to move into the grid, then press the Insert key to
add new codes.

3.|I| Define the valid codes that can be used for the selected segment.

4.To add segment codes for another segment, repeat steps 2 through 4.

5.When you have finished adding codes, click Save, and then click
Close.

When you add a new contract number, Project and Job Costing verifies
your entry for segments that use the Validate option against the valid
segment codes you added for each segment. If the segments are all
valid, the program adds the contract number to the system.

[}l After adding or changing segment codes

[}l Additional information

[l Related topics
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Add or Modify Account Sets

[l overview

[l Before you start
To add, edit, or delete an account set:
1.0pen Project and Job Costing > PJC Setup > Account Sets.

Click here for help on the fields that appear on the Account Sets form.

2.1f you are adding a new account set:

a. Inthe Account Set Code field, enter a unique code for the account
set using up to six alphanumeric characters.

b.  Enter a description for the account set.
If you are editing or deleting an account set:
a. Inthe Account Set Code field, display the code for the account set.

3.Use the remaining fields to define the new account set or enter
required changes to an existing account set.

4 .Click Add or Save to save the record.
Or

If you are deleting an account set, click Delete , and then click Yes
confirm that you want to delete the record.

5.To work with another record, use the buttons beside the Account Set
Code field to start a new record (&) or select an existing one (a).

6.Click Close when you are finished.

[}l After adding or modifying account sets.
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Add or Modify Project Records

Overview

L] Before you start
To add, edit, or delete a project record:
1.0pen Project and Job Costing > PJC Setup > Projects.

Click here for help on the fields that appear on the Projects form.

2.In the Project field (the field described by the Level 2 name on the
Options form), enter the code for this new project using up to 16
characters.

3.Enter a description for the project in the Description field, using up to
60 characters.

4.Enter default settings for this project on the Project tab.

5.1f you want to replace segment codes in General Ledger accounts
when you generate transactions for projects that use this project
code, click the Integration tab, then select the Override G/L Account
Segments option. choose the G/L segments to override and the codes
you want to override them with on the grid that appears.

6.1f you use optional fields, click the Optional Fields tab to edit or check
the optional fields assigned to the project.

7.When you have finished entering data to define the project, click Add.

8.To add another project record, click the New button next to the Project
field and repeat steps 2 through 7. Otherwise, click the Close button
to close the Project form.

[}l After adding or changing project records

[l Related topics
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Add or Modify Category Records

[l overview

[l Before you start
To add, edit, or delete a category record:
1.0pen Project and Job Costing > PJC Setup > Categories.

Click here for help on the fields that appear on the Categories form.

2.1f you are adding a new category record:

a. Inthe Category field, enter a unique category code using up to 16
alphanumeric characters.

b. Inthe Description field, enter a description for the cost category.
If you are editing a category:

a. Use the Finder or the navigation buttons beside the Category field
to display the category record.

If you are deleting a category:

a. Use the Finder or the navigation buttons beside the Category field
to display the category record.

b. Click the Delete button.

c. Click Yes to confirm that you want to delete the record when
prompted.

d.  Skip the remaining steps, unless you want to work with another
category record.

3.0n the Category tab, specify the settings you want to use for
transactions and in projects that use this category.

4.0n the Default Settings for Basic Projects tab, specify the:

o  A/R item number, unit of measure, and cost per unit of measure to
use for this category when processing cost transactions for, or
estimating, basic projects.

o  Default billing rate to be used in transactions and estimates for basic

projects that use an item invoice type [,
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o In a multicurrency ledger, the billing rate for each of the currencies
used by your customers.

5.To override General Ledger account segments in cost transactions
that use this category, click the Integration tab, and then:

a. Select the option Override G/L Account Segments.

b.  On the grid that appears, specify the G/L segment code you want
to use for each overridden General Ledger segment..

6.1f you use optional fields, click the Optional Fields tab t0 & edit or check the

optional fields assigned to the category.

7.Click Add if you are adding a new category.
Or
Click Save to save your changes to the record.

8.To work with another record, use the buttons beside the Category field
to start a new record (&) or select an existing one (2).

9.When you have finished, click Close to close the form.

[}l After adding or modifying cateqory records

[l Related topics
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Add or Modify Employee Records

[l overview

L] Before you start
To add, edit, or delete an employee record:
1.0pen Project and Job Costing > PJC Setup > Employees.

Click here for help on the fields that appear on the Employees form.

2.1f you are adding a new employee record:
a. Inthe Payroll Type field:

o Select the Sage ERP Accpac Payroll program in which the
employee you want to add to your Project and Job Costing
system is enrolled.

Or

o If you do not use an Sage ERP Accpac Payroll program, or if
the employee record does not exist in the other program, select
None.

b. If you selected US Payroll or Canadian Payroll as the Payroll Type,
select an existing employee record from Sage ERP Accpac Payroll
using the Finder or the navigation buttons next to the Employee
field.

The employee number appears in the Employee Number field

If you do not use US or Canadian Payroll, or if the employee does
not exist in the payroll program:

1. Enter a unigue employee number in the Employee Number
field.

2. Type the employee's name in the Name field.
If you are editing an existing employee record:

a. Use the Finder or the navigation buttons beside the Employee
Number field to display the employee record.

If you are deleting an existing employee record:
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a. Use the Finder or the navigation buttons beside the Employee
Number field to display the employee record.

b.  Click the Delete button, and then click Yes to confirm you want to
delete this record.

c.  Skip the remaining steps.

3.Click the Employee tab, then use the fields on this tab to enter or
change information for the employee.

4.To change the A/R item number or unit of measure to use as defaults
for this employee on item invoices, click the Default Settings for
Standard Projects tab, then make your changes in the fields provided.

5.Click the Security tab, then double-click the Visible columns for
selected fields that you want to hide on the employee's timecard.

6.1f you use optional fields, use the Optional Fields tab to edit or check
the optional fields assigned to the project.

7.Click Add to add the record, or click Save to save changes to an
existing record.

[l After adding or modifying employee records

[}l Additional information

[l Related topics
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Add or Modify Equipment Records

[l Before you start

To add, edit, or delete an equipment record:

1.0pen Project and Job Costing > PJC Setup > Equipment.

Click here for help on the fields that appear on the Equipment form.

2.1f you are adding a new equipment record:

a.

a.

b.

a.

In the Equipment Code field, enter a unique code to identify the
piece of equipment, using up to 15 characters.

In the Description field, enter a description of the equipment, using
up to 65 characters.

If you use Sage ERP Accpac Transaction Analysis and Optional
Field Creator and you want to edit optional fields assigned to the
record, click the Zoom () button beside the Optional Fields
checkbox, then add or edit equipment optional fields in the form
that appears.

Enter the settings you want to use as defaults for standard projects
in the A/R Item No., & unitof Measure, and Unit Cost fields.

Enter rate at which you bill your customers for each unit of
measure. (Time and materials projects and fixed price projects that
use the billings and costs or accrual-basis accounting methods
require a billing rate.)

In a multicurrency system, you use the currency grid to enter a
billing rate for each of your customer's currencies.

If you are editing an existing equipment record:

Use the Finder or the navigation buttons beside the Equipment
Code field to display the record you want.

Make your changes.

If you are deleting an equipment record:

Use the Finder or the navigation buttons beside the Equipment
Code field to display the record you want.
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b. Click Delete, then click Yes to confirm that you want to delete the
record.

c. Skip step 3.
3.Click Add or Save to save the record.

4.To work with another record, use the buttons beside the Equipment
Code field to start a new record (&) or select an existing one (2) .

5.When you have finished, click Close.

[}l After adding or modifying equipment records

[}l Additional information

[l Related topics
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Add or Modify Miscellaneous Expense Records

[l overview

[l Before you start

To add, edit, or delete a miscellaneous expense record:

1.0pen Project and Job Costing > PJC Setup > Miscellaneous

Expenses.

Click here for help on the fields that appear on the Miscellaneous Expenses form.

2.1f you are adding a new miscellaneous expense record:

a.

a.

b.

In the Miscellaneous Code field, enter a unique code for the
miscellaneous cost, using up to 16 alphanumeric characters.

In the Description field, enter a description of the cost. You can use
up to 60 alphanumeric characters.

If you use Sage ERP Accpac Transaction Analysis and Optional
Field Creator and you want to edit optional fields assigned to the
record, click the Zoom () button beside the Optional Fields
checkbox, then add or edit miscellaneous expenses optional fields
in the form that appears.

Enter default settings for standard projects in the A/R Item No.,
Unit of Measure, and Unit Cost fields.

Enter rate at which you bill your customers for each unit of
measure. (Time and materials projects and fixed price projects that
use the billings and costs or accrual-basis accounting methods
require a billing rate.)

In a multicurrency system, you use the grid to enter a billing rate
for each currency used by your customers.

If you are editing an existing miscellaneous expense record:

Use the Finder or the navigation buttons beside the Miscellaneous
Code field to select the miscellaneous expense record you want.

Enter your changes in the record.

If you are deleting an existing miscellaneous expense record:
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a. Use the Finder or the navigation buttons beside the Miscellaneous
Code field to select the miscellaneous expense record you want.

b. Click Delete, then click Yes to confirm that you want to delete the
record.

c. Skip step 3.
3.Click Add or Save to save the record.

4.To work with another record, use the buttons beside the
Miscellaneous Code field to start a new record (&) or select an
existing one (2) .

5.Click Close when you have finished.

[}l After adding or modifying miscellaneous Expense Records

[}l Additional information

[l Related topics
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Add or Modify Overhead Expense Records

[l overview

L] Before you start
To add, edit, or delete an overhead expense record:
1.0pen Project and Job Costing > PJC Setup > Overhead Expenses.

Click here for help on the fields that appear on the Overhead Expenses form.

2.If you are adding a new overhead expense code:

a. Inthe Overhead Code field, enter a unique overhead code, using
up to 16 alphanumeric characters.

b. In the Description field, enter a description of the cost. You can use
up to 60 alphanumeric characters.

c. Ifyou use Sage ERP Accpac Transaction Analysis and Optional
Field Creator and you want to edit optional fields assigned to the
record, click the Zoom () button beside the Optional Fields
checkbox, then add or edit overhead expenses optional fields in
the form that appears.

d. Enter default settings for standard projects in the A/R Item No.,
Unit of Measure, and Unit Cost fields.

e. Enter rate at which you bill your customers for each unit of
measure. (Time and materials projects and fixed price projects that
use the billings and costs or accrual-basis accounting methods
require a billing rate.)

In a multicurrency system, you use the grid to enter a billing rate
for each currency used by your customers.

If you are editing an existing overhead expense record:

a. Use the Finder or the navigation buttons beside the Overhead
Code field to select the overhead expense record you want.

b.  Enter your changes in the record.
If you are deleting an existing overhead expense record:

a. Use the Finder or the navigation buttons beside the Overhead
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Code field to select the overhead expense record you want.

b. Click Delete, then click Yes to confirm that you want to delete the
record.

c. Skip step 3.
3.Click Add or Save to save the record.

4.To work with another record, use the buttons beside the Overhead
Code field to start a new record (&) or select an existing one (2) .

[}l After adding or modifying overhead expense records

[}l Additional information

[l Related topics
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Add or Modify Subcontractor Records

[*] pefore you start
To add, edit, or delete a subcontractor record:
1.0pen Project and Job Costing > PJC Setup > Subcontractors.

Click here for help on the fields that appear on the Subcontractors form.

2.In the Subcontractor Code field, enter a code for the subcontractor
using up to 16 characters.

3.In the Subcontractor Name field, enter the subcontractor's name.

4.Enter a description for the subcontractor, such as the type of service
provided.

5.To display the information from the Accounts Payable vendor record
as the defaults for the subcontractor, enter the A/P vendor number, or
select it using the Finder.

6.Complete the remaining fields.
7.Click Add to add the record, or Save to save your changes.

8.To add another subcontractor record, click the New button next to the
Subcontractor Code field and repeat steps 2 through 7, or click Close
to close the form.

[}l After adding subcontractor records

[}l Additional information
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Add or Modify Charge Records (for fees and
services)

[l overview

L] Before you start
To add, edit, or delete a charge record:
1.0pen Project and Job Costing > PJC Setup > Charges.

Click here for help on the fields that appear on the Charges form.

2.1f you are adding a new charge record:
a. Inthe Charge Code field, enter a unique code for this charge.
b. In the Description field, enter a description for this charge code.

c. Ifyou use Sage ERP Accpac Transaction Analysis and Optional
Field Creator and you want to edit optional fields assigned to the
record, click the Zoom () button beside the Optional Fields
checkbox, then, on the form that appears, add or edit the charge
code optional fields.

d. Inthe Charge Type field, select Service or Fixed Amount, as best
describes the charge.

e. Enter the A/R item number and unit of measure to use for this
charge on item invoices.

f.  Inthe Billing Amount field, enter the per unit amount you charge
your customer .

In a multicurrency system, you use the currency grid to enter a
billing amount for each customer currency.

If you are editing an existing charge record:

a. Use the Finder or the navigation buttons beside the Charge Code
field to display the charge record.

b.  Enter your changes in the remaining fields.
If you are deleting a charge record:
a. Use the Finder or the navigation buttons beside the Charge Code
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field to display the charge record.
3.Click Add to (or Save) to save the record.
Or

Click Delete if you are deleting a charge, and then click Yes confirm
that you want to delete the record.

4.To work with another record, use the buttons beside the Charge Code
field to start a new record (&) or select an existing one (a) .

5.When you have finished adding records, click Close.

[t] After adding or modifying charge codes

[}l Additional information

[l Related topics
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Import Information into Project and Job Costing

To import information or transactions:

1.Create the file you want to import. (You can create a template for an
import file by exporting a few records of the type you want to import.
During the export process, select Save Template , and enter a name
for the template file.)

2.0pen the Project and Job Costing form in which you maintain the data
you want to import.

3.0n the File menu, click the Import command.

4.Type or select the file name and file type in the form that appears
next.

5.1f you previously created a template for importing, choose the Load
Template button, then select the template file.

6.Choose the fields that you want to import and select from any other
options that appear. (You can save your choices as a template for the
next time you import records.)

7.Click OK to begin importing.



Export Project and Job Costing Information

To export Project and Job Costing information

1.0pen the form or form that displays the kind of data that you want to
export.

2.1f necessary, create the records you want to export.
3.0n the File menu, click the Export command.

4.0n the form that appears, select the type of information to export, or
choose Load Template to use an export template you created
previously that matches the information you want to export.

5.To limit the range of records to export, use Set Criteria.

6.In the next form, enter the export file name and file type. If you
frequently export information with these specifications, use the Save
Template button to create an export template that you can use next
time you export the data.

7.When ready, click OK to begin exporting.

If you specified a non-existent folder and file, Project and job Costing
asks whether to create them.



Change Project and Job Costing Program

Options

L] Before you start

To change Project and Job Costing program options:
1.0pen Project and Job Costing > PJC Setup > Options.

Click here for help on the fields on the PJC Options form.

2.Use the tabs on the PJC Options form to edit options that govern how
your Project and Job Costing system behaves.

o Company

o Settings

o Segments

o Transactions

o Integration
3.Click Save.

[}l After changing program options

[l Related topics
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Change General Ledger Integration Options

[l overview

L] Before you start
To change General Ledger Integration options:
1.0pen Project and Job Costing > PJC Setup > G/L Integration.

Click here for help on the fields on the G/L Integration form.

2.0n the Integration tab, edit options using the following fields:

o Create G/L Transactions

o Create G/L Transactions By
o Consolidate G/L Batches

o Source Codes

3.To assign information to a G/L transaction field:

a.  On the Transactions tab, either double-click a particular G/L field
for a transaction entry or detail, or select the field, then click Open.

b. On the G/L Integration Detail form that appears, specify
information for the field as follows:

1. In the Segment Separator field, select a character to separate
segments of information. (The separator is used only if you
assign more than one segment. The default separator is a
hyphen.)

2. From the Choose Segments From List, select a segment, then
click Include to assign individual segments to the selected G/L
field.

You can assign a maximum of five segments to a G/L field,
providing that the combination does not exceed 60 characters.
If the assigned information exceeds this number of characters
(including separators), it will be truncated when the transaction
IS posted.

4.To assign information for other transaction types and G/L fields:
a. From the Transaction Type list, select the type of transaction entry
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or detalil.

The information displayed in the G/L Transaction Field and the
Choose Segments From List fields changes, consistent with the
selected transaction type.

b. From the G/L Transaction Field list, select the G/L field to which
you are assigning information.

c. Select a separator and assign segments, as described step 2.

5.When you have finished assigning information to G/L fields, click
Save, then click Close to return to the G/L Integration form.

6.Click Save.

[}l After changing GIL Integration options

[l Related topics


javascript:void(0);
javascript:void(0);

Select a Printer for Reports

Sage ERP Accpac lets you choose a default printer for all reports that
you print, and assign different printers to specific reports (such as
invoices or labels).

To change the default printer for all reports:
1.0n the Sage Accpac desktop, select File > Page Setup.
2.Click the Printer button.
3.Choose the printer that you want to use from the drop-down list.

The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.

4.Click the Properties button to change available settings for your
particular printer.

5.Click OK to return to the Page Setup form.

6.Click the Print Destination button and check that the print destination
IS set to printer.

If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination

page.
7.Click OK on the Print Destination Page, and then Click OK on the
Page Setup page.

To assign a specific report to a specific printer:
1.0pen the report form which you want to assign to a printer.
2.Select File > Print Setup from the report form menu.

3.Choose whether you want to choose the printer that is set as the
Windows default printer, or choose a specific printer for this report.

Note: By default, the specific printer is the one chosen as the printer
on the Page Setup form selected from the File menu on the Sage
ERP Accpac Desktop

The printer list includes all printers that have been added to the



Printers and Faxes list in Windows.

4.Click the Properties button to change available settings for your
particular printer.

5.Choose a paper source if you want to select a particular paper tray or
paper stock for this report.

6.Click OK Page Setup page.

[l To clear the assigned printer for this report

[t] Prompt for printer each time you print

[l Related topics
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Display Reports on Your Screen

Sage ERP Accpac lets you print reports to a printer, to the screen, to a
file, or as an attachment to an e-mail message.

Note: You must be assigned to a security group that has permission to
change the print destination. (Otherwise, the only destination available is

a physical printer.)

To change the default print destination to Preview:
1.0n the Sage Accpac desktop, select File > Print Destination.
2.Select Preview to view a report on the screen.

You can print from the Preview window by clicking the Printer button,
and you can e-mail the report (for example, you can email A/R
statements and invoices).

3.Click OK.

[}l Additional information regarding print destinations

[l Related topics
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Display a List of Fields You Can Import and
Export

] overview
To display a list of the fields you can import and export:

1.0pen the record or transaction-entry form for the type of record or
transaction you want to import or export.

2.For transaction fields, display an existing batch using the Batch
Number field.
3.From the File menu, click Import or click Export.

4.1f a File Import/Export Selection form appears (for example, if you
clicked Import or Export on the Employees form), select the type of
record to import or export, and then click OK.

5.0n the form that appears, click Display Import Fields or Display
Export Fields to display the name, type, and length of each field in the

record that you can import or export.
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Billing Customers — Overview

You use the icons in the A/R Billing subfolder, in the PJC Periodic
Processing folder, to generate invoices for your customers and to send
the invoices to Accounts Receivable.

eThe create Biling worksheet fOrm lets you generate billing worksheets that
show the details of invoices Project and Job Costing will create for
your customers.

You can create separate billing worksheets for item invoices and
summary invoices, or you can create a worksheet that includes both types

of invoices.

The project type and accounting method determine how the program

calculates billing amounts.

Click here for step-by-step instructions on creating a billing worksheet.

e The siiing worksheet fOrm lets you view, edit and post individual worksheets
that you have generated. Only billable projects are included.

eThe post Biling worksheets fOrm lets you post a range of billing worksheets.

Posting the worksheet in Project and Job Costing creates an invoice
batch in Accounts Receivable, where you can view, edit, and post the
job-related invoices as usual.

When you post the invoice batch in Accounts Receivable, that program
creates General Ledger entries to debit the Accounts Receivable control
account and credit the billings account. Posting also sends the posting
information back to Project and Job Costing, including any changes you
made to the invoices in Accounts Receivable.

I:E' Related Topics
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Reopening Projects

You use the following forms, available in the Reopen Projects subfolder

(in the Periodic Processing folder) to reopen projects you closed
previously:

e¢YOU uSe the create Reopen Projects Worksheet fOrm to select closed prOjeCtS that
you want to reopen and to generate reversing entries for any revenue
that was recognized on completion of the projects. The entries are

added to a Reopen Projects Worksheet that you can view, edit, and
post.

e The Rreapen Projects worksheet |€tS YOU edit the entries generated by the

Create Reopen Projects Worksheet form. It also lets you post the
worksheets.

To reopen any project, you must create and post a Reopen Project
Worksheet that includes the project, even if no general ledger entries are
created to reverse revenue recognition.

You can create the worksheet only for one contract at a time, but you can
reopen a range of projects for the contract. The resulting worksheet lists
the projects selected for reopening, and it may also include entries to
reverse revenue you recognized on closing the projects, previously.



Reversing Recognized Revenue

Whether a project requires reversing entries depends on the project's
accounting method:.

eFor projects that use a billings and costs or accrual-basis accounting
method, reversals are not required. (The program recognizes revenue
on a transaction basis.)

eFor projects that use a completed project accounting method, all
revenue recognition entries must be reversed.

Because the program can reverse only entries that have not been
cleared, you must manually reverse revenue recognition entries for
cleared transactions.

Project and Job Costing lets you choose whether to reverse revenue
automatically. If you choose not to create reversing entries when you
reopen the project, the program resets the project’s status to open,
but does not create any general ledger entries.

eFor projects that use a percentage complete accounting method, only
the entries that resulted from closing the project are reversed.
Revenue that was recognized before the contract was completed is
not reversed.



Using Help

Welcome to Sage ERP Accpac online Help! Help is available from both
the Sage ERP Accpac desktop and Sage ERP Accpac on a Web
browser.

Obtaining Online Help

eFor help on using Sage ERP Accpac:

o  Click Help Topics on the Help menu on the Sage ERP Accpac
desktop, or

o  Press F1 in your browser from an open form.

*To view the Help contents for a specific module, open a form for the
module, then click Contents on the module's Help menu or press F1.

¢Click the What's This command from the Help menu or click the
Context Help button to obtain help about the Sage ERP Accpac
desktop.



Glossary

1099 Form

AR Invoice Type

Account Description
Account Groups

Account Number Segment Overrides
Account Number Segments
Account Number Structures
Account Segment

Account Set

Account Status

Account Types

Accounting Equation
Accounting Method
Accounting Period
Accounts Payable

Accrual

Accrual Carry-Over Date
Accrual Method
Accrual-Basis accounting method
Accrued Expenses
Activating taxes

Activation

Active Order

Actual Fiscal Sets
Adjustment Period
Adjustments

Advance

All Users

Allocated Tips

Allocation Account

Allow Posting to Previous Years
Allow Provisional Posting
Annual Maximum
Annualization

Assets

Assign Ul Profile IDs

Audit Trail

Authentication Method
Automatic Reversal
Backdated document

Bad Debts

Balance Sheet

Base Account

Base Deductions

Base Earnings

Base Hours

Base Taxes

Base Wage Multiplier

Basic Account Information
Basic Project style

Batches

Benefit

Billing Type

Billings And Costs accounting method
Budget Fiscal Sets
Calculation Base
Calculation Methods
Calculator

Carrying Over Vacation, Sick, and Compensatory Time Accruals
Carry-Over

Cash Advance

Cash Benefit

Cash Flow Statement

Cash Method

Category

Category Percentage Complete accounting method
Ceiling

Chart of Accounts

Class Codes

Classified Statements
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Clearing Exchange Gain or Loss
Close to Segment / Account
Closing Account

Closing Period

Closing the Books
Common Stock

Company Database
Company Desktop
Company Profile
Compensatory Time
Completed Project accounting method
Consolidated Batch

Control Account

Control Account for Subledgers
Conversion Rate
Corporation

Cost Accounting

Cost Center Overrides

Cost Center Segments
Cost of Goods Manufactured
Cost of Goods Sold

Cost Plus project

CPRS

Credit

Currencies

Currency Rate Type
Currency Rates

Currency Table

Current Assets

Current Liabilities

Custom (and Local) Taxes
Customization Directory
Customize User Interface
Database

Database ID

Date Matching

Debit

Decimal Places for Quantity
Deduction

Default Closing Account
Default Currency

Default Hours

Default Rate Type

Default Source Code
Defining a Source Journal
Defining Meaningful Account Number Segments
Delimiter Character
Depreciation

Detail and Consolidated Posting Options
Detailed Batch

Details

Direct Labor Costs
Distribution Accounts
Distribution Code
Distribution Set

Dividend

Drilldown
Earning/Deduction
Earning/Deduction Frequencies
Earnings

Edit Imported Entries
Effective Date

Employee History
Employee Level Security
Employee Selection List
EMU

Equity

Euro Conversion Rates
Euro Currency

Euro Option

Exchange Gain or Loss
Exchange Rate

Expense Reimbursement
Expenses

Exporting
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Factory Overhead

Federal and State Taxes
Field

Financial Statements
Finder

Fiscal Calendar

Fiscal Periods

Fiscal Sets

Fiscal Year

Fixed Assets

Fixed Price project

FOB Point

Force Listing of Batches
Foreign-currency Bank
Functional Currency
Functional Currency Code
Functional-Currency Equivalent
Future Order

G/L Batch

G/L Options -- Account tab
G/L Options -- Company tab
General Ledger Account
Gross Pay

Gross Profit on Sales
History

Imported Account Data
Imported Batches
Importing

Income

Income Statement
Information in G/L Accounts
Integration Access Pack
Integrity Check

Inventory

Invoice Type

Journal

Journal Entry

Labor Hours Percentage Complete accounting method
LanPak

Last Run Date

Last Year Information
Ledger

Level

Liabilities

Local and Other Custom Taxes
Lock Budget Sets (1-5)
Long-Term Liabilities
Lookup Table

Macro

Maintain Quantities Options
Manual Check

Matching Concept

Menu Bar

Miscellaneous Charge
Multicurrency Accounting
Multicurrency Bank
Multicurrency Fiscal Sets
Multicurrency G/L Accounts
Multicurrency G/L Option
Net Pay

No Users

Normal (Account) Balance
Number of Fiscal Periods
Optional Fields

Original Invoice

Override Segments
Overtime Rate Multiplier
Overtime Schedule

Owner Equity

Partnership

Pay Factors

Payroll Class Codes
Payroll Distribution Accounts
Period Minimum and Period Maximum
Periods Per Year
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Picking Slip

Post in Specified/All Currencies
Posting

Posting Statistics

Posting tab in G/L Options
Preferred Stock

Prepaid Expenses

Price List

Printing Scheduled Reports
Printing Source Journal Definitions
Profile ID

Profit

Profit and Loss Statement
Profit Center

Programs (Applications)
Project Percentage Complete accounting method
Project Type

Provisional Fiscal Sets
Provisional Posting
Provisional Posting Journal
Quantities in G/L Accounts
Quantity Fiscal Sets
Quarter With 4 Periods
Quote

Rate Operation

Rate Type

Rates

Realization

Realized Exchange Gain or Loss
Reallocation Account
Recognized Exchange Gain or Loss
Reconcile (Bank)

Record

Record of Employment
Recurring Transaction
Remit-to Location
Repayment Deduction
Reported Tips

Reporting Currency
Restart Record

Retainage Accounting
Retainage Invoice
Retained Earnings
Revaluation

Revaluation Codes
Revenues

Reversed Unrealized Exchange Gain or Loss
Salary and Wages

Salary and Wages Payable Account
Sales

Sales Table

Sample Account Segments
Schedule Code

Schedule Reports
Schedule Transactions
Script

Security Group

Segment Codes Validation
Selection List

Service Years

Services

Session Date

Settlement Rate

Settling Transactions
Shareholders
Shareholders' Equity

Shift Differential Rate

Shift Differential Schedule
Ship-Via Code

Sick Time

Sole Trader

Source Codes

Source Currency

Source Document

Source Journal Profiles
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Source Journals and Consolidated Transactions
Specific User

Spread

Standard Project style

Standing Order

Statement of Retained Earnings
Status

Stock

Subsidiary Ledger

Surtax Multiplier

Suspense Account

System Database

Tax Authorities

Tax Classes

Tax Groups

Tax Tables

Template (employee setup)
Time And Materials projects
Timecards

Tip Disbursement

Total Cost Percentage Complete accounting method
Transaction Rate Type

Trial Balance

Type

Ul Profile ID

Ul Profile Maintenance
Unrealized Exchange Gain or Loss
User Authorization

User Record

Vacation Time

Wage Bracket Table

Wage Garnishment

Web Desktop

Withdrawal

Workers' Compensation Code
Worksheet

Years of Fiscal Sets

Years of Transaction Detail
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What's New in Project and Job Costing 5.6

With this version, we are pleased to introduce several new features that
you have asked for!

Project and Job Costing 5.6A now lets you:

®[}] pisplay projects and categories quickly in the Contract Maintenance form.

For information on using the new search feature, see quick project and category

Search.

®[}] print Revenue Recognition Worksheets and Billing Worksheets.

For information on printing worksheets, see worksheets Report.

®[}] Take advantage of fully integrated Serialized Inventory and Lot Tracking.

For information on allocating and generating serial and lot numbers in
material transactions, SEE€ Allocating Serial and Lot Numbers in Material Transactions - Overview.

®[t] print reports of serial and lot numbers assigned to jobs in Project and Job Costing.

For information on printing these reports, See serials and Lots Report.
See also

Changes Introduced in Project and Job Costing 5.5
Changes Introduced in Project and Job Costing 5.4
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What's New in Project and Job Costing

Project and Job Costing 5.5A introduced many exciting new features. In
summary, this version let you:

®[}] Assign different customers to projects in a contract.

e\When using the New Contract Wizard to copy an existing contract,

choose whether to copy project customers from the existing contract or to use the new contract customer as the

default for all projects.

®[}] |nvoice different customers than the project customer.

(] Take advantage of I/C unit of measure conversion factors WHen prOCGSSing jOb'related
material transactions in other Sage ERP Accpac programs.

®[}] Specify a source for the default billing rate used for projects.

o] set up billing rates in a variety of currencies, if you use mUltiClJrrency.

®[}] Use billing rates from price lists when entering material usage and material return transactions.

®[}] Use billing rates from price lists when setting up revenue estimates for material on standard projects.

®[}] Use the I/C cost for an item when setting up cost estimates for material on standard projects.

®[] Choose whether to update the payroll expense and employee expense accounts used on PJC timecards when

you update Canadian or US Payroll.

®[] Use Sage ERP Accpac Serialized Inventory and Lot Tracking to track material transactions.

eFor projects that use item invoices (except those using the accrual-
basis accou nting methOd), [] choose to recognize only costs that you have billed on a billing
worksheet, fOr Which you have posted the invoices in Accounts
Receivable.

®[}] process employee expenses using non-labor categories that are consistent with the expense code.

o[l specify a posting date fOr all transactions (including worksheets), and specify
the type of date to use as the default posting date in transaction entry
forms. (This change is consistent with improvements in other Sage
ERP Accpac applications.)

eChange the A/R account set used on invoices you generate for
Accounts Receivable. Project and Job Costing uses the A/R account
set specified for the contract project as the default.
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*Change the work in progress account in transactions for all projects
that use an item invoice type.

1] Choose whether to update Budget Maintenance When YOU pProcess transactions.
(Processing is much faster if you do not update budgets!)

¢Drill down from an Accounts Receivable invoice to the billing
worksheet in Project and Job Costing.

In addition, Project and Job Costing version 5.5 is fully integrated with
Sage ERP Accpac Order Entry 5.5, and it now:

el ets you SpeCify [}l default selections for miscellaneous charges you process in Order Entry.

eAccepts costs from job-related shipments and from invoices for
certain projects that you post in Order Entry.

eAccepts original estimates that you create when you post job-related
guotes in Order Entry.

See also:

Changes Introduced in Project and Job Costing 5.4
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Changes Introduced in Project and Job Costing

5.4

Project and Job Costing 5.4A introduced the following new features:

Contract Maintenance

eYou can enter contact information for a Contract customer.

eYOu can generate item or summary invoices for fixed price projects
that use a billings and costs or accrual-basis accounting method. In
earlier versions, you could produce only summary invoices for fixed
price projects. You set the A/R invoice type on the Project tab of the
Project Maintenance form (in Contract Maintenance).

eYou set a basic or standard style for projects. The contract style now
functions as the default setting for projects you add to the contract. In
previous versions, you set the style only at the contract level.

eYou can change the tax group for each project within a contract. You
can specify a default tax group for a contract. and either accept or
change the tax group for each project within the contract.

eFor fixed price projects that use a billings and costs or accrual-basis
accounting method and an item invoice type, you can change the tax
classes in the Equipment Usage, Material Usage, Material Return,
and Timecard transaction-entry forms (as for time and materials
projects).

eYou can add a new category or resource to a project at any time.
Previously, if you wanted to add a category or a resource to an open
project, you had to post the change using a revise estimate
transaction. You now give permission to add a category and resource
by assigning a new security authorization "Add a New Category And
Resource " to a user.

GIL Integration

eThe G/L Integration form was new in version 5.4. It includes all the
G/L integration fields that used to be contained on the Integration tab



of the PJC Options form in previous versions.

eThe option Append G/L Transactions To Existing Batch was renamed
Create G/L Transactions By. The option provides a third choice,
Creating And Posting A New Batch, to create and automatically post a
new batch in General Ledger.

eThe Transactions tab of the G/L Integration form lets you specify the
type of information from PJC transactions to use for the entry
description, detail reference, and detail comment field in G/L
transactions.

AIR Integration

eThe Integration tab of the Options form contains options exclusively
for integration with Accounts Receivable. It lets you choose to post an
invoice batch in Accounts Receivable automatically when you post a
billing worksheet in Project and Job Costing.

Payroll Integration

eYOu can post job-related timecards directly from US or Canadian
Payroll. Actuals are updated when you print the payroll checks.

eYou can set up records in Project and Job Costing for employees from
US or Canadian Payroll, or both payroll programs, if you use them.
You can also set up employee records solely for Project and Job
Costing (using the payroll type None).

eYou can enter timecards in Project and Job Costing only for
employees whose currency matches the functional currency.

eTimecards you export to US or Canadian Payroll can include expense
accounts.

Costs

eYou can use the new Costs form to post miscellaneous cost
transactions to any project category, so you do not have to create a
vendor invoice in Accounts Payable.

Material Allocation



*A new Material Allocation form lets you track material usage
separately from material that is stored for a project. You enter material
allocation transactions to remove material resources from storage.
The Stored column on the Contract Maintenance form shows the
amount of material held in storage for a project.

Billing Worksheet

eThe Billing Worksheet form includes the tax reporting currency.

eYou can generate a billing worksheet for a fixed price project that uses
the completed project accounting method and has no cost
transactions. If a project's total cost is negative, Project and Job
Costing creates a credit note for Accounts Receivable.

Revenue Recognhnition

o|f you use the option Clearing Billings And WIP During Revenue
Recognition (in PJC Options), Revenue Recognition immediately
recognizes losses.

eRevenue recognition is much faster.

Integrity Checker

eYou can specify options for checking Project and Job Costing tables
and data.

eThe program checks for closed or completed projects used in
unposted job-related transactions in other programs.

Post Transactions

eYOu can choose to post transactions with a certain status.

Transaction History

eThe Transaction History form contains a new Application field that lets
you restrict the display to transactions that originated in an application

you specify.
AlA Report



eYou can print the Architect's Certificate for Payment documents, G702
and G703, using the AIA Report form (located in the PJC Analytical
Reports folder).
Committed Costs Audit Report

*A new Committed Costs Audit Report tracks changes to commitments
effected by Purchase Orders and Accounts Payable transactions.
(Expensed and allocated tax amounts on the retainage portion of
invoices may be commitments, depending on your settings for the
Report Tax options in Accounts Payable and Tax Services.)

Security

eYou must explicitly allow a user to view setup forms. Previously, a

user having only timecard-entry authorization could see setup forms.
Opening Balances

eYou can enter opening balances for stored material.

Cost Plus Projects

eYOu can enter a negative percentage for cost plus projects, or set up a
project where estimated revenue is less than estimated cost.

Transaction Detail Report

eYou can include opening balance transactions on the Transaction
Detail report, strengthening the audit trail to your actuals.



Options Form Field List

For help with the options and fields on the Options form, click the
keywords listed below:

[}l contact Name, Fax Number, and Telephone

Settings Tab

[ Adqing Periods

[}l Default A/R Item Number

[}l Default A/R Unit of Measure

[}l Default Accounting Method

[}l Default Contract Style

[}l Default Labor Type

[}l Default Overhead Type

[}l Force Listing of Transactions

[}l Labor Rate/Percentage

[l Level 1 Name, Level 2 Name, Level 3 Name, and plurals
[}l only Recognize Costs When Billed For Item Invoice Type Project
[}l overhead Rate/Percentage

[}l percentage Complete Method

[ Update Budgets
[}l Update Payroll/Use Expense Accounts

Segments Tab

[}l Default Contract Structure (code and description)
[ Length

[ Segment Name

[}l segment No. (Number)

[ Separator

Ll use

[t validate

Transactions Tab
[ Billing Rate (Timecard default)
[}l Default Posting Date

[ Length
[}l Next Posting Sequence (dISpIay Only)

[t prefix and Next Number
[} Unit Cost (Timecard default)

Integration Tab

[l A/R Invoice Comment Field
[l A/R Invoice Description Field
[}l create AIR Batches By
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G/L Integration Fields

Integration tab

[}l consolidate G/L Batches
[}l Create G/L Transactions By
[}l create GI/L Transactions During Posting/On Request Using Create G/L Batch Icon

[}l posting Sequence and Posting Sequence No. (Number)
[}l Source Codes

Transactions tab
[l G/L Detail Comment

[}l G/L Detail Description

[l G/L Detail Reference

[}l G/L Entry Description

[] Transaction Type

GIL Integration Detail (Select a transaction type, then click Open.)

[}l Choose Segments From List
| Example

[}l G/L Transaction Field

| Segment Separator

[}l Segments Currently Used

[ Transaction Type
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Importing and Exporting

Project and Job Costing can import a variety of data, including cost
transactions, contract estimates, and employees.

Sage ERP Accpac’s Import and Export commands let you transfer data
to and from remote Sage ERP Accpac programs and from non-Sage
ERP Accpac programs, enabling you to:

eImport setup information from a non-Sage ERP Accpac application.

elmport cost transactions created by non-Sage ERP Accpac programs
(for example, an inventory, accounts payable, or customized payroll
program that was not specifically designed for use with Sage ERP
Accpac Project and Job Costing).

eImport transaction batches from remote Sage ERP Accpac
subledgers.

eExport job-costing data to a spreadsheet for analysis.

For information about file formats, templates, and the steps you follow to
import and export data, see the System Manager help.

To see exactly how to format records for importing, we suggest that you
first export records from the sample data, specifying the format in which
you plan to import.

Experiment with Project and Job Costing and the sample data before
importing data to a “live” database. Back up your accounting data before
attempting to import. (See the System Manager help for information on
checking data integrity and making backups.)

Note: Incorrect importing may damage your data. Do not import
accounting data without appropriate manual accounting control and
verification procedures.



Exporting from Records with Multiple Tables

Project and Job Costing uses more than one database table to store
records for contracts and for all types of transactions, including revenue
recognition and billing.

If you are exporting any of these records, the Export dialog box shows a
list of the tables that you can export for the record after you select:

eThe export file type (for example, Excel 200, Single CSV File, and so
on) in the Type field, and

e The file to which to export the data, in the File field.

You select fields to export from the list that appears.



Import Options

Project and Job Costing lets you import records in three ways — Insert
And Update, Insert Only, and Update Only. Update Only updates existing
records without adding new ones. Insert Only adds new records without
changing existing records. Insert And Update adds new records and
updates those currently in the database.



Selecting Records for Export and Import

You can use the Set Criteria option to specify a range of records to
export. (For information on how to use this powerful selection tool, see
the help for the this option when using the Finder.)

You cannot use the Set Criteria option to select records to import from an
import file. You must import all records in an import file at the same time.



Errors During Importing

If importing stops due to errors, Project and Job Costing creates a restart
record which marks the point where importing stopped, identifies the
error condition by task, date, time, and user (the person performing the
task), and describes any action you need to take.

For information on restarting an import operation and on working with
restart records, see the System Manager help for Restart Maintenance.



Account Sets Field List

[}l Account Set Code
[ Billings

[ costs

[t cost of Sales

[ currency Code

] pescription

) Employee Expense

] Equipment
[ Labor

[}l overhead

L] payroll Expense
[}l Revenue
L] work In Progress
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Categories Form Field List

| Category
) Description

Category tab

LI cost Type

[ Labor Type

[}l Labor Rate/Labor Percentage

[}l overhead Rate/Overhead Percentage
] overhead Type

Default Settings for Basic Projects
| A/R Iltem Number

[t Billing Rate

[ currency Code and Description

& unit Cost

) Unit Of Measure

Integration tab

el Segment
[l G/L Segment Code
[t override G/L Account Segments

Optional Fields tab

[}l Optional Field and Description
[}l value and Description
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Charges Field List

B A/R Item No.

[ Billing Amount

[ Charge Code

] Charge Type

[ currency Code and Description
L] pescription

[ Inactive

[ Last Maintained (display only)

Optional Fields
[ Unit Of Measure
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Contract Structures Field List

[}l contract Structure (display only)

L] pescription
[ prefix

[}l segment Length (display onlv)
[t] segment Name

[} segment Separator

[} Structure Code

[} Total Length (display only)
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Cost Types Field List

[ cost Class
L] Cost Type Code

L] pescription
[ Inactive
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Employees Field List

| Employee
| Employee Number

[l Name
) Payroll Type

Employee tab

[ Billing Rate

[l comments

[}l currency Code and Description
[}l Default Hours

[ E-mail

| Earnings Code

| Group

[ Inactive

[}l Last Maintained (display only)
L) user ID

& unit Cost

Default Settings For Standard Projects tab
% A/R Iltem Number
Unit of Measure

Security tab

| Expense
L Time
[ visible

) Optional Fields tab
[}l Optional Field and Description
[}l value and Description
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Equipment Form Field List

] A/R Item No

[ Billing Rate

[ currency Code and Description
L] pescription

] Equipment Code

[ Inactive

[ Last Maintained (display only)
Optional Fields

L1 unit Cost

[ Unit Of Measure
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Miscellaneous Expense Field List

[l AR Item No
[

Billing Rate
[ currency Code and Description
L] pescription
[ Inactive
[ Last Maintained
[ Miscellaneous Code
Optional Fields
LI Unit Cost
[ Unit Of Measure
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Optional Fields Form Field List

L) Auto Insert

[}l Default Value and Description
[}l Optional Field and Description
[}l Optional Fields For

[ Required
[} value Set
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Overhead Expenses Field List

[l AR Item No
[

Billing Rate
[ currency Code and Description
L] pescription
[ Inactive
[ Last Maintained
Optional Fields
[t] overhead Code
LI Unit Cost
[ Unit Of Measure
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Projects Form Field List

| Project (code)
) Description

Project tab

[}l Accounting Method

[ Billing Type

[}l cost Plus Percentage

[ Inactive

[}l Last Maintained (display only)
[}l Markup Percentage

D] Project Type

Integration tab

el Segment
[l G/L Segment Code
[t override G/L Account Segments

Optional Fields tab

[}l Optional Field and Description
[}l value and Description
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Segment Codes Field List

[t] segment Name
[ Length (display only)

[t] segment Code
L] pescription
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Subcontractors Field List

[}l Address and contact fields
[}l contact's E-mail

| Description

[ Inactive

Optional Fields

[*] subcontractor Code

[}l Subcontractor Name

[}l vendor's E-mail

[}l vendor Number

Default Settings for Standard Projects
| A/R Iltem Number

[t Billing Rate

[ currency Code and Description

& unit Cost

) Unit Of Measure
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New Button s

Use the New button to begin adding a new record.



The Finder lets you search the various lists of codes maintained in the
Project and Job Costing database.

The Finder is active only in fields that display the Finder icon.

Note that the records that appear with the Finder are restricted by any
selection criteria you have applied to the field.

You can use Auto Search option in the Finder to locate a record quickly in
a long list. Select the Auto Search option and the criteria by which you
want to search, for example the letters in a customer name. Then, in the
space provided, begin typing the characters that start or are contained in
the field you are searching on, until the program displays the record you
need.

If you cannot find the record you are looking for using the Finder or the
navigation buttons, CheCk the Finder to see whether any criteria are being used
to limit the selection. If necessary, remove the selection criteria.

Keyboard:

E



Navigation Buttons «« o

Use the navigation buttons to display the first, previous, next, or last
entry.

If you cannot find the record you want, check whether any selection
criteria have been set in the Finder to limit the display. Choose the

Finder, then click the Set Criteria button to see or change the current
criteria.



Sage Accpac uses the Go button where you must fill in a number of
fields before the program can select a particular item. For example,
you select a customer number and ship-to location code, then click Go
to display the data in the Ship-To Locations form.

When you have made your selections, click the Go button or press F7
on your keyboard.

Ii]



Zoom ..

The Zoom button (or the F9 key) opens popup forms.
To return to the previous form, click the Close button or press the F9 key.
Keyboard:

E’



Use this command to print the report for the open form you are using.
For example:

eIn a report form, you can choose Print from the File menu or you can
click the Print button to print the report.

eIn a record, you choose Print from the File menu to print a list of
records of that type.

For further information about reports, see prject and Job Costing reports.




Printer Setup

Use this command to set up your printer. You can select the default
printer or a different one from the list of installed printer names.

For further information about printer options, see the Windows
documentation.



Customize

Use the Customize command to hide fields for a specific group of users.

When fields are hidden, data that would normally appear in the fields
cannot be printed.

For more information, see the Ul Profile Maintenance topic in the System
Manager help.



Use the Import command to transfer data from non-Sage ERP Accpac
programs to Project and Job Costing. Transferring this information to
Sage ERP Accpac is called importing.

One common use of the import commands is to import setup records or
transaction batches from other Sage ERP Accpac applications and non-
Sage ERP Accpac programs.

To import account information or transactions,
follow these general steps

1.Create the file you want to import. (To create a template for an import
file, export a few records of the type you want to import, selecting
Save Template and entering a name for the template file during the
export procedure.)

2.0pen the Project and Job costing form in which you maintain the data
you want to import.

3.Choose the Import command from the File menu.

4.Type or select the file name and file type in the form that appears
next.

If you previously created a template for importing, choose the Load
Template button, then select the template file.

5.Choose the fields that you want to import and select from any other
options that appear. (You can save your choices as a template for the
next time you import records.)

6.Click OK to begin importing.

I:E' Related Topics
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Project and Job Costing lets you export data such as batches of
transactions to files that can be read and used by other programs.
Transferring this information from Sage ERP Accpac databases is called
exporting.

To export Project and Job Costing information,
follow these general steps

1.0Open the form that displays the kind of data that you want to export.
2.1f necessary, create the records you want to export.
3.Choose the Export command from the File menu.

4.In the form that subsequently appears, select the type of information
to export, or choose Load Template to use an export template you
created previously that matches the information you want to export.

5.To limit the range of records to export, use Set Criteria.
6.Click OK.

7.In the next form, enter the export file name and file type. If you
frequently export information with these specifications, use the Save
Script button to create an export template that you can use next time
you export the data.

8.When ready, choose OK to begin exporting.

If you specified a non-existent folder and file, the program asks
whether to create them.

I:E' Related Topics
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Close

Use this button to close a form.

If you are editing a record and have not saved your changes, Sage ERP
Accpac will ask you whether you want to save your changes or cancel
them.

Shortcut keys: Alt + F4



New Contract Wizard

The New Contract wizard helps you set up a new contract efficiently by
letting you quickly:

®[3] Select an existing contract to use as a template when creating the new contract. YOU do not have to
use a template, however.

eChoose whether to @ copy project customers from the existing contract projects to the new projects.

eFormat the new contract number. You use the Contract Number tab to
select a structure code and to identify each segment of the contract
number.

eChoose the style for the new contract.

*Choose whether to use the same optional fields as the existing
contract (if you are using a template), the program default optional
fields, or no optional fields in the new contract.

To use the New Contract wizard, click the Zoom button () beside the
Contract field on the Contract Maintenance form, then follow the
instructions in the wizard.

When you click Finish, the program returns you to the Contract tab of the
Contract Maintenance form, which then displays the contract number and
structure code you entered, as well as the settings, projects, and
categories from the template, if you specified an existing contract.

I:E' Related Topics
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Contract Maintenance Form Field List

[}l contract (number) and New Contract wizard
[}l contract Status

[ Description

@ search (fields and button)

Contract tab

[l Account Set

[ A/R Account Set

[}l Accounting Method

[}l Allow Multiple Customers

[t Billing Type

[l comment

[}l contact Information

[t contract Manager

] contract Style

[t Closed Date

[}l cost Plus / Markup Percentage
[l customer Number

[} Invoice to Multiple Customers
[}l Labor Rate/Labor Percentage
[ Labor Type

[ Last Maintained

[ Original End Date

] overhead Type

[}l overhead Rate/Overhead Percentage
[ Project Type

[t Projected End Date

L Start Date

[ structure Code

[ Tax Group

Projects tab

[}l A/R Retainage Percentage

[}l A/R Retention Period

[ Actual Quantity

[}l Actual Revenue

[}l Accounting Method

[t Billing Type

[ Billings (Account) and Description
[t Closed to Billings

[} Closed to Costs

[l committed P/O Total Cost

[}l cost Of Sales (Account) and Description
[t cost Plus (Markup) Percentage
[ current Quantity

[ current Revenue

[}l Default Billing Rate

[ Line Number

[}l o/E Miscellaneous Charges

[ Optional Fields

[ Original Quantity

[ Original Cost

[ Original Revenue

[ P/O Number
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[t Project and Description

[ Project Status

[ Project Style

[ Project Type

[t Projected End Date

[t projected Start Date

[}] Retainage Payable

[}l Retainage Receivable

[}l Revenue (Account) and Description

[}] work In Progress (Account) and Description

[ Optional Fields tab

[t Totals tab
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Category Maintenance Form — Overview

The Category Maintenance form lets you assign the cost categories you
will use to track costs for a selected project.

For each category you assign to a project, you use the Category
Maintenance form to specify:

eThe overhead type and the labor type, along with an associated
percentage or flat rate for each type.

eThe cost plus percentage, on fixed price and cost plus projects.

eThe expense accounts to use for payroll, employee, equipment, labor
burden, and overhead expenses accumulated.

eFor basic projects, you also use the Category Maintenance form to
enter your estimate Of the estimated quantity, unit of measure, unit cost,
billing rate, and total revenue for each category.

If you use retainage accounting, you also specify whether to use
retainage options from the vendor record or from the project category as
defaults for job-related transactions that you process in Accounts
Payable. If you select the option to use retainage options for the
category, you specify a retainage percentage and retention period for the
category.

You can add a new project category at any time. To change a category
that you have added to an open project, however, you must use the
Revise Estimates form.

To assign a new category to a project
1.Expand the project on the wee, then right-click the Category folder.
2.Choose New Category.

Note that you can assign only categories that you previously set up using
the Categories form in the PJC Setup folder.

To view an existing category
1.Expand the project on the tree.
2.Expand the Category folder.
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3.Click the category you want to display.

The program displays the category in the Category Maintenance form, in
the right-hand panel.

You can also select a category on the categoriesist, then click the Estimates
button to view the category in a separate Category Maintenance form.

For information about a field, click the Field List button at the top of this
page.
For help on using a specific tab, click the corresponding button, below:

I:E' Estimates

I:E' Accounts

I:E' Retainage

I:E' Transactions
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LTE‘ Optional Fields

I:E' Related Topics
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Project Maintenance Form — Overview

Like the Project tab on the Contract Maintenance form, the Project
Maintenance form lets you add projects to a contract. The advantage of
the Project Maintenance form is that it displays all the fields for a single

project, and you do not have to scroll to view all the information for a
project.

The Project Maintenance form also includes additional tabs that contain
information not provided on the Contract Maintenance form. Click one of

the buttons below for information about the corresponding tab on the
Project Maintenance form:

I:E' _Project

I:E' _Taxes

I:E' _Totals
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I:E' _Employee

I:E' Miscellaneous

I:E' Overhead

I:E' Equipment

I:E' _Subcontractor
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I:E' Material

LTE‘ Activity

I:E' Optional Fields
To display the Project Maintenance form, do one of the following:

eSelect a project on the Project tab of the Contract Maintenance form,
then click the Detail button.

¢Click the project on the tree. (If you have not yet added a project,
right-click the contract on the tree, then click New Project.)

I:E' Related Topics
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[Resource] Category Maintenance Form

For each category you assign to a project resource, Project and Job
Costing provides a category maintenance form specific to the resource.

Each resource Category Maintenance form includes an Estimates tab
that shows both the original and the revised estimates, the actuals, and
the committed costs for the selected resource.

ATransactions tab &lSO appears for Employee categories. The Transactions tab
lets you specify the source for the default unit cost (for PJC employees)
and the billing rate when you use the category on the selected
employee's timecards.

While a project has an Estimate status you can:
eAdd new categories for a selected resource.

eFor time and materials projects, if the project and category are both
billable, change the billing type for the resource category.

eEnter your estimate of the quantity, unit cost, and cost plus
percentage required for each resource category, as well as the
revenue you expect the resource to generate.

eEnter a projected start date and a projected end date for the resource
category.

When a project is open, you can specify the current start date and the
current end date for the resource category.

I:E' Related Topics
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Resource Maintenance Form — Overview

The Resource Maintenance form is available on standard projects. It lets
you assign resources to a project, and it provides a convenient summary
of the cost of a particular project resource and the revenue and profit the
resource has generated to date.

You use the Resource Maintenance form to:
eAssign specific resources to a project that has an Estimate status.
eSet cost and revenue estimates for project resources.

*View information about a particular resource, once the project is open
and you have begun to process transactions for the resource.

*Open a form that lets you view the estimate for a selected resource
category.

You can add a new resource at any time. To change a resource that you
have added to an open project, however, you must use the Revise
Estimates form.

To assign a new resource to a project:

1.Expand the project on the wee, then right-click the folder for the
resource you want to assign.

2.Click New [Resource] on the menu that appears.

3.Assiqn categories to the resource, and set estimates for each resource category.

Note that you can assign only resources that you previously set up using
the associated resource setup form in the PJC Setup folder.

To view an existing resource:
1.Expand the project on the tree.

2.Expand the folder for the type of resource you want to view (for
example, Employee or Equipment).

3.Click the particular resource you have assigned to the project (for
example, employee number 44652).

The program displays the selected resource in the Resource
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Maintenance form, in the right-hand panel.

4.To view or edit the estimate for a resource category, expand the folder
for the selected resource on the tree, then click the resource category.
(You can also select the subcategory on the Resource Maintenance

Categories tab, then click the Detail button to view the estimate in a
separate form.)

You can also select a resource on the project Resource List, then click the Detall
button to view the resource in a separate Resource Maintenance form.

For information about a field, use the Field List button at the top of this
page.

Click one of the buttons below for information about the corresponding
tab on the Resource Maintenance form:

I:E' _Estimates

I:E' _Categories

I:E' Optional Fields
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Contract Maintenance Form — Project Tab

The Project tab on the Contract Maintenance form lets you:
eView a list of the projects you have added to a contract.

The Project tab lists each project, along with its description, start date,
projected end date, current end date, date closed, accounting
method, project type, cost plus or markup percentage, whether the
project is closed to billings or project costs, project status, billing type,
general ledger accounts, and PO number.

*Add projects to a selected contract.

.Open a Separate Project Maintenance form, where you Can view summary

information for the project, including project and resource totals. You

can also use the Project Maintenance form to add projects to the
contract.

*eOpen separate forms that let you add categories and (on standard
contacts) resources to selected projects.

Click one of the buttons below for information about another tab on the
Contract Maintenance form.

I:E' Contract

I:E' Optional Fields
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I:E' Related Topics


javascript:mc166.Click()
javascript:mc167.Click()

Contract Maintenance Form — Contract

Tab

You use the Contract tab of the Contract Maintenance form to define
general settings for a contract, including the structure code, account set,
customer number, contract manager, contact information for the
customer, as well as the start and end dates that represent the duration
of the contract.

You can also use this tab to define default settings for any projects that
you add to the contract. If you choose not specify default settings for all
the projects related to the contract, Project and Job Costing uses the
default settings from the individual project records.

If you use the New contract wizard t0 S€t UP @ Nnew contract, particularly if you
copy an existing contract, many of the fields on this tab will be filled in for
you. You should review the settings, and change your selections for the
new contract, as necessary. You cannot change the customer number or
the contract style, however.

Once you add the contract record, you cannot change the structure code.

Click one of the buttons below for information about another tab on the
Contract Maintenance form.

I:E' Project

I:E' Optional Fields
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I:E' Totals
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Revise Estimates Field List

[}l Reference

[}l Revise Estimate Number
[t status

[ Transaction Date

[ Year/Period

Detail Revise Estimates
L] category

[l comments

[t contract

[t current Estimate

[}l Description (transaction header)
[] pescription (detail)

[l Exchange Rate

[} Fixed Price Amount

[ Line Number

[ project

[} Rate Date and Rate Type

[}l Resource

[t Revised
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Assigning Optional Fields to Contracts

Once you have defined optional fields for contracts and setup records,
you can assign the optional fields to your contracts.

Optional fields that are set up for automatic insertion on contracts appear
on the Optional Fields tabs of the Contract Maintenance form when you
add a new contract. You can add, edit, and delete optional fields for
particular contracts, as necessary.

You can also assign optional fields to each project, category, and
resource used in a contract. You use the Optional Fields tabs for the
Project Maintenance, Category Maintenance, and resource maintenance
forms to view or edit optional fields for selected projects, categories, or
resources.

You can edit or delete any automatically inserted optional fields, and you
can add different optional fields that you have defined for contracts,
projects, categories, and resources.

Default entries appear for optional fields used in contracts, as follows:

eOptional fields assigned to specific projects and categories appear as
defaults when you add the projects and categories to a new contract.

eOptional fields assigned to specific resources appear as defaults for
project resources, except as follows:

o Payroll optional field entries appear as defaults for employees, if
you set up the same optional fields for employees in Project and
Job Costing as used in the US or Canadian Payroll employee
record.

o If Accounts Payable vendor optional fields match the Project and
Job Costing subcontractor optional fields, the vendor optional field
entries appear as defaults for the subcontractor.

o  If you use Inventory Control, if the optional fields for the Inventory
Control item match the optional fields you defined for Project and
Job Costing material, the optional field entries from Inventory
Control appear as defaults when you add a material resource.

The Optional Fields column on the Project tab of the Contract



Maintenance form shows whether optional fields are assigned to
particular projects. Similarly, Optional Fields columns on the Project
Categories list and on the resource lists show whether optional fields are
assigned to any project categories or resources.

I:E' Related Topics
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Opening Balances Field List

[ Description
] Document Number

[}l Reference

[t status

[t Transaction Date
[ Year/Period

Detail Opening Balance form

[ Category

[t contract

[ Opening Type
[ Project

[}l Resource

Actuals fields

[t Actual A/R Unit of Measure

[}l Actual Billing Rate (Source Currency)

[}l Actual Extended Cost

[}l Actual Labor Amount

[}l Actual Labor % / Labor Rate

[}l Actual Overhead Amount

[}l Actual Overhead % / Overhead Rate

[ Actual Quantity

[}l Actual Total Cost (Functional Currency)
[}l Actual Total Revenue (Functional Currency)
[}l Actual Total Revenue (Source Currency)
[}l Actual Total Profit (Functional Currency)
[}l Actual Total Profit (Source Currency)

[ Actual Type

[}] Remaining To Be Billed Total Revenue

Activity fields

[}l Last A/P Payment Posting Date

[}l Last AIR Receipt Posting Date

[} Last Billings Posting Date

[}l Last Cost Posting Date

[}l Last O/E Invoice Date

[ Last O/E Shipment Date

[}l Last Purchase Order Date

[}l Last P/O Receipt Date

[}l Last P/O Return Date

[}l Last [Canadian/US] Payroll Date

[}l Last Revise Estimates Posting Date

[}l Total A/P Vendor Payments (Functional Currency)
[*] Total AIR Customer Receipts (Source Currency)

Stored fields

[}l Extended Cost

[}l overhead Amount

[}l payment Due (from AIA Certificate for Payment)

[ Quantity

[}l Retainage Amount (from AIA Certificate for Payment)
[}l Stored Amount (from AIA Certificate for Payment)

L Total Cost

[ Total Revenue

[t] Use AIA Report

[}l work Completed (from AIA Certificate for Payment)
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Update Retainage Field List

[} Retainage Number
[] Retainage Type

[ status

[ Transaction Date
[ Year/Period

Details

L] category
[l comment

[t contract

| Currency

[l Original Document Number
[ project

[} Retainage Invoice Amount
[] Retainage Payable

[] Retainage Receivable
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Serial/Lot Numbers Allocation / Generation

Form

If you have a license to use Serialized Inventory and Lot Tracking, you
can allocate serial numbers and lot numbers to material that you use on a
job and to material that you return to inventory from a job.

Inventory Control maintains serial numbers and lot numbers by location
for serialized and lotted items.

You allocate these numbers in Project and Job Costing when you enter
material usage and material return transactions for serialized or lotted
items.

The SeriallLot Numbers Allocation form appears when you enter a
quantity for a serialized or lotted item in the Material Usage form, and
then press the Tab key or click the Zoom button.

The SeriallLot Numbers Generation form appears when you enter a
guantity for a serialized or lotted item in the Material Returns form. It lets
you identify existing serial numbers and lot numbers, or generate new
numbers, for an item that you are returning to inventory.

These forms can display one or both of the following tabs, depending on
whether the item is serialized or lotted, or both. For information on these
tabs, click the following links:

® Serial/Lot Numbers Allocation / Generation - Serials Tab

® Serial/Lot Numbers Allocation / Generation - Lots Tab

See also

Allocating Serial Numbers in Material Transactions - Overview
Allocate Serial Numbers in Material Return Transactions
Allocate Serial Numbers in Material Usage Transactions
Allocate Lot Numbers in Material Returns Transactions
Allocate Lot Numbers in Material Usage Transactions




Lot Numbers

Lot numbers are used for tracking stock from the point of receipt through
to the point of sale, and can be used to track returned items from the
customer and back to the vendor. For example, a food distribution
company can use lot numbers to record purchases and sales of unique
lots.

Some industries, such as pharmaceuticals and meat-packing, are legally
required to track the items that they purchase, manufacture, and ship.

Unlike serial numbers, many different items can share the same lot
number.



Adjustments Field List

[l Adjustment Number

| Description
| Optional Fields

[}l Reference

[t status

[t Transaction Date
[ Year/Period

Adjustment Details
D] Adjustment Type

| A/R Iltem Number

[}l A/R Unit of Measure

| Billing Currency

[ Billing Rate

[t Billing Type

| [Original] Category

| [Original] Contract

[t cost Class (display)

[l customer Number (display)
[l Document No.

] Document Type

| Employee No.

| Earnings Code

| Expense Code

[}l Extended Billing Amount
[}l Extended Cost

| 1/C Bucket Type

[t 1/C Document Number

[} 1/C Transaction Date (display only)
[t 1/C Location (display only)
[} 1/C Unit Of Measure

[}l Labor Amount

[t Labor Rate / % (display only)
| Line Number

| [Original] Project

| Optional Fields

| Original Employee No.

[}l overhead Amount

[}l overhead Rate / % (display only)
| Quantity

| [Original] Resource

[t Revised Category

[}l Revised Contract

[}l Revised Employee No.

[t Revised Project

[}l Revised Resource

| Total Amount

[}l Transaction Date (Detail)
& unit Cost
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Budget Maintenance Field List

[ Budget Method

[ pudget Set Lookup fields (Contract, Project, Category, Budget Set, Year)
| Budget Set /Year

[ calculation Method

[ contract / Project / Category

[} Quantity / Cost / Revenue

[ Rate/Rate Date/Rate Type

L) show
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Charges Field List

| Charge Number

| Description

| Optional Fields

[}l Reference

[t status

[}l Total Billable Amount
[t Transaction Date

[ Year/Period

Detail Charges/Taxes
| A/R Iltem Number

| Billing Amount

[ Billing Type

| Category

| Charge Code

[l comments

[t contract

| Line Number

| Optional Fields

| Project

[}l Resource

[}l Tax Authority and Description
[}l Tax Class and Description

| Tax Included

) Unit of Measure
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Costs Field List

| Description
] Document Number

| Optional Fields

[}l Reference

[t status

[}l Total Billable Amount
L Total Cost

| Total Quantity

[t Transaction Date

[ Year/Period

Detalils

[l A/R Item Number and Description
[l A/R Unit of Measure

| Billing Amount

| Billing Currency

[ Billing Rate

[ Billing Type

| Category

[l comments

[t contract

[}l cost Account and Description
L] Cost Class

[}l cost Of Sales Account

[}l Extended Cost

| Line Number

| Optional Fields

| Project

| Quantity

[}l Resource and Description

& unit Cost

[}l Tax Authority and Description
[}l Tax Class and Description

| Tax Included

[l work In Progress Account
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Equipment Usage Field List

| Description

| Equipment Number
| Optional Fields

[}l Reference
[t status
[}l Total Billable Amount

& Total Cost

| Total Quantity

[t Transaction Date
[ Year/Period

Detail Equipment Usagel/Taxes
| A/R Iltem Number

[ Billing Rate

[ Billing Type

| Category

[l comments

[t contract

[}l cost Of Sales Account

| Equipment Account

| Equipment Code

[}l Extended Billing Amount
[}l Extended Cost

| Line Number

| Optional Fields

| Project

| Quantity

[}l Tax Authority and Description
[}l Tax Class and Description
| Tax Included

& unit Cost

| Unit of Measure

[l work In Progress Account
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Material Returns Field List

| Description
[}l Material Return Number

| Optional Fields

[}l Reference

[t status

[}l Total Billable Amount
L Total Cost

| Total Quantity

[t Transaction Date

[ Year/Period

Detail Material Returns/Taxes
| A/R Iltem Number

[}l A/R Unit of Measure

[ Billing Rate

[ Billing Type

| Category

[l comments

[t contract

[}l cost Of Sales Account

[}l Extended Billing Amount
[}l Extended Cost

| Inventory Control Account
| Iltem Number

[} jtem Unit of Measure

| Line Number

[t Location

[ Price List

| Project

| Optional Fields

| Quantity

[}l Tax Authority and Description
[}l Tax Class and Description
| Tax Included

& unit Cost

[l work In Progress Account



javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);

Material Usage Field List

| Description
[}l Material Usage Number

| Optional Fields

[}l Reference

[t status

[}l Total Billable Amount
L Total Cost

| Total Quantity

[t Transaction Date

[ Year/Period

Detail Material Usage/Taxes
| A/R Iltem Number

[}l A/R Unit of Measure

[ Billing Rate

[ Billing Type

| Category

[l comments

[t contract

[}l cost Of Sales Account

[}l Extended Billing Amount
[}l Extended Cost

| Inventory Control Account
| Iltem Number

[} jtem Unit of Measure

| Line Number

[t Location

| Optional Fields

[ Price List

| Project

| Quantity

[}l Tax Authority and Description
[}l Tax Class and Description
| Tax Included

& unit Cost

[l work In Progress Account
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Material Allocation Field List

| Description
[}l Material Allocation Number

| Optional Fields
[}l Reference

[t status

[t Transaction Date
[ Year/Period

Detalils

[t Allocated Quantity

| (Allocated) UOM

[ Billing Rate

| Category

[l comments

[t contract

[}l Extended Allocated Cost
[}l Extended Billing Amount
| Iltem Number

[} jtem Unit of Measure

| Line Number

[t Location

| Optional Fields

[}l overhead Allocated

[}l percentage Allocated

| Project

[t stored Overhead

[t stored Quantity

[ (Stored) UOM
[*] Unit Cost
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Tracking Material Used on Projects

If you purchase material at the start of a project that spans several
months or years, you may need to track how much material you have set
aside for a project, how much of the material has been used to date, and
the costs of materials both stored and used.

Project and Job Costing produces transactions that distinguish between
stored and used material, and the resulting information is used for the aa

Report.

You use the waterial usage fOrm, for example, to transfer the cost of material to
a project. In Project and Job Costing, this material is considered “stored”
until you allocate it for use on the project. When you post a material
usage transaction, the program increases the actuals and the stored
amount for the project, category, and resource, depending on the project
type and accounting method (as for other types of transactions).

You can also assign material to a project by entering an Accounts
Payable transaction or a cost transaction, or record the return of items to
inventory using a Material Returns transaction.

You can use the wmaterial allocation form, @vailable in the PJC Transactions folder,
to reduce the stored amount as you use material for a project. (Note that
material allocation transactions do not affect actuals, and they do not
produce general ledger transactions.)

The Contract Maintenance form displays stored costs on the following
tabs:

eThe Totals tab on the Contract Maintenance form, proper, shows
stored costs for a selected contract.

eThe Totals tab on the Project Maintenance form shows stored costs
for a selected project.

eThe Material tab on the Project Maintenance form shows the stored
guantities and stored costs for a selected project.

material returns transactions also reduce stored quantities and costs.

All cost transactions posted for a material resource update the Stored
amount in a contract, regardless of whether a transaction is billable, non-



billable, or no charge. If you need to exclude non-billable and no-charge
transactions, you could set up separate categories for non-billable or no-
charge amounts. For example, you could set up Electrician, Electrician
Non-Billable, and Electrician No Charge.



Timecards Field List

| Description
| Employee Number

&) End Date

| Optional Fields
[}l Reference

L Start Date

[ status

[t Timecard Number
[}l Total Billable Amount
L Total Cost

| Total Hours

[t Transaction Date
[ Year/Period

Time tab
| Category

[t contract

| Line Number
| Project

& Total

Expense details
| A/R ltem No.

| Billing Amount

[t Billing Type

| Category

[l comments

[t contract

| Cost Amount

[}l cost Of Sales Account

| Employee Expense Account
| Expense Code

D] Expense Type

| Line Number

| Optional Fields

| Project

[}l Tax Authority/Tax Class/Tax Included
[t Transaction Date

| Unit of Measure

[t work In Progress Account

Time Detail tab/Detail Timecards form
| A/R ltem No.

[ Billing Rate

[t Billing Type

| Category

[l comments

[t contract

[}l cost Of Sales Account
| Earnings Code

& End Time

[}l Extended Billing Amount
[}l Extended Cost

L Hours

| Line Number

| Optional Fields

) Payroll Account
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[ Project

L] start Time

[}l Tax Authority/Tax Class/Tax Included
[t Transaction Date

& unit Cost

[ Unit of Measure

[l work In Progress Account
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Create Billing Worksheet Field list

[t create Invoices By

[ cutoff By

L] pescription

) Document Date

[ Include Customers On Hold

[ Include Contracts On Hold

[t Include Inactive Customers

[ Include Non-billable Transactions
[ Include Projects On Hold

[ Include Transactions On Hold

[ Include Zero Billed Fixed Price Projects
[ Invoice Type

[}] Retainage Exchange Rate

[] select By/Then By

[ Transaction Date

[t Year/Period (cutoff)

[ Year/Period
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Calculation of Percentage Complete

For projects using a percentage complete method, the first step in billing
calculation or revenue recognition is to determine the percentage
complete. This percentage is then used to calculate the revenue or billing
amounts.

The program calculates the percentage complete as of the specified
cutoff date or fiscal year and period using a cost-to-cost basis that is
consistent with the particular accounting method.

Total Cost Percentage Complete (see the total costs on the project
Totals tab)

Total
actual
project
% _ costs
Complete Total
estimated
project
costs

Labor Hours Percentage Complete (see the quantities on the project
Employee tab)

Total actual project

% _ labor hours
Complete

Total estimated project
labor hours

Category Percentage Complete (see the costs on the Estimates tab for
each category)

Actual costs for the

% _ category
Complete

Estimated costs for the
category

Project Percentage Complete (see the total costs on the project Totals



tab)

Total
actual
project
% — Ccosts
Complete Total
estimated
project

costs



Billing Worksheet Field List

| A/R Account Set
| Currency

[l customer

[l customer Name

| Description

] Document Amount
[l Document Date

| Exchange Rate

[ Invoice Type

| Line Number

| Optional Fields

L) Rate Date

L) Rate Type

| Tax Group

[}l Tax Reporting (Currency/Rate Type/Rate Date/Exchange Rate)
[}l worksheet Number
[ Year/Period

Details
| A/R Iltem Number
[l A/R Unit Of Measure
[}l Account Description
[}l Accounting Method
[ Billing Type
| Category
[l comment
[t contract
[l customer
| Description
] Document Number/Document Type
[}l Extended Amount (Functional)
[}l Extended Amount (Source)
| GI/L Account
] Module
| Optional Fields
| Percentage Complete
| Project
D] Project Type
| Quantity
[}l Resource
| Retainage Percentage
[}l Retention Period
[t status
[t Transaction Date
& unit Price
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Create Revenue Recognition Worksheet Field

List

[ cutoff By

L] cutoff Date

] pescription

[t Include Completed Projects (for Closing)
[} Include Contracts on Hold/Include Projects on Hold
[ Include Projects With No Costs

[ select By

[ Then By

] Worksheet Date

[}l worksheet Number

[t Year/Period

[t Year/Period (Cutoff)
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Revenue Recognition Worksheet Field List

[}l Accounting Method

L] category
[t contract

[}l contract Status

[ cutoff By

L] pescription

[ Line Number

[ Optional Fields

[ percentage Complete
[ project

[ project Status

[ project Type

] Worksheet Date

[}l worksheet Number
[ Year/Period
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Check, Edit, or Post a Revenue Recognition
Worksheet

Overview

[l Before you start
To review, edit, or post revenue recognition entries:

1.Choose Project and Job Costing > Periodic Processing > Revenue
Recognition> Revenue Recognition Worksheet.

Click here for help on the fields on the Revenue Recognition Worksheet form.

2.In the Worksheet Number field, select the worksheet you want to
review.

3.To change the posting date, click the Zoom button beside the
Year/Period field, then edit the Posting Date field in the Posting Date
Override form that appears.

4.To review the general ledger entry details for a selected contract,
project, and category:

Click the Details button.

b. To enter a new percentage complete, type the percentage in the
Percentage Complete field, then click Recalculate to display
recalculated amounts for the general ledger entry.

c. Click Close to return to the worksheet

5.1f you use optional ﬁeldS, [t review or edit the optional fields assigned to worksheet details.

6.When you have finished reviewing the entries, click Post.

7.1f any projects were marked Completed since the last time revenue
was recognized, confirm whether they should be closed when
prompted.

[ After adding ...

[}l Additional information

[l Related topics
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Create Reopen Projects Worksheet Field List

[t contract

L] pescription

[ From Project / To

[}l Reverse Entries for Completed Project Accounting Method Projects
] Worksheet Date

[}l worksheet Number

[ Year/Period
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Reopen Projects Worksheet Field List

[ Accounting Method
[t contract

L] pescription

[ Line Number

[] Optional Fields

[ project

[ project Type

] Worksheet Date

[ worksheet Number
[ Year/Period

GL Entry Details

[}l Account Description
[ Accounting Method
[ currency

[ (Functional) Debit
[ (Functional) Credit

Ll Rate

Ll Rate Date

L) Rate Type

[}l source Credit
[} source Debit
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Clear History Field List

[ Closed Contracts

[l committed Cost Audit

[ cutoff By

[ posted Documents

[] posting Errors

[ Printed Posting Journals

[ Through Posting Sequence Number
[} Transaction Date

[}l Transactions For Closed Contracts
[ Year/Period
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Synchronizing Start and End Dates for All Project

Levels

The Contract Maintenance form includes fields that let you specify
projected start and end dates and current start and end dates for
projects, resources, and resource categories.

If the project has an Estimate or Open status, you can easily assign to
resources and resource categories the same start and end dates that you
assign to the associated project. (If the project has an Estimate status,
you can set projected start and end dates for resources and categories. If
the project has an Open Status, you can set the current start and end
dates for resources and categories.)

To assign the same dates to projects, resources, and resource
categories:

1.Select a project on the tree.

2.0n the prOjeCt record, click the @ zoom (&) button beside the End Date field.
The Set Dates form opens.

3.The program displays the dates used for the project as defaults. You
can change the dates for the resources and categories, if necessary.

4.Click OK to update the start and end dates for all the resources and
categories in the project.


javascript:void(0);

Project Maintenance Form Field List

[ Description
[t Line Number

[ Project

Project tab

[l A/R Invoice Type
[l A/R Retainage Percentage

[}l A/R Retention Period
[l Account Set
[}l Accounting Method

[ Billing Type
[ Billings

[t Closed To Billings

[} Closed To Costs

[}l contact Information

[ Cost Of Sales

[}l cost Plus Percentage

[t current Start Date/End Date
[l customer

[}l customer Default

[ Date Closed

[}l Default Billing Rate

[} Invoice to Multiple Customers
[}l Markup Percentage

[}l o/E Miscellaneous Charges
[ PO Number

[ Project Status

[ Project Style

[ Project Type

[t Projected Start Date/End Date
[}l Revenue

[l work In Progress

Taxes tab

[}l customer Tax Class and Description
[}l Detail Tax Class and Description

[}l Tax Authority and Description

[ Tax Group

[ Tax Included

Totals tab

[ Actuals

[l committed

[t current Estimates

[}l Exchange Rate/Rate Date/Rate Type
[}l Extended Cost

[} Fixed Price Amount

[}l Labor Amount

[ Original Estimates

[ Original Exchange Rate/Rate Date/Rate Type
[}l overhead Amount

[ Recognized

[t stored

L Total Cost

[} Total Profit (Functional Currency)
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[}l Total Revenue (Functional Currency)

Employee tab
[ Actuals

[l committed

[ current Estimates
[}l Labor Amount

[ Original Estimates
[}l overhead Amount
[ Quantity

L Total Cost

[ Total Revenue

Miscellaneous tab
[ Actuals

[l committed

[t current Estimates

[ Original Estimates

[}l overhead Amount

[ Quantity

L Total Cost

[ Total Revenue

Overhead tab

[ Actuals

[l committed

[ current Estimates
[ Original Estimates
[}l overhead Amount
[ Quantity

L Total Cost

[ Total Revenue

Equipment tab
[ Actuals

[l committed

[ current Estimates

[ Original Estimates

[}l overhead Amount

[ Quantity

L Total Cost

[ Total Revenue

Subcontractor tab
[ Actuals

[l committed

[ current Estimates

[ Original Estimates

[}l overhead Amount

[ Quantity

L Total Cost

[ Total Revenue

Material tab
[ Actuals

[l committed

[t current Estimates
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[ Original Estimates
[}l overhead Amount
[ Quantity

[t stored

L Total Cost

[ Total Revenue

Activity tab

[ current Billings

[ Expected Billings

[}l Last A/P Payment Posting Date

[}l Last AIR Receipt Posting Date

[} Last Billings Percent Complete

[t Last Billings Posting Date

[}l Last [Canadian/US] Payroll Posting Date

[}l Last Cost Posting Date

[}l Last O/E Invoice Date

[ Last O/E Shipment Date

[}l Last Purchase Order Date

[}l Last P/O Receipt Date

[}l Last P/O Return Date

[}l Last Rev. (Revenue) Recognition Percentage
[}l Last Revenue Rec. (Recognition) Posting Date
[}l Last Revise Estimates Posting Date

[}] Retainage Payable

[}l Retainage Receivable

[}l Total A/P Vendor Payments

[} Total AIR Customer Receipts

[ Optional Fields tab
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Setting Project Dates

The Project Maintenance form includes fields that let you specify
projected start and end dates and current start and end dates for
projects, resources, and resource categories.

This facility helps you to schedule resources when they are required for
the project. If you use Microsoft Project to manage resources, you can
revise the dates in Microsoft Project, then use the wizard provided to
synchronize the dates in Sage ERP Accpac.

If the project has an Estimate or Open status, you can easily assign to
resources and resource categories the same start and end dates that you
assign to the associated project. (If the project has an Estimate status,
you can set projected start and end dates for resources and categories. If
the project has an Open Status, you can set the current start and end
dates for resources and categories.)

To assign the same dates to project resources and resource categories




Revising Estimates: Assigning a New Category

The Revise Estimates form lets you assign a new category to a selected
project. (If the category you need has not been assigned to the project, it

does not appear in the category Finder list when you enter a detail for a
revise estimate transaction.)

Note that the category must be set up for your system before you can
assign it to a project.

To assign a new category to the project:

1.0n the Revise Estimates form, click the New button beside the Revise
Estimates Number field.

2.Enter header information for the transaction as described in the
previous section.

3.In the Contract and Project fields, select the contract and project to
which you want to add the category.

4.Click the second Finder button next to the Category field.

5.Select (highlight) the required category from the list that appears, click
Select, and then click Close.

6.Click the Go button to display the fields for the category estimate.

7.Specify the labor type and overhead type, then enter the labor
percentage (or rate), overhead percentage (or rate), and cost plus
percentage, as required for the category.

8.1f you are revising an estimate on a basic project, select the labor type
and the overhead type to use for the category, as required. Then

complete the estimate for the category, as described in the previous
section.

9.Click the Add button.

10.1f you are revising a standard project, close the detail form, click Add,
then click Post on the Revise Estimates form to assign the new

category to the project before adding an estimate for a resource using
this category.



I:E' Related Topics
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Revising Estimates: Assigning a New Resource

Category

The Revise Estimates form lets you assign a new resource category to a
selected project. (If the resource you need has not yet been assigned, it
does not appear in the resource Finder list when you enter a detail for
revise estimate transaction.)

Note that you must set up the resource for your system before you can
assign it to a project.

Also, note that if the category has not yet been assigned to the project,
you must post a separate revise estimate transaction to add the category
before you can add the resource estimate.

To assign a new resource to a project:

1.0n the Revise Estimates form, click the New button beside the Revise
Estimates Number field.

2.Enter header information for the transaction, as described earlier in
this chapter.

3.Use the Contract, Project, and Category fields to specify the contract,
project, and category that you are going to change.

4 .Click the second Finder button next to the Resource field.

5.Select the required resource from the list that appears, click Add, and
then click Close.

6.Click the Go button to display the fields for the resource category
estimate.

7.Enter the estimate for the resource category.
8.Click the Add button.

9.When you have finished adding details, close the detail form, then
click Add to add the transaction.



I:E' Related Topics
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Processing Job-Related Payroll

To charge jobs for payroll costs, you process timecards in Project and
Job Costing.

Whether you use a Sage ERP Accpac payroll program, or not, you must
create an employee in Project and Job Costing before you can process a
job-related timecard for the employee.

e|f you do not use a Sage Accpac payroll program, or if the employee
has no record in the payroll program, you set up employee records in
Project and Job Costing with a payroll type of None, manually
entering information for the employee.

e|f you use Sage ERP Accpac US or Canadian Payroll, you can add
PJC employee records that use information from your payroll
employee records.

Click here to find out how to add or modify employee records.

When calculating payroll costs, Project and Job Costing uses the default
earnings codes and billing rates specified for a particular project,
depending on:

eThe project type and accounting method. (A billing rate is used only
for time and materials projects and for fixed price projects that use the
accrual-basis or billings and costs accounting method.)

*\Whether the employee is set up in Payroll. (The default unit cost for
Payroll employees comes from the Payroll employee record. if the
employee is not set up in Payroll, the unit cost setting is used.)

Processing Timecards

You can process timecards that include both labor costs and employee
reimbursements.

The program uses weekly timecards as the default pay period, but you
can change the start and end dates for individual timecards, if you use a
different pay period.

If you use security in your Sage ERP Accpac system, employees with a
Timecard Entry security assignment can enter timecards. To restrict an



employee to view, enter, or update only their own timecards, you must
enter their user ID on their PJC employee record. An employee with
Timecard Posting authorization can review and post timecards.

If you have set up your Sage ERP Accpac system for use on the Internet,
employees can also enter timecards remotely using a browser. (For
information on setting up Sage ERP Accpac for Internet users, see the
System Manager documentation.)

When entering information on timecards, you use:

®[}] The Time Details tab to enter wage cost transactions.

®[}] The Expense tab to reimburse employees’ out-of-pocket expenses.

Click here for step-by-step instructions on entering time details on an employee's timecard.

Click here for step-by-step instructions on reimbursing employee expenses on a timecard.

When you post timecards, the program creates journal entries that debit
the general ledger work in progress account and credit the wage expense
account and, if required, credit the labor allocated and overhead
allocated accounts.

Updating Your Payroll Program

After you post timecards for payroll employees in Project and Job
Costing, you run Update Payroll to update US or Canadian Payroll with
the timecard information. You then generate employee checks in the
usual way, in the payroll program. You can also run Update Payroll to
create a .CSV file that you can import into a non-Sage ERP Accpac
payroll program.

Alternatively, you can:

ePost job-related timecards in US or Canadian Payroll, and
automatically update Project and Job Costing when you print the
paychecks.

eImport timecards from and export timecards to Payroll.

Click here for step-by-step instructions on updating payroll.
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Integration with Sage ERP Accpac Order Entry

Project and Job Costing integrates with Sage ERP Accpac Order Entry in
the following ways:

eYOu can create a new contract "on the fly" when you enter a quote in
Order Entry. When you post the quote, Order Entry sends estimates
of the quantity, total cost, and total revenue to Project and Job
Costing. When you change the quote to Active and post it in Order
Entry, Project and Job Costing changes the project status to Open.

eProject and Job Costing accepts costs from job-related shipments that
you post in Order Entry.

o [-Or some projects that use item invoicing &, you Can choose whether to pOSt jOb'
related invoices in Order Entry. When you post the invoices in
Accounts Receivable, Accounts Receivable updates Project and Job
Costing with the costs and billing information.

Project and Job Costing handles the billing for the costs of posted
shipments that use project invoicing.

eYou can specify a default method for determining the costs and billing
amounts for job related documents you process in Order Entry. To set
the default methods for a selected project, use the Default Billing Rate
field and the O/E Miscellaneous Charges field on the Project tab of
the Project Maintenance form.

Click here to display help topics for these fields.

Deciding Whether to Record Costs and Charges
in Order Entry

You can record job-related non-material costs in Order Entry as
miscellaneous charges. Order Entry sends both cost and revenue
amounts to Project and Job Costing.

You can also process job-related item costs on sales orders in Order
Entry, as well as on receipts in Purchase Orders.

Before processing miscellaneous charges in Order Entry, you should be
aware that:
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eThere is a risk that you can process the same costs twice. To avoid
double-counting, you should establish guidelines on how to record
job-related miscellaneous charges and how to transfer item costs to
projects.

eThere are some differences in the calculation of overhead for job-
related material costs you process in Order Entry and those you
process in Purchase Orders.

Project and Job Costing calculates overhead for job-related purchase
receipts and sales orders. For project categories that use the
Percentage Of Cost overhead method, the calculations vary,
depending on which program you use to process the costs:

o  The costs of items you process in Purchase Orders do not include
taxes. The associated overhead calculations are based on
amounts excluding taxes.

o  Order Entry, on the other hand, uses I/C item cost amounts, which
include allocated taxes. Therefore, overhead calculations are
based on amounts that include allocated taxes.



Assign Lot Numbers to Material Transactions

[l overview

To assign a lot number to a material usage or material return detail:

1.Enter the material usage OF material return, AS usual.

Be sure to use the detail entry form to enter transaction details. (Click
the Detail/Tax button to open the form.)

2.Enter a value in the Quantity field, and then press the Tab key to
move out of the Quantity field.

The Lot Tracking dialog box opens (if it is not already open following a
preViOUS assignment of serial numbers).

3.Assign the lot numbers in one of the following ways:

o  To assign lot numbers one at a time, in the Quantity Shipped field,
enter the quantity or press the spacebar. Lots will be displayed in
the order specified on the L/T Options form.

o  To assign lot numbers all at once, select the Quantity Shipped
field, and then click the Auto-Allocate button. Lots will be allocated
in order from the first lot selected.

o  To create lot numbers “on the fly,” click the Generate button.
Another form will appear, allowing you to add a new lot into the
system. New lots appear in the Quantity Available field once you
close the Generate form.

4.Edit the lot numbers as necessary. To change the quantity allocated
from a lot, either edit the Quantity Shipped field or select the Clear
button to remove lots.

5.Click Save to save the lot numbers you allocated, and then click
Close. (These are marked as Sold in the database once you post the
transaction.)

To close the form without saving the lot numbers, click Close.
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Serial/Lot Number Allocation/Generation Form

Field List—

For information about fields and buttons on the Serial/Lot Number
Allocation form and on the Serial/Lot Number Generation form, click the
following links:

Item Number
Location
Stock Date

Serials tab

allocated (display only)

Auto-Allocate From

Generated (dlsplay Only)
Next Serial Number
Serial Number column

Shipped column

oty shipped (display only)
Remaining (dISpIay Only)

Serial Nos. Required (dISpIay Only)
Serials Shipped (dISpIay Only)
Unit of Measure (dISpIay Only)

Lots tab

allocated (display only)

Auto-Allocate From

Generated (dlsplay Only)

Lot Number column
Lot Oty Required (diSplay only)

Lots shipped (display only)
Make [] Lots OR Each Lot Has [ ]
Next Lot Number

Quantity column
Quantity Shipped column

Qty shipped (display only)
Remaining (dISpIay Only)
Unit of Measure (dISpIay Only)

Buttons

Add
Auto-Alloc
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Auto-Gen.
Clear
Close

Ship All
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Contract Maintenance Form — Totals Tab

The Totals tab form provides a snapshot of the contract as a whole. It
displays the original estimates, current estimates, earned revenue and

actual costs, committed costs, recognized revenue, retainage payable,
and retainage receivable for the entire contract.

It also provides contract totals for labor burden and overhead.

Click one of the buttons below for information about another tab on the
Contract Maintenance form.

I:E' Contract

I:E' Project

I:E' Optional Fields
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Optional Field Settings

You can - and should - restrict the flow of information that is passed to
General Ledger and other Sage ERP Accpac programs when you post
transactions that use optional fields.

The Optional Fields setup form lets you specify groups of accounts for
which values for an optional field can be passed to General Ledger. (The
optional fields used in a transaction must also match the transaction
details optional fields used for an account in order to be passed to
General Ledger.)

When defining an optional field for use with transactions, click the
Settings button (or double-click the line on the grid). A separate form
opens, listing the groups of accounts that are affected when you post
transactions of the type for which you are defining the optional field.

Select from the list all the account groups for which you want to pass
values to General Ledger when you post transactions that include the
optional field.

Note: While all account groups are initially selected for new optional
fields, you need to consider carefully the purpose of the optional field you
are defining. You should send values to General Ledger only for optional
fields that require financial analysis, and only to accounts where they are
required. For example, you might want to send optional fields that contain
customer numbers or sales territories only to revenue accounts.

You do not need to send optional field information for analysis that is
performed only in Project and Job Costing. If you routinely send all the
optional fields you use in Project and Job Costing transactions, your
General Ledger may become unwieldy, and you may also considerably
slow down processing.

Other Sage ERP Accpac programs will accept optional field information
sent with transactions from Project and Job Costing if you select the
settings to send optional field information to these other programs and
accounts and you use the same optional fields for the corresponding
forms in Accounts Receivable [, inventory Control, JUS or Canadian Payroll [, OF for the account
transaction details in ceneral Ledger .
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Assigning Optional Fields to Setup Records

Once you have defined optional fields for your Project and Job Costing
system, you can assign them to particular setup records.

Optional fields you set up for automatic insertion on the Projects,
Categories, or Employees forms appear on the Optional Fields tab of the
respective forms when you add a new record.

For equipment, miscellaneous expenses, overhead expenses,
subcontractors, and charge codes records, an Optional Fields indicator
shows whether optional fields have been added to particular records. If
you set up any optional fields for automatic insertion on the form you are
using, the Optional Fields check box will be selected for new records. (To
view or edit the optional fields, click the Optional Fields Zoom button to
open a separate Optional Fields form.)

You can edit or delete any automatically inserted optional fields on the
Optional Fields tab or Optional Fields form (depending on the type of
record), or you can add different optional fields that you have defined for
the particular Project and Job Costing form.

Optional fields assigned to project and category setup records appear as
defaults when you add the projects and categories to a new contract.

Optional fields assigned to particular resources appear as defaults when
you assign the resources to a contract project, except for employee,
subcontractor, or material resources, which may take their default entries
from Payroll, Accounts Payable, or Inventory Control records. (See assigning
Optional Fields to Contracts fOr more detailed information.)

I:E' Related Topics


javascript:mc118.Click()

Planning a Contract Numbering Scheme

A contract number is an alphanumeric code that uniquely identifies a
contract in your Project and Job Costing system.

Before you set up your contract numbering system, you need to
determine your project reporting needs. Your contract numbering system

should help you to identify contracts easily, as well as to sort and group
contracts on reports.

If your existing numbering system does not fulfill your requirements, now
is the time to decide what changes you need.

You may be able to use your existing contract numbering system, if it
satisfies the following Project and Job Costing requirements.



Defining Contract Number Formats

Once you decide on the types of contract numbers you need, you need to
create one or more formats for your contract numbers. For example, you
might want all your contract numbers to have the pattern {customer}
{department}-{contract}. An example of a contract number using this
pattern is #HELI 1200-0026. Or, you might want to use different formats
for basic and standard contracts, so that you can easily distinguish them.



Contract structures

You specify formats for contract numbers using contract structures. A
contract structure determines the number of Segments in a contract
number, the order in which the segments appear, and the position and
type of separator and prefix characters in a contract number. Project and
Job Costing lets you have several contract structures, so you can use
several different contract number formats.

Contract numbers can contain a separator character between
consecutive segments and a prefix character in front of the first segment.

Design your contract numbering scheme as
follows

1.|I| Define the segments you need for your contract numbers.

2.1f you want to restrict entries to valid codes for certain segments of the
contract number, [t add segment codes.

3.Set up one Or More contract structures. [
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Summary of the Rules for Contract Numbers

eA contract structure can be up to 16 characters long, including all
segments, separator characters, and a prefix character.

eContract structures can have from one to five segments. For example,
you could use a segment to indicate a type of service, a project
manager, or a division of your company.

A segment can be up to 16 characters long, including the optional
separator character(s). Keep in mind that contract structures are also
limited to 16 characters, so you could have no more than one 16-
character segment in a contract structure.

(Note that if you decide to use only one segment, you will sacrifice
some of the sorting and classification capabilities of the system.)

eYOu can use an optional separator character between segments in the
contract structure, and you can use an optional prefix character at the
beginning of the structure.

eProject and Job Costing ignores separator and prefix characters when
sorting contract numbers.

Project and Job Costing also ignores separator and prefix characters
when distinguishing between contract numbers. For example, the
program considers the contract numbers #5200-010 and 5200/010 to
be identical, since the only difference is the prefix and separator
characters.

eContract numbers may contain blank spaces, such as in the number
22 463 999. The blank space is treated as an alphanumeric character,
not as a separator, so that 11 /111/111 and _11/111/111 (where the
underscore represents a space) are two difference contract numbers.

eThe program does not allow you to enter duplicate contract numbers.



Sorting Order for Contract Numbers

Project and Job Costing sorts contract numbers for reports and lists from
left to right in the following order:

0123456 789ABCDEFGHIJKLMNOPQRSTUVWXY
Z

For example, the program sorts the following sample contract numbers in
the order shown:

123

123A

Al2

A2

AB1234

Separator and prefix characters do not affect the order.



Tips for Contract Number Formats

When you design your contract number format, consider the following
suggestions:

Do not mix numbers and letters in segments to make the order in
which contract numbers appear on reports and in lists more
predictable.

e\When you assign numbers to segments, leave sufficient gaps to allow
for later expansion of your system. For example, for a segment used
to define a service type, assign 100, 200, 300 rather than 010, 020,
030.

eAssign contract numbers according to the order in which you want
contracts to appear on reports and lists. For example, you can identify
the type of a contract as new construction or maintenance by
assigning segment codes 1100, 1200, and 1300 for maintenance and
2100, 2200, and 2300 for new construction.

eUse segments of different lengths in contract structures, or use some
alphabetic segments, so that you can easily identify what each
segment of a contract number represents.



Print a Hard Copy of a Report

Sage ERP Accpac lets you print reports to a printer, to the screen, to a
file, or as an attachment to an e-mail message.

Note: You must be assigned to a security group that has permission to
change the print destination. (Otherwise, the only destination available is
a physical printer.)

If your printer is already set up, follow these instructions to change
the print destination back to Printer:

1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select Printer as the print destination.
3.Click OK.

If you have not yet selected a printer for Sage ERP Accpac, follow
these instructions to choose a default printer for printing all reports
from Sage ERP Accpac.

1.0n the Sage Accpac Desktop menu, select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.

The printer list includes all printers that have been added to the
Printers and Faxes list in Microsoft Windows.

4.Click the Properties button to change available settings for your
particular printer,

5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.

7.Click the Print Destination button and check that the print destination
IS set to Printer.

If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.

8.Click OK on the Print Destination form, and then click OK on the Page



Setup form.

[l Related topics


javascript:void(0);

Accounting Method

The accounting method determines when to recognize revenues for this
type of project.

Note that the program limits the range of accounting methods you can
select to those that are consistent with the project type.

You can choose the following default accounting methods for new
projects:

® Completed Project

® Total Cost Percentage Complete

® | abor Hours Percentage Complete

® Billings And Costs

® Project Percentage Complete

® Category Percentage Complete

® Accrual-Basis
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Optional Fields

This field appears only if you use Sage ERP Accpac Transaction Analysis
and Optional Field Creator.

Project and Job Costing lets you define as many optional fields as you
need for additional information that you want to store with setup records.
You use the Optional Fields setup form to define the optional fields that
you want to use with different types of records.

Once you have defined optional fields for this type of record, you can
assign the optional to particular records.

The Optional Fields check box indicates whether optional fields have
been added to the selected record. If you set up optional fields for
automatic insertion on the type of record you are working with, the
Optional Fields check box will be selected for new records.

To check or change the optional fields added to a setup record, click the
Zoom button () beside the Optional Fields check box to open a separate
Optional Fields form for the setup record.



Contract Style |/ Project Style
Contract and project styles provide flexibility in tracking project costs.

Select a project style that is consistent with the project's length or
complexity, or its reporting requirements, as follows:

®Basic

® Standard

The style you specify for a contract becomes the default style for projects
that you add to the contract. However, you can change the style for
particular projects.
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Billing Type

The billing type, together with the project type, determines the kinds of
details that appear on job-related customer invoices.

You can select:
®Billable

® Non-billable

®No Charge

Note that the project type and accounting method jointly determine
whether you set the billing type for projects, for categories, or for both on
a contract, and whether you can change the billing type for individual
transactions:

eFor time and materials projects, you set the billing type for each
resource category (for a standard project) or category (for a basic
project). You can change the billing type for transactions only if the
resource category (or category, for a basic project) is billable.

eFor fixed price projects, that use the completed project or project
percentage complete accounting methods, you set the billing type
only for the project, and you cannot change it for individual
transactions. Categories are not used in billing for these fixed price
projects.

eFor fixed price projects, that use the billings and costs or accrual-
basis accounting methods, you can set the billing type for each
resource category (for a standard project) or category (for a basic
project) only if the project is billable. You can change the billing type
for transactions only if the resource category (or category, for a basic
project) is billable.

eFor cost plus projects using a completed project, total cost percentage
complete, or labor hours percentage complete accounting method,
the billing type for the resource category (or category, for a basic
project) is set at the project level, and you cannot change the billing
type for transactions.

eFor cost plus projects using billings and costs, category percentage
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complete, or accrual-basis accounting methods, you can change the
billing type for categories on the Contract Maintenance form only if the
project is billable. You cannot change the billing type for the resource
category, which uses the same billing type as the category, and you
cannot change the billing type for any transactions.



Category Maintenance Form Field List

[ Category
[ cost Type (display only)
[ Description

[ Exchange Rate
[ Line Number

Estimates tab
[ Actuals

[ Billing Rate

[t Billing Type

[l committed

[}l cost Plus Percentage
[t current Estimates

[ Expected Billings

[}l Extended Cost

[l Labor Amount

[}l Labor Rate/Percentage
[ Labor Type

[}l Markup Percentage

[ Original Estimates

[}l overhead Amount

] overhead Type

[}l overhead Rate/Percentage
[ Percentage Complete
[ Quantity

[ Recognized
[} Total Cost

[} Total Profit (functional and source)
[}l Total Revenue (functional and source)

Accounts tab
LI cost

[ Cost of Sales

[ Equipment

] Employee Expense
[ Labor

[}l overhead

[ Payroll Expense
[ work in Progress

Retainage tab

[}l A/P Retainage Percentage
[}l A/P Retention Period

[}l Default Retainage From
[}l Retainage Payable

[}l Retainage Receivable

Transactions tab (basic projects, labor cost class)
[ Default PIJC Employee Unit Cost From
[ Default Billing Rate

[ Optional Fields tab
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Categories List

The Categories list lets you
eView a list of the categories you have assigned to a selected project.
eAdd categories to a selected project.

*Open the Categories Maintenance form to enter or view estimates for
a selected category.

Once you have entered estimates for all the project categories, you
can view the estimated totals for the project on the Totals tab of the
Project Maintenance form.

To display the Categories list for a project:

*On the tree, expand the folder for the desired project, then click the
Category folder. The program displays the Categories form in the
panel to the right of the tree.

eAlternatively, you can select the project on the Project tab of the
Contract Maintenance form, then click the Categories button. The
program displays the list of categories on a separate Categories form.

To view all the details, including the assigned cost-related accounts,
for a particular category in the Category Maintenance form, either:

eOn the tree, expand the Category folder, then click the desired
category. The program displays the Category Maintenance form
showing the details for the selected category in the right-hand panel.

eAlternatively, display the Categories form (as above), select a
category on the list, and then click the Estimates button.

I:E' Related Topics
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[Resource] Category Maintenance Field List

L] category
[*] cost Type (display only)

| Description
| Exchange Rate
[t Line Number

Estimate tab

[ Billing Rate

[t Billing Type

[l committed

[}l cost Plus Percentage

[t current Start Date/End Date
[}l Extended Cost

[l Labor Amount

[l Labor Rate/Percentage

[ Labor Type

[}l Markup Percentage

[}l overhead Amount

] overhead Type

[}l overhead Rate/Percentage
[t Projected Start Date/End Date
| Quantity

L Total Cost

[} Total Profit (functional and source)
[*] Total Revenue (functional and source)
& unit Cost

) Unit of Measure

Transactions tab (appears only for Employee resources)

[}l Default PIC Employee Unit Cost From
[}l Default Billing Rate
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Resource Category Maintenance —

Transactions Tab

The Transactions tab appears only for labor categories, which are
assigned to employee resources.

It lets you choose different timecard default settings for a particular
employee and cost category than those specified on the pac options form. The
settings determine the billing rate and unit cost that appear on the
employee's timecard when you specify the particular contract, project,
and category.

Note that you can specify a default unit cost for employees that are "PJC
employees," only. If the employee has a record in US or Canadian
Payroll, the earnings rate from the employee's Payroll record appears as
the unit cost on the employee's PJC timecards.

To change the timecard settings for an employee and cost category:

1.0n the Contract Maintenance tree, click the resource category for the
project and employee.

2.0n the Transactions tab of the Resource Category Maintenance form,
specify settings for the Default PJC Employee Unit Cost From and
Default Billing Rate fields.

For information about a field, click the Field List button at the top of this
page.



Resource Maintenance Form — Field List

L] [Resource] Code

[ Description
[ Line Number

Estimates tab

[ Actuals

[l committed

[t current Estimates

[t current Start Date/End Date
[}l Extended Cost

[}l Labor Amount

[ Original Estimates

[}l overhead Amount

[t Projected Start Date/End Date
[ Quantity

[ 1otal cost (functional currency)
[ 1otal profit (fUNCtional and source currencies)
[ 1otal Revenue (fUNCtional and source currencies)

Categories tab

[ A/R ltem No.

[l A/R Unit of Measure

[ Actual Cost

[ Actual Quantity

[}l Actual Revenue (functional and source)
[t Billing Type

[ Category

] committed P/O Cost

[l committed P/O Labor

[l committed P/O Overhead

[l committed P/O Quantity

[l committed P/O Total Cost

[t current Billing Rate

[ current Cost

[ current Markup Percentage

[t current Cost Plus Percentage

[ current Quantity

[t current Revenue (functional and customer currencies)
[}l current Unit Cost

[ Description

[}l Labor Rate/Percentage

[ Labor Type

[ Line Number

L] original Billing Rate

[ Original Cost

[ Original Cost Plus (or Markup) Percentage
[ Original Labor Amount Estimate

[ Original Overhead Estimate

[ Original Quantity

[ Original Revenue (functional and customer currencies)
[ Original Unit Cost

[}l overhead Rate/Percentage

] overhead Type
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[ Optional Fields tab
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Project [Resource] List

For each type of resource you assign to a project, Project and Job
Costing maintains a list of the resources you have added (for example, a
Project Employee List, a Project Equipment List, and so on).

Similar to the Categories list, a project resource list lets you:

®[}] view a list of resources assigned to a selected project.

®[] Assign resources to a selected project.

.Open a Separate form to enter @ estimates for selected resources.

To display a list of project resources:

«On the tree, expand the folder for the desired project, then click the
folder for the type of resource (such as Employees or Material). The

program lists the particular resources you have assigned in the panel
to the right.

eAlternatively, on the Project tab of the Contract Maintenance form,

select the project, click the Resources button, then click the resource
you want to display.

To display the details for a particular resource, do one of the
following:

eOn the tree, expand the resource folder, then click the folder for the

specific resource. The program displays the details for the selected
resource in the right-hand panel.

eAlternatively, you can display the Project [Resource] List, as described

above, select a specific resource on the list, then click the Detalil
button.

I:E' Related Topics
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Serial/Lot Numbers Allocation / Generation

Form — Serials Tab

Use the Serials tab on the Serial/Lot Numbers Allocation form to assign
serial numbers tO Serialized items when you enter material usage and material
return transactions in Project and Job Costing.

For help on the fields that appear on the Serials tab, click the Field List
button at the top of this form.

For step-by-step instructions on assigning serial numbers, click the link
for the task you want to perform, below:

To allocate serial numbers in material usage transactions

To allocate serial numbers in material return transactions

Click the following links for more information about the Serial/Lot
Numbers Allocation / Generation Form:

® Serial/lot Numbers - Lots Tab

® Serial/Lot Numbers Allocation / Generation Form

See also

Allocating Serial Numbers in Material Transactions - Overview
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Serial/Lot Numbers Allocation/Generation

Form — Lots Tab

You use the Lots tab on the Serial/Lot Numbers Allocation form to assign
lot numbers tO lotted items when you enter orders, shipments, debit notes,
and return credit notes.

For help on the fields that appear on the Lots tab, click the Field List
button at the top of this form.

For step-by-step instructions on assigning lot numbers, click the link for
the task you want to perform, below:

To allocate Lot Numbers in Material Usage Transactions

To allocate Lot Numbers in Material Returns Transactions

Click the following links for more information about the Serial/Lot
Numbers Allocation / Generation Form:

® Serial/lot Numbers - Serials Tab

® Serial/Lot Numbers Allocation / Generation Form

See also

Allocating Serial Numbers in Material Transactions - Overview
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AIR Invoice Type

The type of details that appear on an invoice depends on the invoice
type.

eSummary invoices include just enough information to update your
receivables records and general ledger revenue account. You use
summary invoices if you do not need to update inventory items.
Project and Job Costing produces summary invoices for all cost plus
projects and for all fixed price projects that use the completed project
and project percentage complete accounting method.

eltem invoices include details about items. They update receivables
records as well as the revenue, inventory, and cost of goods sold
general ledger accounts.

Project and Job Costing produces item invoices for all time and
materials projects. You can choose whether to produce item invoices
or summary invoices for a particular fixed price project if it uses the
billings and costs or accrual-basis accounting method.

You can create a worksheet that includes either type or both types.



Assign Serial Numbers to a Material Transaction

[l overview

[l Before you start

To assign a serial number to a material usage or material return
detail:

1.Enter the material usage OF material return, AS usual.

Be sure to use the detail entry form to enter the transaction details.
(Click the Detail/Tax button to open the form.)

a.  On the Detail Material Usage/Taxes form (or the Detail Material
Returns/Taxes form), click the Zoom button beside the Quantity
field.

b. Inthe dialog box that opens, select Serialized Inventory or Both (if
you also use Lot Tracking), and then click OK.

c. Inthe detail entry form, enter a quantity, and then press the Tab
key to move out of the Quantity field.

The Serialized Inventory dialog box opens.

d. If you want to change a serial number assigned to an existing
transaction, click the Zoom button beside the Serial Numbers field
to open the dialog box.

2.1f you need to change transaction date, type it in the Transaction Date
field, or click the calendar icon beside the field to select a date.

3.To assign serial numbers, either:

o  Type a serial number in the blank field above the Available Serial
Numbers list, then click the Include button,

Or

o Highlight a number in the Available Serial Numbers list, and then
click the Auto Allocate button.

Serial numbers that are available for the specified item appear in the
Allocated Serial Numbers list.

4.Apply the resulting serial numbers to the transaction by clicking the
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Exclude and Clear buttons.
You can edit or change serial numbers as required.

5.Click Save, then click Close to return to the detail-entry form, or to the
Lot Tracking form, if you use Lot Tracking and you chose to launch
both programs in Step 1.

6.1f the Lot Tracking form opened, enter the lot tracking information.

7.When you return to the detail-entry form, enter another detail, or click
Close.



Categories List Fields

[}l A/P Retainage Percentage

[}l A/P Retention Period
[t Actual Cost
[ Actual Quantity

| Category
[l committed P/O Quantity

[l committed P/O Total Cost

L Cost Type

[ current Cost

[t current Cost Plus [Markup] Percentage
[ current Quantity

[}l Default Retainage From

| Description

[ Labor Percentage

[ Labor Rate

[ Labor Type

| Line Number

| Optional Fields

| Original Cost

D] Original Cost Plus [Markup] Percentage
D] Original Labor Amount Estimate
D] Original Overhead Estimate

| Original Quantity

D] Original Revenue (CAD)

D] Original Revenue (USD)

[}l overhead Percentage

[}l overhead Rate

] overhead Type

[}l Retainage Payable

[}l Retainage Receivable

[}l Revenue

[ Total Original Estimate Cost
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